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Legal information
The Schneider Electric brand and any trademarks of Schneider Electric SE and its subsidiaries
referred to in this guide are the property of Schneider Electric SE or its subsidiaries. All other
brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and furnished for
informational use only. No part of this guide may be reproduced or transmitted in any form or by
any means (electronic, mechanical, photocopying, recording, or otherwise), for any purpose,
without the prior written permission of Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide or its
content, except for a non-exclusive and personal license to consult it on an "as is" basis.
Schneider Electric products and equipment should be installed, operated, serviced, and
maintained only by qualified personnel.

As standards, specifications, and designs change from time to time, information contained in this
guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by Schneider
Electric and its subsidiaries for any errors or omissions in the informational content of this material
or consequences arising out of or resulting from the use of the information contained herein.
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Safety information
Important information

Read these instructions carefully and look at the equipment to become familiar with the
device before trying to install, operate, service, or maintain it. The following special
messages may appear throughout this manual or on the equipment to warn of potential
hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a "Danger" or "Warning" safety label indicates that an
electrical hazard exists which will result in personal injury if the instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal injury hazards. Obey
all safety messages that follow this symbol to avoid possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided,will result in death or serious
injury.

Failure to follow these instructions will result in death or serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result inminor or
moderate injury.

Failure to follow these instructions can result in injury or equipment damage.

NOTICE
NOTICE is used to address practices not related to physical injury.

Failure to follow these instructions can result in equipment damage.
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Please note
Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out
of the use of this material. A qualified person is one who has skills and knowledge related to the
construction, installation, and operation of electrical equipment and has received safety training to
recognize and avoid the hazards involved.
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Notices
FCC

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that the
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following
measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to which the receiver is
connected.

• Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that any changes or modifications not expressly approved by Schneider
Electric could void the user’s authority to operate the equipment.

This digital apparatus complies with CAN ICES-3 (B) /NMB-3(B).
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Metering equipment symbols
The following IEC 60417 and ISO 7000 symbols may be used on the metering equipment:

Symbol Reference Title and description

IEC 60417-5017

Earth; ground

To identify an earth (ground) terminal in cases where
neither the symbol 5018 nor 5019 is explicitly required.

IEC 60417-5018

Functional earthing; functional grounding (US) *

To identify a functional earthing (grounding) terminal, for
example, of a specially designed earthing (grounding)
system to avoid causing malfunction of the equipment.

IEC 60417-5019

Protective class I; Protective earth/ground

To identify any terminal which is intended for connection
to an external conductor for protection against electric
shock in case of a fault, or the terminal of a protective
earth (ground) electrode.

IEC 60417-5172

Protective class II equipment **

To identify equipment meeting the safety requirements
specified for Class II equipment (double or reinforced
insulation).

ISO 7000-0434B

Caution, refer to accompanying documents

To indicate that caution is necessary when operating
the device or control close to where the symbol is
placed. To indicate that the current situation needs
operator awareness or operator action in order to avoid
undesirable consequences.

ISO 7000-1641

Operator's manual; operating instructions

To identify the location where the operator's manual is
stored or to identify information that relates to the
operating instructions. To indicate operating instructions
should be considered when operating the device or
operating controls close to where the symbol is placed.

* There may be national differences concerning the use of this symbol.

** Protective class equipment requirements are outlined in IEC 61140.
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About this manual
This manual discusses features of the PowerLogic™ ION9000 series power meter and provides
configuration instructions.

Throughout the manual, the term “meter” refers to all models of the PowerLogic™ ION9000 series
meter. All differences between the models, such as a feature specific to one model, are indicated
with the appropriate model number or description.

This manual assumes you have an understanding of power metering and are familiar with the
equipment and power system in which your meter is installed.
This manual does not provide configuration information for advanced features where an expert
user would perform advanced configuration. It also does not include instructions on how to incor-
porate meter data or perform meter configuration using energy management systems or software.

Contact your local Schneider Electric representative to learn what additional training opportunities
are available regarding the PowerLogic™ ION9000 series meter.

Make sure you are using the most up-to-date version of your meter’s firmware in order to access
the latest features.

The most up-to-date documentation about your meter is available for download from
www.se.com.

Document Number

PowerLogic™ ION9000 online
documents

https://www.se.com/ca/en/product-range/64241-
new%21-powerlogic-ion9000/#documents

PowerLogic™ ION9000 series
installation guide

NVE78642

PowerLogic™ ION9000 series -
LVCS installation guide

GDE96023

PowerLogic™ ION9000 series -
LVDC installation guide

NNZ67817

PowerLogic™ ION9000 series -
LVDC/LVCS installation guide

NNZ67818

PowerLogic™ ION9000 series -
Measurement Canada installation
guide

NNZ55235

Related documents
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Document Number

ION Reference 7EN02-0290

PowerLogic™ ION9000 series
technical datasheet

PLSED310106EN

PowerLogic™ Fiber Ethernet option
module

METSEPMFIBER

PowerLogic™ 4-wire RS-485 option
module

METSEPMRS4854W
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Safety precautions
Installation, wiring, testing and service must be performed in accordance with all local and
national electrical codes.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

• Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

• Follow guidelines in the Wiring section of the related Installation Guide.

• Always use a properly rated voltage sensing device to confirm that all power is off.

• Do not use the data from the meter to confirm power is off.

• Do not exceed the maximum ratings of this device.

• Do not short secondary terminals of Voltage Transformer (VT).

• Do not open secondary terminals of Current Transformer (CT).

• Ground secondary circuit of CTs.

• Use only Low Power Current Transformers (LPCTs) that are approved for use with this
device.

• Do not connect CT secondary signals to meter low voltage LPCT terminals.

• Do not install CTs or LPCTs in equipment where they exceed 75% of the wiring space of any
cross-sectional area in the equipment.

• Do not install CTs or LPCTs in areas where ventilation openings may be blocked or in areas
of breaker arc venting.

• Do not install CTs or LPCTs using Class 2 wiring methods or connect to Class 2 equipment.
See NFPA 70.

• Secure CT or LPCT secondary conductors to ensure they do not contact live circuits.

• Assume communications and I/O wiring are hazardous live until determined otherwise.

• Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

NOTE: See IEC 60950-1 for more information on communications and I/O wiring connected to
multiple devices.



WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

• Change default passwords/passcodes to help prevent unauthorized access to device
settings and information.

• Disable unused ports/services and default accounts, where possible, to minimize pathways
for malicious attacks.

• Place networked devices behind multiple layers of cyber defenses (such as firewalls, network
segmentation, and network intrusion detection and protection).

• Use cybersecurity best practices (for example: least privilege, separation of duties) to help
prevent unauthorized exposure, loss, modification of data and logs, interruption of services,
or unintended operation.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.
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Meter overview
ION9000 series overview

The ION9000 series advanced energy and power quality meter helps meet the needs of your
energy management, power management, and cost management applications within your
EcoStruxure™ Power architecture.

ION9000 series revenue-accurate meters comply with international metering standards. The
meters feature flexible ION programmability that enhances functionality through customization by
loading specialized frameworks. You can add optional modules and incorporate mounting
accessories into the physical installation to meet a variety of installation and application needs.

Measurement accuracy
Third-party international standards-certified:

• Class 0,1S for energy

• Power Quality Instrument – Class A (PQI-A) for all normative IEC 61000-4-30 power quality
metrics

• IEC 62053-22, -23, -24 and ANSI C12.20

Power quality
Third-party international standards-certified:

• IEC 62586-1, IEC 62586-2, and IEC 61000-4-30

• EN 50160, including flicker monitoring

• IEEE 519

Root cause analysis and sequence-of-events support
• Disturbance Direction Detection

• High-speed RMS data capture with pre and post event records

• Extended waveform capture

• Time quality flag for GPS or PTP time sources

• Time synchronization to 1 ms accuracy

• High-speed voltage transient capture with 10 MHz sampling rate (ION9000T only)

Cybersecurity
• Meter security with multiple users and access levels

• Total control for each communications port and protocol, including protocol lockout

• Secure webpages (HTTPS)

• Support for meter event logging to a remote server (syslog)
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Account management
If your meter’s user access information is lost, you must return the meter to the factory, where
your meter is reset to its factory defaults and all logged data is lost.

NOTICE
DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.

Your meter in an energy management system
As a key piece in your energy management system, the PowerLogic™ ION9000 series meter
provides highly accurate measurements and calculations for a wide variety of power system
values, performs analysis on collected data, alerts you of potential issues and integrates with a
variety of display and analysis software.

It performs analysis on collected data, alerts you of potential issues and integrates with a variety
of edge control software such as EcoStruxure™ Power Operation and EcoStruxure™ Power
Monitoring Expert, and cloud-based energy management software such as EcoStruxure™
Energy One Hub.

For further analysis, you can also connect your meter with EcoStruxure™ Power Advisor to
enhance the performance and maintenance of power networks.

Communications
Supported protocols

Data that the meter measures can be made available to other devices using ION and other
industry-standard protocols.

Your meter’s fundamental protocol and architecture is ION.

You can integrate the meter into networks using the following industry-standard protocols:

• Modbus

• BACnet/IP

• MQTT

• DNP 3.0

• DLMS

• SNMP

• MV-90 billing software

You can configure the meter to import data from other devices using these protocols. Your meter
supports IEC 61850 and the COMTRADE waveform data format.



Your meter also supports IPv6, Devices Profile for Web Services (DPWS), and Rapid Spanning
Tree Protocol (RSTP) Ethernet protocols.

Meter configuration
ION Setup device configuration tool

ION Setup is a free configuration tool for your meter that lets you remotely configure your meter’s
features over Ethernet or serial communications.

• Use the setup screens to guide you through the process of configuring your meter.

• Use the real-time data screens to verify your meter’s configuration.

• Use the data screens to view your meter’s recorded data.

• Use the charting function to view your meter’s recorded waveforms.

• Use ION Setup in Advanced mode to work directly with modules.

Download ION Setup from www.se.com.

Switching ION Setup to Advanced mode
1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

Data display
Built-in web server and webpages

Your meter’s onboard internal web server and built-in webpages provide quick and easy access
to real-time energy, basic power quality information and meter configuration without having to use
specialized software.

Localization
The meter can be customized to use different regional settings.

Localization settings determine:

• The language used for the display and webpages

• Time, date, and digit formats

• Displayed phase labels (123/ABC)

• Institute of Electrical and Electronics Engineers (IEEE) or International Electrotechnical
Commission (IEC) conventions for power, power factor, and energy

Configure your meter’s localization settings using ION Setup or the display.

Display
Use the meter’s display to view real-time and historical power quality data, access monitoring
tools, receive and acknowledge alarms, and perform basic device configuration.
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The touch-screen color display has multiple mounting options to suit your environment and an
eight-language interface with external LED indicators for power, alarms, and energy pulsing
applications.

Notification
Active and historical alarms

The meter’s display shows an alarm icon and the alarm LED flashes if your meter detects an
active alarm condition.

Depending on the priority of the alarm, the display also flashes. You can view and acknowledge
active alarms, historic alarms, and events using the display and webpages.

An active alarm becomes a historic alarm when the alarm condition no longer exists.

Email notifications
Configure your meter to automatically email information such as notification of a high-priority
event or a regularly scheduled send of logged data.

Specify the type of event that triggers an email alert, such as a power quality disturbance or
interval for logged data. Email messages from your meter are received like any other email
message.

ION9000 meter models and accessories
Commercial references for the ION9000 series meter and accessories.

Commercial reference Description

METSEION92030

METSEION92830
ION9000 series meter

METSEION92040 ION9000 series meter with RD192 remote display

METSEION92043 ION9000 series – Measurement Canada Approved meter

METSEION92044 ION9000 series – Measurement Canada Sealed meter

METSEION92130 ION9000 series – LVDCmeter

METSEION92140 ION9000 series – LVDCmeter with RD192 remote display

METSEION93030 ION9000 series – LVCSmeter

METSEION93040 ION9000 series – LVCSmeter with RD192 remote display

METSEION93130 ION9000 series – LVDC/LVCS meter

METSEION93140 ION9000 series – LVDC/LVCS meter with RD192 remote display

METSEION95030 ION9000T series meter

METSEION95040 ION9000T series meter with RD192 remote display



Commercial reference Description

METSERD192
RD192 192 x 192 mm remote display with ION9000 series back-
to-back mounting adapter and 1/4 DIN (92 x 92 mm) panel cutout
mounting adapter

METSEPM89RD96
PM89RD96 96 x 96 mm remote display with 1/4 DIN (92 x 92 mm)
panel cutout mounting adapter

METSEPM89M2600 Digital I/O option module (2 outputs, 6 inputs)

METSEPM89M0024 Analog I/O option module (2 outputs, 4 inputs)

METSEPMRS4854W 4-wire RS-485 option module

METSEPMFIBER Fiber Ethernet option module

METSE9B2BMA ION9000 series back-to-back mounting adapter

METSE9HWK
ION9000 series replacement hardware connectors and terminal
covers

METSE9HWKLVCS
ION9000 series – LVCS replacement hardware connectors and
terminal covers

METSE9USBK RD192 replacement USB cover

METSERD192HWK RD192 replacement hardware kit

METSECAB10 Remote display cable, 10 m

For more information on meter types and accessories, refer to your meter’s catalog pages,
available from www.se.com.

Terminal covers
The terminal covers enclose the terminals, the conductor fixing screws, and a length of the
external conductors and their insulation. The terminal covers are secured by tamper-resistant
meter seals.

The voltage and current terminal covers help prevent tampering with the meter's voltage and
current measurement inputs.

These covers are included for meter models where sealable voltage and current covers are
required to comply with revenue or regulatory standards.

The meter terminal covers must be installed by a qualified installer.

Refer to your meter's installation guide or the instructions that came with your terminal covers for
instructions on installing the terminal covers.
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Cybersecurity
Your device has security capabilities that:

• Allow it to be part of a NERC CIP compliant facility. For information on NERC Reliability
Standards, go to the North American Electric Reliability Corporation website.

• Align with cybersecurity standards in the IEC 62443 international standard for business IT
systems and Industrial Automation and Control Systems (IACS) products. For information
about the IEC 62443 international standard, go to the International Electrotechnical
Commission website.

This chapter contains information about your product’s cybersecurity. Network administrators,
system integrators, and personnel that commission, operate, maintain, or decommission a device
should review Recommended actions to help secure your device in a protected environment.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

• Change default passwords/passcodes to help prevent unauthorized access to device
settings and information.

• Disable unused ports/services and default accounts, where possible, to minimize pathways
for malicious attacks.

• Place networked devices behind multiple layers of cyber defenses (such as firewalls, network
segmentation, and network intrusion detection and protection).

• Use cybersecurity best practices (for example: least privilege, separation of duties) to help
prevent unauthorized exposure, loss, modification of data and logs, interruption of services,
or unintended operation.

Failure to follow these instructions can result in death or serious injury or equipment
damage.

Recommended actions
Your device is designed to be used in a protected environment that uses a defense in depth
strategy, in compliance with IEC 62443, the global standard for industrial automation control
system security.

To help secure your device, you must take specific actions at every stage of the project life-cycle.

NOTE: The list of recommended actions below is not a complete list of possible cybersecurity
measures. It is meant to be a starting point to improve the security of your device in a protected
environment. Consult with cybersecurity experts to plan, configure, operate, maintain, and
decommission your device based on your needs.

http://www.nerc.com/
https://www.iec.ch/
https://www.iec.ch/


The following table lists the actions we recommend you take to help secure your device in a
protected environment, organized by life-cycle stage:

Recommended action Defense-in-depth role

Plan

Review cybersecurity
awareness

Resources to increase your cybersecurity knowledge and
awareness.

Review the system
defense in depth
assumptions

Understand the security measures expected to be provided by the
external environment in which the device is to be used.

Review the device security
capabilities

Understand how the device's security capabilities can be used in a
protected environment.

Review the Security risks
and mitigation strategies

Known security risks and the mitigation strategies to help minimize
the risks.

Configure

Change the default
password *

Help reduce unauthorized access. Default account settings are
often the source of unauthorized access by malicious users.

Disable meter
configuration methods *

Limiting configuration options and providing read-only access
reduces the attack surface of the meter.

Disable webpages and
time sync sources *

Disable webpages to deny a web browser to access the meter
data. If your meter can be accessed by a web browser outside
your protected network, a malicious user could intercept
communications.

Disable the ability to modify the meter’s time source to help protect
against disguised communication from an unknown source as
being trusted and possibly invalidating timestamps.

Define lockouts and event
timeouts *

Lock accounts after a predefined number of unsuccessful login
attempts. Lockouts help reduce brute-force password attacks from
succeeding.

Limit user access*

Limit user access to the minimum, least privilege level of access
needed to perform their job functions.

Revoke user privileges when no longer needed due to role
change, transfer, or termination.

Edit meter access event
logging *

Edit the default meter access event priorities that are logged to
the event log to meet your reporting requirements.
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Recommended action Defense-in-depth role

Create and change user
passwords * 

Create strong passwords for each user that requires access to the
meter. Default account settings and weak passwords are often the
source of unauthorized access by malicious users.

Follow user account management tasks as described by your
organization or contact your network administrator. For example,
maximum password age or history policies.

Set up Advanced security *
Advanced security is the default meter security mode. If your
meter uses standard security mode, we recommend you change it
to advanced.

Disable unused protocols
and change default port
numbers

Disable unnecessary and unused communication protocol ports,
such as SFTP and network ports, to reduce the meter attack
surface.

Change port number default values to reduce the predictability of
port use.

See Protocols, ports, and connections.

Revenue-lock the meter
and use anti-tamper
sealing points

Physical lock switch with tamper-evident seal to prevent remote
modification of revenue parameters, settings, and data.

Validate security settings Verify the meter security configuration.

Assign a dedicated reader
for event log notifications

Assigning a dedicated reader can help prevent event log entries
being overwritten before they are reviewed.

Configure syslog to store
event logs

A syslog server can receive logs from multiple devices and store
the log information as needed. Syslog helps maintain meter log
information for extended periods of time.

See Syslog.

Operate

Monitor the event log
Monitor event logs for suspicious activity and to help identify the
cause of cybersecurity breaches that could lead to a cybersecurity
incident.

Report a cybersecurity
incident or vulnerability

Report suspicious activity, a cybersecurity incident, or a
vulnerability to Schneider Electric.

Maintain

Apply firmware updates
Keeping your device firmware up to date helps protect you from
security vulnerabilities.

Check the revenue lock
and anti-tamper seals

Follow your company's policies and standards by periodically
checking your device locks and seals to verify that the device has
not been tampered with.



Recommended action Defense-in-depth role

Review user accounts on a
regular basis

Limit user access to the minimum, least privilege level of access
needed to perform their job functions.

Revoke user privileges when no longer needed due to role
change, transfer, or termination.

See Limiting user access for details.

Keep your network security
up to date.

Helps reduce your attack surface, decreasing the likelihood of a
vulnerability.

Perform security audits Help verify the security status of your system.

Decommission

Record decommissioning
activities

Document disposal actions according to your company’s policies
and standards to keep a record of activities.

Wipe the device Help prevent the potential disclosure of data.

Decommission-related
rules and sanitize records

Follow decommission and sanitization tasks as described by your
organization or contact your network administrator.

Decommission network and security rules. For example, a firewall
rule that could be used to get past the firewall.

Perform records tracking sanitization tasks to remove records in
related systems. For example, monitoring SNMP servers.

Dispose, reuse, or recycle
the device

Follow local disposal regulations.

* For detailed information on the default meter security settings, see Default meter security
settings.

Plan
Before you install your device, use the following planning information to help you prepare for the
installation and commissioning of your meter in your facility.

• Cybersecurity awareness

• System defense-in-depth assumptions

• Device security capabilities

• Security risks and mitigation strategies

Cybersecurity awareness
Knowledge is the first step to help prevent cyber intrusions. Review the following to increase your
cybersecurity awareness:
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• Cybersecurity Best Practices guide

• EcoStruxure™ Power Guide for Designing and Implementing a Cyber Secure Digital Power
System

Subscribe to Schneider Electric security notifications
Register for Schneider Electric security notifications on the Schneider Electric Cybersecurity
Support Portal website.

System defense-in-depth assumptions
Defense-in-depth is an information security strategy integrating people, technology, and
operations capabilities to establish variable barriers across multiple layers and dimensions in your
information technology and control system.

Defense-in-depth helps minimize data protection gaps, reduces single-points-of-failure, and
creates a strong cybersecurity posture. The more layers of security in your system, the harder it is
to breach defenses, take digital assets or cause disruption.

Using a defense-in-depth strategy by securing the device in a protected environment will help
reduce your attack surface, decreasing the likelihood of a vulnerability.

Before you install your device, review the following system defense-in-depth assumptions. If you
have not already adopted these assumptions, we strongly recommend you add them to help
improve your cybersecurity posture.

Site security assumptions

• Perimeter security – Installed devices, and devices that are not in service, are in an access-
controlled or monitored location.

• Emergency power – The control system provides the capability to switch to and from an
emergency power supply without affecting the existing security state or a documented
degraded mode.

Network security assumptions

• Controls against malware – Detection, prevention, and recovery controls to help protect
against malware are implemented and combined with appropriate user awareness.

• Physical network segmentation – The control system provides the capability to:

Physically segment control system networks from non-control system networks.

Physically segment critical control system networks from non-critical control system
networks.

• Logical isolation of critical networks – The control system provides the capability to
logically and physically isolate critical control system networks from non-critical control
system networks. For example, using VLANs.

https://www.se.com/ww/en/download/document/Cybersecurity_Best_Practices/
https://www.se.com/ww/en/download/document/ESXP2TG003EN/
https://www.se.com/ww/en/download/document/ESXP2TG003EN/
https://www.se.com/ww/en/work/support/cybersecurity/security-notifications.jsp
https://www.se.com/ww/en/work/support/cybersecurity/security-notifications.jsp


• Independence from non-control system networks – The control system provides network
services to control system networks, critical or non-critical, without a connection to non-
control system networks.

• Zone boundary protection – The control system provides the capability to:

Manage connections through managed interfaces consisting of appropriate boundary
protection devices, such as proxies, gateways, routers, firewalls, and encrypted tunnels.

Use an effective architecture. For example, firewalls protecting application gateways
residing in a DMZ.

Control system boundary protections at any designated alternate processing sites should
provide the same levels of protection as that of the primary site. For example, data
centers.

• No public internet connectivity – Access from the control system to the internet is not
recommended. If a remote site connection is needed encrypt protocol transmissions.

• Resource availability and redundancy – Ability to break the connections between different
network segments or use duplicate devices in response to an incident.

• Manage communication loads – The control system provides the capability to manage
communication loads to mitigate the effects of information flooding types of DoS (Denial of
Service) events.

• Control system backup – Available and up-to-date backups for recovery from a control
system failure.

• Encrypt protocol transmissions over all external connections – Use an encrypted
tunnel, TLS wrapper, or a similar solution.

Administrative assumptions

• Cybersecurity governance – Available and up-to-date guidance on the secure use of
information and technology assets in your company.

• Firmware upgrades – Meter upgrades are implemented consistently to the current version of
firmware.

For detailed information on the device security capabilities, see Device security capabilities.

Device security capabilities
Your device includes security capabilities that, when combined with other defense-in-depth
measures, can help reduce vulnerabilities.

Before you install your device, carefully review the following device security capabilities to
understand how you can configure and use the device securely in a protected environment.
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Security area Device security capabilities
Role in defense-in-
depth

Physical

• Revenue-lock switch

• Anti-tamper sealing points

• LED lock status indicator on the
device

• Revenue lock icon on the display.

These capabilities help
prevent unauthorized
access to revenue-
related parameters and
settings or leave clear
evidence that the device
has been physically
tampered with.

Information
confidentiality

• SSH, SFTP, HTTPS support, Secure
ION, MQTT, and Secure EtherGate

These secure protocols
employ cryptographic
algorithms, key sizes,
and mechanisms to help
prevent unauthorized
users from reading
information in transit.

Access

• User authentication identifies and
authenticates software processes and
devices managing accounts.

• Least privilege in multiple dimensions:
read, peak demand reset, time sync,
test mode, meter configuration, and
security and communications
configuration.

• User account lockout limits the
number of unsuccessful login
attempts.

• Use control restricts allowed actions
to the authorized use of the control
system.

• Supervisors can override user
authorizations by deleting user
accounts.

• Set password complexity and length
requirements to help enforce stronger
passwords.

• Password strength feedback using
ION Setup.

These capabilities help
enforce authorizations
assigned to users,
segregation of duties,
and least privilege.



Security area Device security capabilities
Role in defense-in-
depth

Device configuration

• Internal time synchronization.

• Time source integrity protection and
meter configuration event logging.

• Timestamps, including date and time,
match the meter clock.

• The device embeds user information
when a change is made.

• SSH server hosts an internal SFTP
site and stores files in the meter’s
flash memory, such as webpages,
COMTRADE records, and firmware
files.

• Settings can be saved as a Security
Configuration File (.scf) using ION
Setup.

• Offload information to syslog or a
protected storage or retention
location.

These capabilities
support the analysis of
security and user
account events and help
protect the device from
unauthorized alteration
and record configuration
changes.

Device hardening

• Least functionality.

• Default port numbers can be changed
to lower the predictability of port use.

• Unused protocols can be disabled to
reduce the attack surface of the
device.

• Inactivity timeout requires sign in after
a time-period of inactivity for
webpages, display, and Secure ION
protocol.

• Limit the number of consecutive failed
login attempts.

These capabilities help
prohibit and restrict the
use of unnecessary
functions, ports,
protocols, and services.
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Security area Device security capabilities
Role in defense-in-
depth

Operation

• Machine and human-readable
reporting options for current device
security settings.

• Audit event logs to identify:

Meter configuration changes.

Energy management system
events.

• Audit record storage capacity
communication to notify a user when
the threshold is approaching.

• Audit storage capacity of 5,000 event
logs by default and alternate methods
for log management.

• Time source integrity protection and
event logged when changed.

These capabilities help
provide a method to
generate security-
related reports and
manage event log
storage.

Maintenance: Upgrade
and backup

• Digitally signed firmware is used to
help protect the authenticity of the
firmware running on the meter and
only allows firmware generated and
signed by the manufacturer.

This security capability
helps protect the
authenticity of the
firmware running on the
meter and facilitates
protected file transfer.

Decommissioning

• Purge shared memory resources
through device wiping and other
decommissioning tasks.

• Physical (recommended) or
sustainable device disposal
possibilities.

These capabilities help
prevent the potential
disclosure of data when
the device is
decommissioned.

For detailed information on the system defense-in-depth assumptions, see System defense-in-
depth assumptions.

For detailed information on how to help secure your device in a defense-in-depth protected
environment, see Recommended actions.

Security risks and mitigation strategies
Review the following issues and security risks and the mitigation strategies to help minimize these
risks:



Issue Security risk Mitigation strategies

User accounts

Default account settings
are often the source of
unauthorized access by
malicious users.

If you do not change the
default password,
unauthorized access can
occur.

Change the default password of 0
(zero) to help reduce unauthorized
access. See Changing the default
password.

Unencrypted protocols

ION, Modbus, DNP, DLMS,
IEC 61850, BACnet/IP, and
some IT protocols are
unencrypted.

The device does not have
the capability to transmit
data encrypted using these
protocols.

If a malicious user gained
access to your network,
they could intercept
communications.

Physically or logically segment the
network when transmitting data over
an internal network.

Encrypt protocol transmissions over
all external connections using an
encrypted tunnel, TLS wrapper, or
Secure ION.

For more information, see System
defense-in-depth assumptions.

Turn off unused protocols. For more
information, see Disabling and
enabling protocols and changing port
numbers.

Self-signed certificates

Factory shipped meters
include a self-signed SSL
certificate.

An SSL certificate is
required to use webpages
over HTTPS and Secure
ION (ION over TLS).

Self-signed certificates
cannot be validated. An
attacker with access to the
network could pose as the
device to obtain credentials
sent over the TLS tunnel.

Use a Certificate Authority (CA)
signed SSL certificate and external
network controls.

Configure
This section contains detailed information on the following tasks: 

• Meter security configuration in a protected environment

• Disabling and enabling protocols and changing port numbers

• Verifying the meter security settings

• Applying security settings to multiple meters

This section also includes the following reference information:

• Default meter security settings

• Advanced security mode
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Meter security configuration
Meter security configuration using ION Setup consists of the following tasks:

1. Open a Security Configuration File

2. Configure the meter security settings

3. Push the updated security settings to the meter

4. Store the updated SCF file

Opening a meter security configuration file

Meter security settings are stored in an encrypted Security Configuration File (SCF).

Use ION Setup to open an SCF file.

Prerequisites:

• Meter connection using ION Setup.

• Device credentials.

• Security configuration access.

To open the meter security configuration file:

1. In ION Setup, open the Setup Assistant for your meter.

2. Select Security > Security Mode > Edit.

3. If prompted, enter the meter password, and then selectOK.

4. Select the SCF file that you want to edit, and then selectOpen.

The Select security mode screen appears.

5. Select the Password Complexity.

TIP: For more information on the enforcement rules for each option, hover over the drop-
down.

6. Enter theMinimum Password Length.

NOTE: TheMinimum Password Length can be up to 16 characters and must be 6
characters or greater if Password Complexity is set to IEEE 1686-2013 or NERC CIP-
007-5.

7. Select Next.

The meter security configuration settings open in the ION Setup Security wizard.

Next, configure the meter security settings.

Related topics:

Storing Security Configuration Files



Configuring the meter security settings
After you open a SCF file, ION Setup displays the security settings in a Security wizard.

Use the ION Setup Security wizard to complete the following security configuration tasks:

• Disabling and enabling meter configuration options

• Defining lockout and event timeout

• Changing the default password

• Creating and changing user passwords

• Disabling and enabling webpages and time sync sources

• Editing meter access event logging

• Limiting user access

Changing the default password

Change the default password of 0 to help reduce unauthorized access. Default account settings
are often the source of unauthorized access by malicious users.

Prerequisites:

• Open a Security Configuration File in the ION Setup Security wizard.

To change the default password:

1. In the ION Setup Security wizard, click Next to navigate to Define individual
users/passwords.

2. Highlight USER1, and then click Password.

3. Enter and confirm the new password.

TIP: Hover over the text fields for character requirement details. Use a combination of
different characters to help strengthen the password. A password can be up to 16
characters long.

NOTICE
LOSS OF ACCESS

Ensure that the password you set is compatible with the device front panel and any
software used to communicate with the device.

Failure to follow these instructions can result in loss of access to the device.

While ION Setup supports up to 16 character passwords, some ION software clients may
not yet support passwords longer than 6 alphanumeric characters.

4. Click OK.

5. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.
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Disabling and enabling meter configuration options

Limiting configuration options, such as Modbus, webpages, and the display, and providing read-
only access reduces the attack surface of the meter.

Prerequisites:

• Open a Security Configuration File in the ION Setup Security wizard

To disable and enable meter configuration methods:

1. In the ION Setup Security wizard, click Next to navigate to Security Options.

2. In Security Options:

Select or clear Enable Web to enable or disable the ability to view meter settings online
using webpages.

Select or clear Allow setup by webpages to enable or disable the ability to change meter
settings using webpages.

Select or clear Allow Front Panel programming to enable or disable the ability to change
meter settings using the display.

Select from theModbus Access drop-down list:

None – Disables built-in Modbus map access.

Read/Write – Enables configuration of basic metering parameters using only Modbus
communications protocol.

Read Only – Enables ability to read metering parameters using only Modbus
communications protocol. This option is enabled by default.

3. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.

Disabling and enabling webpages and time sync sources

Disable webpages to deny a web browser to access the meter data. If your meter can be
accessed by a web browser outside your protected network, a malicious user could intercept
communications. See Disabling and enabling protocols and changing port numbers for details on
enabling HTTPS.

Disable the ability to modify the meter’s time source to help protect against disguised
communication from an unknown source as being trusted and possibly invalidating timestamps.
See “Configuring time information using ION Setup” for detailed steps on setting up the time
source.

Prerequisites:

• Open a Security Configuration File in the ION Setup Security wizard



To disable and enable webpages and time sync sources:

1. In the ION Setup Security wizard, click Next to navigate to Security Options.

2. In Security Options:

Select or clear Enable Web to enable or disable webpages for viewing meter data
online using a web browser.

Select or clear Allow Broadcasting Time Synchronization to enable or disable the
ability to modify the meter’s time synchronization source.

3. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.

Defining lockout and event timeout

A lockout prevents logging into a valid user account after a predefined number of unsuccessful
login attempts. Lockouts help reduce brute-force password attacks from succeeding.

Event timeout defines the time interval during which identical incorrect credentials are treated as a
single login attempt for event recording.

NOTE: Failed user login attempts over Ethernet—and any associated lockouts—will apply to
both ION and Secure ION. Failed user login attempts over other communication channels—
such as a serial port—are tracked separately.

You can define the following account lockout and event timeout options:

• Lockout after unsuccessful login attempts.

• Lockout duration.

• Event timeout for ION or Secure ION only, and only when not using ION sessions.

Prerequisites:

• Open a Security Configuration File in the ION Setup Security wizard

To define user lockouts and timeouts:

1. In the ION Setup Security wizard, click Next to navigate to Select protocol lockout
options:
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2. Select each protocol and click Edit to change lockout and timeout values for:

User lockout after unsuccessful login attempts.

Timeout for ION protocol only.

3. Enter a value for the Lockout duration in minutes.

4. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.

Editing meter access event logging

The event log monitors meter access events such as user logins and user account lockouts.

You can edit the default meter access event priorities that are logged to the event log to meet your
reporting requirements.

To monitor meter access events, see Monitoring the event log.

Prerequisites:

• Open a Security Configuration File in the ION Setup Security wizard.

To configure meter access event logging: 

1. In the ION Setup Security wizard, click Next to navigate to Select protocol lockout
options:



2. Click Events. The Event Priorities dialog box opens:

3. For each meter access event priority, set the value according to your reporting
requirements. The following table describes the priority value ranges:

Priority Description Value range

None Not recorded in the event log. 0

Info Only

The default event log cutoff value is 5. Event
values equal to or less than the cutoff value
are not recorded in the event log nor in
syslog records.

1–5

Recorded in the event log and in syslog
records.

6–63

Low

Produces low alarm.

Recorded in the event log and in syslog
records.

64–127
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Priority Description Value range

Medium

Produces medium alarm.

Recorded in the event log and in syslog
records.

128–191

High

Produces high alarm.

Recorded in the event log and in syslog
records.

192–255

4. ClickOK.

5. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.

You can also change event priorities for cybersecurity events using ION Setup Advanced Mode.

Limiting user access

Limit user access to the minimum level of access needed to perform their job functions.

Revoke user privileges when no longer needed due to role change, transfer, or termination. User
credentials do not expire.

NOTE: The maximum number of users is 50. Users can be added or removed at any time.

Prerequisites:

• Open a Security Configuration File in the ION Setup Security wizard

To define user access:

1. In the ION Setup Security wizard, click Next to navigate to Define individual
users/passwords.

NOTICE
DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.



2. For each user, select the user, and then assign their permissions:

See for Access information on the device access level permissions.

3. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.

Creating and changing user passwords

Create strong passwords for each user that requires access to the meter. Default account settings
and weak passwords are often the source of unauthorized access by malicious users.

To optimize cybersecurity in a protected environment, follow user account management tasks as
described by your organization or contact your network administrator, for example, maximum
password age or history policies.

Prerequisites:

• Open a Security Configuration File in the ION Setup Security wizard.

To change a password:

1. In the ION Setup Security wizard, click Next to navigate to Define individual
users/passwords.
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NOTICE
DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.

2. For each user that you want to assign or change a password:

a. Highlight the USER, and then click Password.

b. Enter and confirm the password.

TIP: Hover over the text fields for character requirement details. Use a combination of
different characters to help strengthen the password. A password can be up to 16
characters long.

c. ClickOK.

3. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.

You can also change the password through the Security User Module using ION Setup Advanced
Mode or by using Power Monitoring Expert.

Setting up Advanced security

Meter security has strong user login, user access management, and password complexity.

NOTE:We recommend that you use Advanced security mode.

For detailed information on the Advanced security mode capabilities, see Advanced security
mode.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.

• Security configuration access privileges.

To set up Advanced security:

1. Open ION Setup > select the meter > Setup Assistant.

2. Security > Security Mode > Edit. The Open Security Configuration file dialog box opens.

3. Select the advanced.scf security configuration file.

4. ClickOpen. If prompted, click Yes to use Advanced security.



5. Next, either:

Continue configuring the meter security settings.

Click Finish to push your security configuration changes to the meter.

Pushing updated security settings to the meter

After you have completed configuring the meter security settings, push the updated settings to the
meter.

To push the updated security settings to the meter:

1. In the ION Setup Security wizard, click Next until you reach the Security wizard pane that
has a Finish button.

2. Click Finish. A Confirmation message box opens.

3. Click Yes to confirm your changes.

ION Setup pushes your security configuration changes to the meter.

Next, store the Security Configuration File.

Storing Security Configuration Files

After ION Setup pushes the security configuration updates to the meter, it prompts you to store
the edited security settings to an encoded Security Configuration File (SCF).

We recommend that you store the SCF file using a new filename when you change the meter
security settings. If you do not use a new SCF filename, your changes will overwrite the settings in
the SCF file that you opened.

NOTE: If you don't store your security changes to a SCF file, your changes are stored on the
meter only; no other record of your security configuration is kept.

ION Setup stores SCF files in the following folder: C:\ProgramData\Schneider
Electric\ION Setup\Security

Store your meter’s Security Configuration File (SCF) in a protected location.

WARNING
POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

Store Security Configuration Files (SCF) to a secure site.

Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

Cybersecurity policies that govern how sensitive system files are securely stored vary from site to
site. Work with the facility IT System Administrator to ensure that such files are properly secured.
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Security log file

The first time you store a SCF file, ION Setup creates a security log file (SECURITY.LOG) in the
\Security folder.

The security log file contains the history of security configuration files saved from ION Setup.

Use SECURITY.LOG to track meter security configuration changes and to select the correct SCF
file for a meter whose security settings you want to edit or use in another meter.

NOTE: The security log file is stored as plain text.

Disabling and enabling protocols and changing port numbers
Disable unnecessary and unused communication protocol ports—such as SFTP, standard ION
protocol, and network ports—to reduce the meter attack surface. Change port number default
values to reduce the predictability of port use. See “Protocols, ports and connections" for port
defaults.

Leave Secure ION enabled for configuration changes and upgrades. If Secure ION is disabled,
use the display, Modbus programming, or webpages to access the meter.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.

• Security configuration access privileges.

NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To disable and enable protocols and change port numbers:

1. In ION Setup, select the meter, and then open Setup Assistant.

2. Click Communications > Advanced Ethernet > Protocols.

3. Select the protocol, and then click Edit.

4. Change the default port number.

5. Enable or disable the protocol.

6. ClickOK.

7. Click Exit.



Verifying the meter security settings
Generate a Meter Configuration Report to verify the meter security settings and user privileges.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.

To verify meter security settings:

1. In ION Setup, select the meter, and then open Setup Assistant.

2. Click Reports > Meter Configuration > Display. The Meter Configuration Report for your
meter opens.

3. Scroll down to the Security section to validate the meter security settings. For example: 

4. Click Close or Save As to save the report as a .txt file.

5. (Optional) Edit the meter security settings.

PowerLogic™ ION9000 series - User manual Cybersecurity

7EN02-0390-10 Public 48



Cybersecurity PowerLogic™ ION9000 series - User manual

49 Public 7EN02-0390-10

Viewing the Device Configuration Checklist
View the Device Configuration Checklist to verify that the default password is not being used.

To view the checklist:

1. Click Tools >Options.

2. Click the Assistant tab and select the Configuration Checklist check box.

Applying security settings to multiple meters
A Security Configuration File (SCF) can be applied to other meters. If differences in capabilities
between meters exist, ION Setup will indicate a capability is not available.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.

• Saved Security Configuration File (.scf).

NOTICE
DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.



To apply security settings to multiple meters:

1. Open ION Setup > select the meter > Setup Assistant.

2. Security > Security Mode > Send. The Open Security Configuration file dialog box opens.

3. Open the meter security configuration file.

TIP: Open the security log file to determine the SCF file you want. See Opening a meter
security configuration file for more information.

4. Click Yes to confirm the security update.

The security settings in the SCF file are sent to the meter.

5. Click Exit.

Updating passwords on multiple meters
Use the ION Setup Diagnostics tool to update passwords on multiple meters at the same time.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.

• Security configuration access privileges.

NOTICE
DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.

To update passwords on multiple meters: 

1. Open ION Setup > select the System.

2. Tools > Diagnostics. The Systems diagnostics: System dialog box opens.

3. Select the Tools tab > Advanced Security Password Updater.

4. ClickOpen.

5. Select the meters that need a password update.

6. Click Set Info.

7. Click Start.

8. Click Allow passwords to be visible.

9. Select each user, click Password, and then enter a new password.

If the meter is connected to a display, update the password for the Front Panel.

10. Click Start. A Notice message box opens.
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11. Click Proceed. A result is displayed for each device.

12. Click Save As to save a copy of updated meter passwords in a .txt file. The Save As dialog
box opens.

13. Save the file with a unique file name to a protected location. An ION Setup message box
opens

14. ClickOK.

15. Click Exit.

16. Click Close.

Default meter security settings
Review the following default meter security settings to understand how you can securely
commission your meter:

Area Setting Default

Communications
protocols

HTTPS with HTTP redirect Enabled

SSH Terminal Disabled

SFTP Enabled

SNMP Disabled

Modbus TCP Enabled

ION Enabled

ION over TLS (Secure ION) Enabled

MQTT Disabled

BACnet/IP Disabled

Time and time
keeping

Broadcast time synchronization Enabled

Webpages Webpages Enabled

Configuration

Configuration using the display Enabled

Configuration using webpages Disabled

Configuration using Modbus
programming

Disabled

Meter access
event logging

See Editing meter
access event
logging for details.

Valid login event priority 0 (No priority)

Invalid login event priority 128 (Medium priority)

Lockout event priority 255 (High priority)



Area Setting Default

Security mode

Advanced security mode
(advanced.scf)

Enabled if Advanced security was
used before upgrading meter
firmware to v3.0.0. See Advanced
security mode for details.

Legacy security support
(standard.scf)

Enabled if Standard security was
used before upgrading meter
firmware to v3.0.0.

We recommend that you use
Advanced security mode.

See:

• “Legacy security support” for
details on Legacy security
support.

• Setting up Advanced security for
information on switching to
Advanced security mode.

For recommendations on how to configure and use your meter in a protected environment, see
Recommended actions.

Advanced security mode
Advanced security mode lets you add up to 50 users, has strong user login, and privilege
management.

NOTE:We recommend that you use Advanced security mode.

This topic lists the advanced mode security capabilities, as well as detailed information on user
access permissions, and the default username and password.

Advanced security mode capabilities

The following table lists the security capabilities of advanced security mode:
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Security capability Description

User credentials and
password robustness

Use a single account to access the meter with a numeric password
for login.

Use multiple user accounts with alphanumeric passwords for login
and configuration changes.

Use any combination of valid characters, with a maximum length
of 16 characters.

Define a minimum password length requirement.

Enforce password character requirements using industry-standard
password complexity options.

Password strength feedback using ION Setup.

User account lockouts and
timeouts

Define user account lockout criteria after unsuccessful login
attempts and define event timeout period.

User privileges
User accounts with variable permissions to read access, test
mode, or configuration privileges.

Webpages
Disable or enable webpages for viewing meter data online using a
web browser (Web Server).

Configuration

Disable or enable ability to configure the meter using:

• Modbus communications programming or allow read-only
viewing.

• The display

• Meter webpages (Web Server programming).

Disable and enable time synchronization.

Password required for broadcast time synchronization
configuration changes using the display or communication
protocols.

Cybersecurity event logs
and reports

Set up cybersecurity event logs and alarms using event priorities.

User access (Advanced security mode only)

The following table lists the Advanced security mode user access details: 

Access type Permission

Time Sync Access Set the meter’s time and time synchronization parameters.

Read Access View parameters, except security configuration.

Peak Demand Reset
Access

Reset peak demand values.

Comm Config Access Configure communication settings.

Test Mode Access Switch the meter to test mode, if available with your meter type.



Access type Permission

Full Meter Config Access Configure meter settings.

Security Config Access Configure security settings.

User accounts (Advanced security mode only)

The following table lists the Advanced security mode user account details:

Username Default password Account description

User1 0 (zero)
Default administrator. This account has full meter
access, including configuration.

User2 0 (zero)
Default viewer. This account has view only
access.

User3, User4, ...
User50

-
These user accounts are not activated; they do
not have default passwords.

Related topics:

Changing the default password.

Legacy security support

Setting up Advanced security troubleshooting

Operate
Review the following recommended actions to operate your device in a protected environment: 

• Monitoring the event log

• Revenue lock LED behavior

• Reporting a security incident or vulnerability

Monitoring the event log
Monitor event logs for suspicious activity and to help identify the cause of cybersecurity breaches
that could lead to a cybersecurity incident.

NOTE: The default event log limit is 5,000 records. When the limit is reached, new log entries
overwrite older ones. To be notified when the Event Log record limit is approaching, see
Assigning a designated reader for event log notification. To extend log record retention, offload
information to syslog or a protected storage or retention location, see Configuring Syslog
network settings using ION Setup.

For more information on meter access logging events, see Editing meter access event logging.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.
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To monitor the event log:

1. In ION Setup, select the meter, and then open Setup Assistant.

2. Click Reports > Event Log > Display.

3. Select the range of records you want to view, the type, and then clickOK.

4. Click Save As to save the log to your local machine or print the event log.

5. Click Close.

Reporting a security incident or vulnerability
To report suspicious activity or a cybersecurity incident, go to the Schneider Electric Report an
Incident website.

To report a security vulnerability affecting your product or solution, go to the Schneider Electric
Report a Vulnerability website.

Maintain
This section contains information on the tasks you should perform periodically to help maintain
the security of your meter in a protected environment.

Viewing and downloading an event log
Generate an event log report to assist with cybersecurity incident investigations.

Event logs contain meter configuration changes and energy management system events.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.

• Configured event logs and alarms.

To view and download an event log:

1. Open > select the meter > Setup Assistant.

2. Click Reports > Event Log > Display. The Log reports dialog box opens.

3. Select a record range for the report and clickOK:

The Event Log for your meter opens.

https://www.se.com/ww/en/work/support/cybersecurity/report-an-incident.jsp
https://www.se.com/ww/en/work/support/cybersecurity/report-an-incident.jsp
https://www.se.com/ww/en/work/support/cybersecurity/report-a-vulnerability.jsp
https://www.se.com/ww/en/work/support/cybersecurity/report-a-vulnerability.jsp


NOTE: Only All available records and Last options are available for Event Logs.

4. Click Save As.

5. Select CSV or TXT > Save.

6. Click Close.

Upgrades and security configuration
When meter firmware or ION Setup software is upgraded – Security configuration remains the
same until changed, including usernames and passwords. It is recommended security
configuration is reviewed after an upgrade to analyze privileges for new or changed device
features and revoke or apply them according to your company’s policies and standards.

For detailed information on upgrading firmware, see Firmware upgrades.

Decommission
Review the following recommended actions to decommission your device in a protected
environment: 

• Record activities – Document disposal actions according to your company’s policies and
standards to keep a record of activities.

• Wiping the device

• Decommission-related rules and sanitize records:

Follow decommission and sanitization tasks as described by your organization or contact
your network administrator.

Decommission network and security rules. For example, a firewall rule that could be used
to get past the firewall.

Perform records tracking sanitization tasks to remove records in related systems. For
example, monitoring SNMP servers.

• Disposal, reuse, recycling

Wiping the device
Wipe the device before decommissioning it to help prevent potential disclosure of data.

Prerequisites:

• Meter connection using ION Setup.

• Login credentials.

• Security configuration access privileges.
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NOTICE
DATA LOSS

Save all important data from the device before performing a reset.

Failure to follow these instructions can result in data loss.

NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with your device.

Failure to follow these instructions can result in loss of access to the device.

Your device might have stored users, passwords, or certificates. Wiping the device in the
following order helps ensure that confidential information is not left on the device.

NOTICE
LOSS OF CONFIDENTIALITY
• Ensure that you follow all device wiping steps in the order listed.
• Overwrite the communications module registers last to maintain meter connectivity.

Failure to follow these instructions can result in loss of confidentiality.

To wipe the device:

1. Overwrite the meter template file. This overwrites the meter template with the default factory
template. See “Overwriting the Meter template file” for detailed steps.

2. Delete files in the documents folder in SFTP file directory using SFTP client software. See
“SFTP” for more information.

3. Delete the custom SSL certificate. See “Deleting a custom SSL certificate” for more
information.

4. Delete webpages. See “Deleting custom webpages” for more information.

5. Delete the IEC 61850 configuration file. This deactivates functions related to the IEC 61850
protocol. See “Deleting an IEC 61850 configuration file” for more information.

6. Restore default security configuration. See “Restoring default security configuration” for
more information.

7. Overwrite factory module registers. This deletes values for:

Device owner.

Device tag.



Device location.

Device name.

See “Overwriting factory module registers” for more information.

8. Perform a Master Reset. This deletes values for:

Event log, data, and waveform records.

Power quality event (COMTRADE) files.

Energy, metering, min./max., revenue and test mode, and peak demand values.

Disturbance (sag/swell event) counter, EN 50160 parameters and statistics.

9. Overwrite communications module registers. This deletes values for network infrastructure
details. See “Overwriting communications module registers” for more information.

Overwriting the meter template file
1. Go to www.se.com and search for the meter template for your device.

2. Download the ZIP file and extract files.

3. Open ION Setup.

4. Click the meter to select it > Setup Assistant.

5. Click Template > Send to Meter tab.

6. Click Send.

7. Navigate to the extracted files and select the DCF file.

NOTE: FWN file type is also an option.

8. ClickOpen.

9. Click Proceed. The Template Paste Options dialog box opens.

10. Clear all check boxes and clickOK.

11. Click Yes. The overwriting process could take a few minutes.

12. ClickOK.

13. Click Exit and thenOK.

Restoring default security configuration

NOTICE
DATA LOSS

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in loss of data.
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1. Open ION Setup > select the meter > Setup Assistant.

2. Click Security > Security Mode > Edit. The Open Security Configuration file dialog box
opens.

3. Select the standard.scf and clickOpen. If prompted, click No to use Legacy security
support.

4. Click Next to navigate to the Define individual users/passwords screen.

5. Click Finish. The Confirmation message box opens.

Overwriting factory module registers
1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

3. Double-click Factory Modules folder > select meter type.

4. Select the Setup Registers tab.

5. Type text or characters to replace values for these setup registers by selecting them and
click Edit:

FAC1 Device Namespace.

FAC1 Device Name.

FAC1 Owner.

FAC1 Tag1.

FAC1 Tag2.

6. Click Send.

Overwriting communication module registers
1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced.

3. Double-click Comm Modules folder > Ethernet > Setup Registers.

4. Type text or characters to replace values for network infrastructure setup registers by
selecting them and clicking Edit. Some registers include:

Stored IPv4 Address.

Stored IPv4 Subnet Mask.

Stored IPv4 Gateway.

NOTE: IP values can be replaced with text.

Primary DNS.

Secondary DNS.

All servers.

All port numbers.

Ethernet Device Name.



Stored IPv6 Global Gateway.

Domain Name.

5. Click Send.

Disposal, reuse, recycling
Before removing the device from its intended environment, follow the recommended actions in
Decommission.

Follow device removal tasks described by your organization or contact your network administrator
to determine a responsible method of disposal.

Dispose the device according to the legislation of the country. Some regulatory organizations
include:

• The United States Environmental Protection Agency (EPA) for guidance on the sustainable
management of electronics.

The EPA provides an Electronic Product Environmental Assessment Tool (EPEAT) that
helps assess the environmental attributes of electronics.

• The European Waste Electrical & Electronic Equipment Directive (WEEE Directive) is
the community directive on waste electrical and electronic equipment.

• The European Restriction of Hazardous Substances Directive (RoHS) directive on the
restriction of the use of certain hazardous substances in electrical and electronic equipment.

NOTICE
UNAUTHORIZED OR UNINTENDED ACCESS TO CONFIDENTIAL DATA

Store devices that are not in service in an access-controlled or monitored location.

Failure to follow these instructions can result in unauthorized or unintended access to
sensitive or secure customer data.

Device disposal

It is recommended that the entire device is physically destroyed. Destroying the device helps
prevent potential disclosure of data contained in the device that was not removed.

WARNING
HAZARD OF PHYSICAL INJURY
• Do not destroy devices without the proper safety training.
• Never burn a device, put a device in a microwave, or pour acid on a device.

Failure to follow these instructions can result in death or serious injury.

Device reuse

Store the device in a location that is access controlled or monitored if there is potential for reuse.
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Device recycling

Go to www.se.com and search for the Product Environmental Profile for your meter type to get
instructions on managing e-waste.



Installation and commissioning
This chapter supplements the meter installation guide and provides guidance on commissioning
your meter.

• See your device installation guide for information related to installation.

• See your product catalog pages at Schneider Electric for information about your device, its
options, and accessories.

• Download updated documentation from www.se.com.

For the latest information about your product, or for assistance in advanced features and custom
functionality, contact your local Schneider Electric representative.

Installation
Installation, wiring, testing and service must be performed in accordance with all local and
national electrical codes.
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DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

• Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

• Always use a properly rated voltage sensing device to confirm that all power is off.

• Do not use the data from the meter to confirm power is off.

• Do not exceed the maximum ratings of this device.

• Do not short secondary terminals of Voltage Transformer (VT).

• Do not open secondary terminals of Current Transformer (CT).

• Ground secondary circuit of CTs.

• Use only Low Power Current Transformers (LPCTs) that are approved for use with this
device.

• Do not connect CT secondary signals to meter low voltage LPCT terminals.

• Do not install CTs or LPCTs in equipment where they exceed 75% of the wiring space of any
cross-sectional area in the equipment.

• Do not install CTs or LPCTs in areas where ventilation openings may be blocked or in areas
of breaker arc venting.

• Do not install CTs or LPCTs using Class 2 wiring methods or connect to Class 2 equipment.
See NFPA 70.

• Secure CT or LPCT secondary conductors to ensure they do not contact live circuits.

• Assume communications and I/O wiring are hazardous live until determined otherwise.

• Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

Power system wiring
You can connect the meter’s voltage inputs directly to the phase voltage lines of the power system
if the power system’s line-to-line or line-to-neutral voltages do not exceed the meter’s direct
connect maximum voltage limits. For more information, see Electrical characteristics.

If your system voltage is greater than the specified direct connect maximum voltage, you must
use voltage (potential) transformers (VTs/PTs) to step down the voltages. Use high-bandwidth
voltage transformers in high-speed transient capture applications (ION9000T only).

The maximum voltage allowed for direct connection might be lower than the manufacturer-
specified limits, depending on the local electrical codes and regulations.



Residual current measurement
The meter can calculate or measure the residual current, depending on how the inputs are wired.

3 CT wiring

For a 3-phase 3-wire system, the meter
calculates residual current for Ground.

For a 3-phase 4-wire system, the meter
calculates residual current for Neutral.

For a 3-phase 3-wire system, the meter
measures the residual current for Ground at I4.

For a 3-phase 4-wire system, the meter
measures the residual current for Neutral at I4.

4 CT wiring

For a 3-phase 4-wire system, the meter
calculates residual current for Ground.

For a 3-phase 4-wire system, the meter
measures the residual current for Ground at I5.

Functional ground
The meter’s functional ground terminal must be wired for optimal performance.

Use the supplied ferrite when terminating the functional ground terminal to earth ground. Make
sure the ground wire is looped through, around and back through the ferrite as shown.
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LVCS overview
The Low Voltage Current Sensor (LVCS) hardware option is used with external low voltage
current transformers to sense current in each phase of a power feed. Use the LVCS option to:

• Measure and monitor individual phases.

• Help reduce installation costs for new or retrofitted installations.

• Provide non-intrusive load monitoring.

LVCS only works with voltage output Low-Power Current Transformers (LPCTs) and is intended
for use with listed Energy-Monitoring current transformers rated for the application. To use LVCS,
an ION9000 LVCSmeter is required. See ION9000 meter models and accessories for a list of
meters that support LVCS.

LPCT configuration
This section assumes your meter and LPCTs are already installed. For more information related
to installation, refer to the ION9000 series – LVCS installation guide at www.se.com.

This section illustrates two common LPCT configuration scenarios and how they are configured
using ION Setup. You can also configure LPCTs using the meter webpages or display.

Configuration scenario 1: LPCT connected directly to conductor 

The LPCT is connected directly to the line to be measured.

LPCT transformation ratio 10A:1V
Meter transformation ratio (default) 1A:1V



Example:
Set the meter CT ratio to 10:1 to match the transformation ratio of the LPCT and report the
conductor primary current.
CT ratio:

= LPCT ratio x Meter ratio
= 10:1 x 1:1
= 10:1

Configuring LPCT connected directly to conductors

I1–I3

1. Open ION Setup > select the meter > Setup Assistant.

2. ClickMetering Setup > Basic tab.

3. Set the LPCT CT primary value:

a. Select PM1 CT Prim > Edit. The LVCS Configuration Setup dialog box opens.

b. Enter the LPCT primary value.

c. ClickOK.

4. Set the LPCT CT secondary value:

a. Select PM1 CT Sec > Edit. The LVCS Configuration Setup dialog box opens.

b. Enter the LPCT secondary value.

c. ClickOK.

The CT Prim and CT Sec values are stored to the device register.

I4, I5

Configure these settings inMetering Setup > Advanced tab.

Configuration scenario 2: LPCT connected to secondary side of conventional CT

The LPCT is connected to the secondary side of a conventional transformer.
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CT1 (L1) transformation ratio 500A:5A
LPCT transformation ratio 10A:1V
Meter transformation ratio (default) 1A:1V

Example:
The total transformation ratio is the product of all component transformation ratios. Set the meter
CT ratio to match the total transformation ratio and measure the primary current at CT1.
CT ratio:

= CT1 ratio x LPCT ratio x Meter ratio
= 500:5 x 10:1 x 1:1
= 5000:5 (or 1000:1)

Configuring LPCT connected to secondary side of conventional CT

I1–I3

1. Open ION Setup > select the meter > Setup Assistant.

2. ClickMetering Setup > Basic tab.

3. Set the LPCT and conventional CT primary values:

a. Select PM1 CT Prim > Edit. The LVCS Configuration Setup dialog box opens.

b. Enter the LPCT primary value.

c. ClickOK.

d. Select the Conventional CT check box.

e. Enter the conventional CT primary value. The calculated PM1 CT Prim value is
displayed.

f. ClickOK.

4. Set the LPCT and conventional CT secondary values:

a. Select PM1 CT Sec > Edit. The LVCS Configuration Setup dialog box opens.

b. Enter the LPCT secondary value.



c. ClickOK.

d. Select the Conventional CT check box.

e. Enter the conventional CT secondary value. The calculated PM1 CT Sec ratio is
displayed.

f. ClickOK.

The calculated CT Prim and CT Sec values are stored to the device register.

I4, I5

Configure these settings inMetering Setup > Advanced tab.

LPCT compensation
Minor phase and magnitude compensation can be made using the Instrument Transformer
Correction (ITC) module.

For more information on the ITC module, see ION Reference, available on www.se.com.

Removing the display from back-to-back mounting adapter
Instructions on how to remove the display, for example, if you want to connect it to another meter.

NOTE: Refer to the display installation sheet QGH42230 for installation instructions.

1. Holding the display, turn the tightening wheel with a flat-head screwdriver until it disengages
from the display.
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2. Carefully pull the display away, far enough to access the cable connector on the display.

3. Disconnect the display cable.



Removing the meter from back-to-back mounting adapter
You can uninstall the meter from the optional back-to-back mounting adapter.

NOTE: Refer to the meter installation guide for installation instructions.

1. Use a flat-head screwdriver to unlock the meter retainer clips.

2. Holding the meter firmly, swing it outwards and pull slightly upwards to detach it from the top
retaining hooks.
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Option modules
Option modules are ordered separately from your meter and can be connected to your meter
without specialized equipment.

Option modules are identified based on how they are physically connected to the meter’s external
I/O bus.

The first connected module, attached directly to the meter, is Module A. The second module,
attached to Module A, is Module B. The meter supports up to four external modules:

Option modules are monitored and controlled by the meter’s ION modules. External I/O modules
are mapped to the corresponding ION modules:

Option module physical position ION module mapping

Module A to Module D Port A to Port D

Option module terminal connector label ION module mapping

Analog inputs A1 to A(n) Analog Input module A1 to A(n)

Analog outputs Q1 to Q(n) Analog Output module Q1 to Q(n)

Digital inputs S1 to S(n) Digital Input module S1 to S(n)

Digital/relay outputs R1 to R(n) Digital Output module R1 to R(n)



Maximum number of option modules
Up to four option modules are supported per device.

Limitations:

• Only one 4-wire RS-485 module and one Fiber Ethernet module may be installed.

• Depending on the type and quantity of option modules attached to your meter, you may need
to reduce your meter’s maximum operating temperature or limit the number of option
modules. See Environmental characteristics for more information.

Commissioning
Factory default settings

Use these default values the first time you connect to your meter.

Parameter Default value

Username USER1

Password 0

IP address1 169.254.0.10

Subnet mask 255.255.0.0

Gateway 0.0.0.0

RS-485
COM1 Unit ID: 100

COM4: Unit ID: 103

Language English

1 The IPv6 link local address can also be used. See Self-discovery over Ethernet for details.

Commissioning using ION Setup
Use ION Setup to commission the meter for integration into your energy management system.

Connect to your meter using ION Setup then use the Setup Assistant to configure the meter.
Setup parameters are arranged in logical groupings and category folders.

Before exiting the Setup Assistant, ION Setup performs a meter configuration test and displays
the results. You can review the results and make changes as needed.

To turn off the meter configuration test:

1. Click Tools >Options.

2. Click the Assistant tab and clear the Configuration Checklist check box.

NOTE: ION Setup also performs a configuration test and displays results when configuring
certain features such as the Sag/Swell or Transient Logging wizard in the Power Quality setup
assistant.

PowerLogic™ ION9000 series - User manual Installation and commissioning

7EN02-0390-10 Public 72



Installation and commissioning PowerLogic™ ION9000 series - User manual

73 Public 7EN02-0390-10

Configuring metering parameters
Use ION Setup to configure the meter’s metering functionality.

1. Start ION Setup and open the Setup Assistant for your meter.

2. Configure the parameters inMetering Setup > Basic.

Parameter Values Description

Volts Mode
4W-WYE, DELTA, 3W-
WYE, SINGLE, DEMO1 Power system type

PT Prim 1–999,999
Potential transformer's primary winding voltage
rating

PT Sec 1–999,999
Potential transformer's secondary winding
voltage rating

CT Primary 1–999,999
Current transformer's primary winding current
rating

CT
Secondary

1–999,999
Current transformer's secondary winding
current rating

Nominal
Voltage

1–999,999
Nominal voltage (V) used for metering functions
such as harmonic calculations and sag/swell
detection

Nominal
Current

1–999,999
Nominal current (A) used for metering functions
such as harmonic calculations and sag/swell
detection

Nominal
Frequency

50, 60
Nominal frequency (Hz) used for metering
functions such as alarms

Basic tab

3. Configure the parameters inMetering Setup > Advanced, if appropriate.

Parameter Values Description

PhaseOrder ABC, ACB
Power system’s rotation order of voltage
phases

V4 PT Prim 1–999,999
V4 potential transformer's primary winding
voltage rating

V4 PT Sec 1–999,999
V4 potential transformer's secondary winding
voltage rating

I4 Prim 1–999,999
I4 current transformer's primary winding
current rating

Advanced tab



Parameter Values Description

I4 Sec 1–999,999
I4 current transformer's secondary winding
current rating

I5 Prim 1–999,999
I5 current transformer's primary winding
current rating

I5 Sec 1–999,999
I5 current transformer's secondary winding
current rating

Scale Rev
Param

ON, OFF
Specifies whether revenue readings are
presented as primary or secondary side values
(ON = primary side, OFF = secondary side)

1 Demo mode is for demonstration only, and does not use the meter input terminals to display
values.

Using the Phasor Viewer
Phasor diagrams can help verify or troubleshoot issues with voltage and current input wiring.

Use ION Setup’s Phasor Viewer to display a real-time phasor diagram of the voltage and current
input signals.

To use the Phasor Viewer:

1. Start ION Setup and open the Setup Assistant for your meter.

2. ClickMetering Setup > Phasor.

3. Select Phasor Viewer and click Show.

4. To change the polarity of the voltage or current inputs, click Show Setup to display the
Polarity Settings.

Select the box beside the input you want to invert polarity, then click Apply to Meter.

Basic setup using the webpages or display
You can use the meter webpages or display to configure basic metering parameters.

• Using the webpages: Navigate to Setup >Metering.

• Using the display: Navigate to Setup Menu >Meter Setup.
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Communications
Communications overview

Communications is the transfer of data to and from the meter and is controlled by a combination of
hardware and software components in the meter.

For each connected communications port, the meter uses the applicable communications
protocol to establish communications with other devices or software. The protocol manages the
communications session and defines the set of rules, commands, and packet structure of the
transmitted data. You can also control which protocols are enabled or disabled on the meter.

NOTE: To maximize the performance of your power management system, it is recommended
that devices be connected directly to an Ethernet network.

Other means of controlling communications, such as who can access certain types of meter data,
are discussed in the security topics for the meter.

Your meter’s default protocol settings meet the needs of most systems with only basic
configuration. You can customize these settings to meet your specific needs. These are
advanced procedures that require an understanding of your meter’s architecture, supported
protocols, and the communications network and power system that your meter is connected to.

Ethernet communications
Your Ethernet connection source should be installed in a location that helps minimize the overall
Ethernet cable routing length and complexity of your network.

The meter supports a single IP address for both physical Ethernet connections.

Your device’s second Ethernet port acts as an Ethernet switch to help simplify network
connections and reduce installation time and costs, by having shorter Ethernet cable runs
between devices without needing additional Ethernet routers or repeaters. You cannot connect
your meter to two different Ethernet networks. The two Ethernet ports do not split the signal, so
connecting both ports should not impact your communications speed.

The meter uses dual-stack IPv4/IPv6 routing technology to manage network communications and
allow network hosts to communicate with the meter using either IPv4 or IPv6.

Ethernet communications connections
Your meter’s dual port Ethernet connections enable you to use straight-line or network loop (ring)
topology.

If local network loop Ethernet topology is required, you must enable RSTP for your meter’s
Ethernet communications to function.

Use CAT5 (or higher) Ethernet cables with unshielded RJ45 modular connectors to wire your
meter’s Ethernet communications.
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Ethernet loop topology

A Ethernet switch or hub

B Ethernet connected meters

C LAN / WAN



Protocols, ports, and connections
The Ethernet protocols supported by your device allow simultaneous connections through the IP
service ports.

By enabling or disabling Ethernet protocols, you can control whether your meter accepts new
socket connection requests. Changing settings for one port does not impact the other existing
connections. Depending on the protocol, you can also change the port number.

NOTE: Some protocol port numbers are read-only and not configurable.

Protocol Port (default) Number of connections

ION (ION over TCP) 7700 8 1

Secure ION (ION over TLS) 7443 8 1

Modbus TCP 2 502 8 1

Modbus RTU over Ethernet 2 7701 8 1

BACnet/IP 47808 N/A

DNP 20000 8 1

DLMS 4059 8 1

Modbus TCP (dedicated) 2 502 32

EtherGate (COM1) 7801 1

EtherGate (COM4) 7802 1

DHCP 67 (68) 1

SFTP 22 2

Webserver (HTTPS) 3 443 10

SNMP 161 N/A

SMTP server (email) outgoing only 25 1

NTP 123 1

IEC 61850 102 5

Protocol, ports, and connections

1 – These eight simultaneous connections are shared by ION, Secure ION, Modbus TCP, Modbus
RTU over Ethernet, DLMS and DNP. You can have a maximum of three DNP connections. You
can have a maximum of one DLMS connection.
2 – These protocols must be enabled for Modbus gateway functionality.
3 – These are used for the meter’s webpages.
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Self-discovery over Ethernet
Your meter supports Devices Profile for Web Services (DPWS) which allows for self-discovery of
the meter when it is connected to your local area network.

When you connect your meter to your network, your meter automatically appears in your network
in Windows Explorer under Other Devices. By default, the meter is named <meter type>-<last six
digits of MAC address>. For example, a meter with a MAC address of 006078173393 appears on
the network as <meter type>-173393.

A Computer connected to the network with IPv6 enabled

B LAN / WAN (Local Area Network / Wide Area Network), common subnet, no routers

C Meters with self-discovery over Ethernet connected to the network

Considerations for using self-discovery over Ethernet
• For self-discovery, the meter must be connected directly to the network using only a cable or
switches, and not going through a router.

• You must use a computer running Windows 7 or later with IPv6 enabled to use self-discovery
over Ethernet.

• The computer and the meter must be on the same subnet.

• You do not need to configure your meter’s IP address for self-discovery over Ethernet. An
IPv6 address is automatically generated from your meter’s MAC address and self-discovery
takes place over IPv6.

Accessing the meter through self-discovery

UseWindows Explorer to locate and access the meter on your Local Area Network (LAN).

NOTE: Some networks restrict device self-discovery over a wireless connection. If this is the
case, make sure your computer is connected to the network using an Ethernet cable.

To access the meter through self-discovery:



1. Connect the meter’s Ethernet port to the LAN.

2. Start Windows Explorer.

3. Click Network.

The connected network devices display.

4. Locate your meter with the name <Device Name>-<Last 6 digits of MAC address>.

5. Double-click the icon to open the meter webpages.

Ethernet configuration
To use Ethernet communications, you must configure your device’s IP settings.

You need to enter network information for any Ethernet servers used by the device (for example,
a DNS or email server). Contact your network system administrator for your IP address and other
Ethernet network configuration values.

NOTE: For meters that do not have a display, you must connect your meter directly to your
computer to set a unique IP address for each device or configure the meter to use a DHCP
server to acquire IP addresses.

It is recommended that you test your communications with the meter after changing any
communications-related settings (for example, communicating with the meter using the fully-
qualified domain name if using DNS or with assigned addresses after these are provided by the
DHCP server). In addition, make sure that any software or other devices communicating with the
meter are using the new settings.

Initial Ethernet configuration versus changing existing Ethernet settings

There are two scenarios when configuring your meter’s Ethernet communications settings: initial
configuration and changing the existing addresses when the meter is in use.

• Initial configuration: Configure your device’s Ethernet settings manually using the display or
by connecting your meter directly to your computer and using a web browser to access the
device’s webpages. Alternately, you can connect your meter to the network and configure it to
use a DHCP server to acquire an IP address.

NOTE: It is recommended during initial configuration that you use a connection method
other than the one you are trying to configure. For example, if you are configuring DHCP
IPv4 settings, connect to the meter using the IPv6 Link Local address or a serial connection.
This allows you to configure the meter without being disconnected.

• Changing existing IP settings: After the meter’s Ethernet port is configured and connected to
the LAN, you can use ION Setup to configure meter settings, in addition to using the display or
meter webpages.

In either case, modify your meter’s Ethernet settings to those provided by your network system
administrator before connecting the device to your local area network (LAN).
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IP address format and ranges

When you set your meter’s IPv4 or IPv6 addresses, make sure you use the correct format and
valid ranges.

Protocol Format

IPv4 0.0.0.0 to 255.255.255.255

IPv6

:: to FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF

The double colon indicates that gaps are filled with zeroes to make
the IPv6 address the correct length (32 hexadecimal numbers)

All meters ship from the factory with the IPv6 global address and IPv6 gateway undefined (set to
“::”). To communicate with the meter using IPv6 outside the local network, you must configure
these settings manually or use DHCP to assign the addresses to the meter. Within the local
network, you can use the meter’s IPv6 Link Local address.

IP addresses and network port numbers

To specify a port for an outgoing IP address, append a colon then the port number to the end of
the IP address. For IPv6 addresses, enclosed the address in square brackets then add the port
number. For example, to specify the default port for SFTP (port 22):

• IPv4: 169.254.0.10:22

• IPv6: [FE80::260:78FF:FE04:5943]:22

Configurable Ethernet settings

NOTE: Some additional Ethernet settings are available in the Advanced Ethernet menu in ION
Setup and on the meter webpages.

“W” indicates the setting can be configured (written) while “R” indicates it is read-only.

Setting Display ION Setup Webpages

IPv4 address W W W

IPv4 Subnet mask W W W

IPv4 Default gateway W W W

IPv4 Assignment Mode
(DHCP/Stored)

W W W

IPv6 Assignment Mode
(DHCP/Stored)

W W W

Ethernet Device name R W W

Domain name R W W

Ethernet configuration settings



Setting Display ION Setup Webpages

IPv6 enabled W W W

IPv6 Link Local Address R R R

IPv6 global address R W W

IPv6 gateway R W W

Ethernet Rx timeout — W W

Modbus TCP timeout — W W

Modbus gateway — W —

MAC address R R R

Ethernet primary DNS R W W

Ethernet secondary DNS R W W

Configuring IPv4 / IPv6 communications settings using ION Setup

You can configure your device’s IPv4 and IPv6 address settings, such as stored addresses or
address assignment mode, using ION Setup.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access additional data.

NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

Contact your network system administrator for your IP addresses and other Ethernet network
configuration values.

To configure IPv4 / IPv6 communications settings using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your device.

3. Click Communications > Basic Ethernet > IPv4 (or IPv6).

4. Select the IP address then click Edit.
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5. Select your IP address assignment mode.

Selection Mode Description

Use DHCP to obtain an
IPv4 address

DHCP

The meter acquires its IP addresses from
your network’s DHCP server. The Device
Name and Domain Name fields are used to
define the meter’s fully-qualified domain
name (FQDN).

Use the following IPv4
address

Stored
The meter uses the IP addresses that you
manually enter for IPv4 (address, subnet
mask and gateway).

IPv4

For IPv6, select the IPv6 Enabled check box to enable IPv6 communications or clear it to
disable IPv6 communications.

NOTE: The IPv6 Link Local address is factory set and is read-only.

Selection Mode Description

Use DHCP to obtain an
IPv6 address

DHCPv6

The meter acquires its IP addresses from
your network’s DHCPv6 server. The Device
Name and Domain Name fields are used to
define the meter’s fully-qualified domain
name (FQDN).

Use the following IPv6
address

Stored
The meter uses the IP addresses that you
manually enter for IPv6 (global address and
default gateway).

IPv6

You can have different assignment modes for IPv4 and for IPv6.

6. Configure the settings for the selected mode then clickOK.

The changes are saved to the meter. If ION Setup detects that the connection information is
already in use, you are prompted to confirm the change.

7. Click Yes to confirm the change or No to cancel.

An example of an instance where you might want to confirm the change is if you are
programming the meter to replace another meter already in service.



Parameter Value Description

Device name
Contact your local network
administrator for parameter
values.

The Ethernet device name is used by:

• DPWS for self-discovery over Ethernet.

• The hostname to uniquely identify your
meter for DHCP and DNS.

• The BACnet device object's Object_Name
property.

By default, the meter is named <meter type>-
<last six digits of MAC address>. For example,
a meter with a MAC address of 006078173393
appears on the network as <meter type>-
173393.

Domain name
Contact your local network
administrator for parameter
values.

The Ethernet domain name for the network
that the meter resides on.

DHCP settings available using ION Setup

Parameter Value Description

IP address
Contact your local network
administrator for parameter
values.

The IP address of your device.

Subnet Mask
Contact your local network
administrator for parameter
values.

The subnet IP address of your network.

Gateway
Contact your local network
administrator for parameter
values.

The gateway IP address of your network.

Stored IPv4 settings available using ION Setup

Parameter Value Description

Global Address
Contact your local network
administrator for parameter
values.

The Internet protocol address of your device.

Default Gateway
Contact your local network
administrator for parameter
values.

The address the meter uses to route
communications to a different network or
subnet.

If you do not set this or the address is
incorrect, you may see slow communications
or communications errors.

Stored IPv6 address settings available using ION Setup
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ION Setup reconnection

If you change the settings for the Ethernet connection method you are currently using to connect
to the meter, ION Setup tries to reconnect to the meter using the updated information. You can
view the process in the Device reconnection dialog box that appears.

• If ION Setup can successfully communicate using the new setting, this setting appears in the
IP Address drop-down list box and the check box is selected. ClickOK to copy this
information into the IP address field in Device Properties. ION Setup will now use this
address to communicate with the device.

• If ION Setup cannot successfully communicate using the new setting, the new address
appears in the IP Address but the check box is not selected. Either select the check box and
clickOK (for example, you may want to use the new setting if you are replacing a meter in
service) OR select another address option from the drop-down list box. Click Test to check
that ION Setup can communicate with the meter using the new address, select the check box,
then clickOK.

Configuring basic Ethernet settings using ION Setup

To configure your device’s basic Ethernet settings using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your device.

3. Click Communications > Basic Ethernet > TCP/IP.

4. Select a setting and then click Edit.



NOTE: Contact your network system administrator for the appropriate values.

Parameter Value Description

Ethernet device name configurable

The Ethernet device name is used by:

DPWS for self-discovery over Ethernet.

The hostname to uniquely identify your
meter for DHCP and DNS.

The BACnet device object's Object_
Name property.

By default, the meter is named <meter
type>-<last six digits of MAC address>. For
example, a meter with a MAC address of
006078173393 appears on the network as
<meter type>-173393.

Rx timeout configurable
Specifies the number of seconds the meter
waits for communication acknowledgments.

Modbus TCP Timeout configurable
Specify number of seconds the meter waits
before disconnecting an idle Modbus TCP
connection.

Modbus Gateway

Disabled

COM1 (CM1
Protocol)

COM4 (CM4
Protocol)

Specify the port on which Modbus Gateway
sends/receives Modbus TCP requests.

For Modbus Gateway to function properly,
the serial port protocol must be set to
Modbus Master. For example, change CM1
Protocol from factory to Modbus Master.

MAC address Read-only
The media access control (MAC) address is
factory set and is for reference only.

General Ethernet settings available using ION Setup

1Modbus Gateway is supported only on one serial port at any given time

Configuring basic Ethernet settings using the meter webpages

You can use the meter webpages to configure the IPv4, IPv6 and TCP/IP settings for the meter.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.
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NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

Contact your network system administrator for your IP addresses and other Ethernet network
configuration values.

To configure basic Ethernet setting using the meter webpages:

1. Connect to your meter’s webpages.

Until you configure other Ethernet connection settings, you can connect to the meter using
its default IPv4 address or its IPv6 link local address, or by using self-discovery over
Ethernet by double-clicking the meter’s network icon.

2. Navigate to Setup > Ethernet.

3. Enter the appropriate value for the settings.

4. Click Advanced Settings to configure additional Advanced Ethernet settings, such as
timeouts and enabling/disabling certain protocols over Ethernet, if needed.

5. Click Apply.

NOTE: If you are changing the address you used to access the webpages, you will need
to reconnect to the webpages after you click Apply.

Parameter Value Description

MAC address Read-only
The media access control (MAC) address is
factory set and is for reference only.

Ethernet device name configurable

The Ethernet device name is used by:

• DPWS for self-discovery over Ethernet.

• The hostname to uniquely identify your
meter for DHCP and DNS.

• The BACnet device object's Object_Name
property.

By default, the meter is named <meter type>-
<last six digits of MAC address>. For example,
a meter with a MAC address of 006078173393
appears on the network as <meter type>-
173393.

Ethernet settings available using the webpages



Parameter Value Description

Domain name

Contact your
local network
administrator for
parameter
values.

The Ethernet domain name for the network
that the meter resides on.

Primary DNS

Contact your
local network
administrator for
parameter
values.

The IP address of your network’s primary DNS
server, if your network uses DNS.

Secondary DNS

Contact your
local network
administrator for
parameter
values.

The IP address of your network’s secondary
DNS server, if your network uses DNS.

Parameter Value Description

IPv4 Assignment mode
Stored

DHCP

Stored: The meter uses the IP addresses that
you manually enter for IPv4 (address, subnet
mask and gateway).

DHCP: The meter acquires its IP addresses
from your network’s DHCP server.

Stored IPv4 address

Contact your
local network
administrator for
parameter
values.

The Internet protocol address of your device.

Stored IPv4 Subnet Mask

Contact your
local network
administrator for
parameter
values.

The Ethernet IP subnetwork address of your
network.

Stored IPv4 Gateway

Contact your
local network
administrator for
parameter
values.

The Ethernet IP gateway address of your
network.

IPv4 settings available using the webpages

The webpage also displays the acquired IPv4 settings if the Assignment mode is set to DHCP.
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NOTE: To disable communications using IPv4, set the Assignment mode to Stored and the
IPv4 Address to 0.0.0.0.

Parameter Value Description

IPv6 Assignment Mode
Stored

DHCPv6

Stored: The meter uses the IP addresses that
you manually enter for IPv6 (Global address,
gateway address).

DHCPv6: The meter acquires its IP addresses
from your network’s DHCP server.

IPv6 Link Local Address Read-only
TheIPv6 Link Local address is factory set and
is read-only.

Stored IPv6 Global
Address

Contact your
local network
administrator for
parameter
values.

The Internet protocol address of your device.

Stored IPv6 Gateway

Contact your
local network
administrator for
parameter
values.

The address the meter uses to route
communications to a different network or
subnet. If you do not set this parameter or the
address is incorrect, it may result in slow
communications or communications errors.

IPv6 settings available using the webpages

The webpage also displays the acquired IPv6 settings if the Assignment mode is set to DHCP.

NOTE: To disable communications over IPv6, set Enable IPv6 in Advanced Settings to No.

NOTE: You must enclose an IPv6 address in square brackets when typing it in a web browser,
for example: “http://[fe80::260:78ff:fe04:5943]”.

Configuring Ethernet communications settings using the display

You can configure basic Ethernet communications settings using the display.

You can use the display to select the IP address assignment mode for IPv4 and IPv6, configure
stored IPv4 addresses, and view other settings. To configure the Ethernet settings that are not
available on the display or are read-only, use the meter’s webpages or ION Setup.

Prerequisites:

• Obtain your meter’s IP address and other network information from your network
administrator or IT department.



To configure Ethernet communications settings using the display:

1. Press Setup Menu > Communications Setup.

2. Scroll through the screens until you reach the setting you want to configure then press the
Edit button.

3. Select the IPv4 or IPv6 Assignment Mode, if required.

Option Description

Stored
The meter uses the IP addresses that you manually enter for
IPv4 (address, subnet mask and gateway) and IPv6 (Global
address, gateway address).

DHCP/DHCPv6
The meter acquires its IP addresses from your network’s
DHCP server.

You can have different assignment modes for IPv4 and for IPv6.

If you set the IPv4 Assignment Mode to Stored, continue with the remaining steps to
configure stored IPv4 addresses. If you are using addresses acquired from a DHCP server,
press the down arrow to view the assigned addresses.

4. Go to the Stored IPv4 Address Setup screen and press Edit.

5. Configure your meter’s stored IPv4 Addresses, as required.

Parameter Values Description

IP Address
Contact your local
network administrator for
parameter values.

Sets the IP address for the meter

Your meter’s default IP address is
169.254.0.10

Subnet Mask
Contact your local
network administrator for
parameter values.

Used if subnetting applies to your network

Your meter’s default subnet address is
255.255.0.0

Gateway
Contact your local
network administrator for
parameter values.

Used in networks with multiple segments

Your meter’s default gateway address is
0.0.0.0

MAC Address Read-only
Your meter’s media access control (MAC)
address

Stored IPv4 address settings available using the display

DHCP
The meter can function as a DHCP (Dynamic Host Configuration Protocol) client, allowing a
DHCP server to assign IP addresses to the meter.
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The meter supports assignment of the following addresses by a DHCP server when the
Assignment Mode is set to DHCP:

• IPv4 IP Address

• IPv4 Subnet mask

• IPv4 Gateway

• IPv6 Global Address

• IPv6 Gateway

Considerations for using DHCP
• It is recommended that you also set up a DNS server and configure software and other
devices to use the meter’s name to communicate with it. Alternatively, you can configure the
DHCP server to always provide the same address to the meter.

• When you switch the assignment mode from DHCP to Stored, the meter reverts to using its
default IP addresses as the Stored addresses.

• When you switch the assignment mode from Stored to DHCP, the acquired addresses display
as None until the meter receives addresses from the DHCP server.

• When using IPv6, the meter’s fully-qualified domain name (FQDN) is not sent to the DHCP
server. It is important that you make sure what is configured on the meter matches what is
configured on your network.

• If the meter is not able to communicate to the DHCP server:

When using IPv4, the meter will try to connect to the DHCP server for approximately one
minute. If the meter cannot connect to the DHCP server, it will revert to the default IP
address, but the Assignment Mode will remain DHCP.

When using IPv6, the meter will continue to try to connect to the DHCP server, even if it
does not receive an address.

NOTE: If the DHCP server has not assigned an IP address and you need to reconnect
to the meter, use the meter's IPv6 link local address.

For IPv4, if the meter’s fully-qualified domain name (FQDN) is not found on the DHCP
server, an event is logged in the event log. For IPv6, if the meter’s fully-qualified domain
name (FQDN) is not found on the DHCP server, no event is logged; this is important to
keep in mind when troubleshooting communications issues in a system using DHCP.

Meter domain name
A DNS (domain name system) server maps domain names to IP addresses. If you configure the
meter to use a DNS server, the meter can communicate with other network resources using their
domain names, rather than their IP addresses, and vice versa. For example, if your network has
an SMTP server with the domain name of smtp.company.com, you can enter smtp.company.com
as the SMTP Server address in the meter’s communications settings.



The meter’s Fully-Qualified Domain Name (FQDN)

To allow other network resources to communicate to the meter using its domain name, you must
configure the meter’s Ethernet Device Name setting to match that used by the DNS server. The
meter’s fully-qualified domain name is its Ethernet name plus its Domain name. For example, if
the meter’s Ethernet name is ElectricityHQ and its Domain name is companyXYZ.com, the FQDN
will be ElectricityHQ.companyXYZ.com.

NOTE: This domain name is used for both IPv4 and IPv6 communications. It is used to identify
the meter in a system using DNS and to identify the meter when using DPWS for self-discovery
over Ethernet.

Network protocol control
The network protocol control feature allows you to enable, disable or change the port number of
the network protocols supported on your meter.

Disabling unused ports is considered a cybersecurity best practice to help minimize unauthorized
access to your meter.

NOTE: The protocol port number may not be configurable on all protocols.

Managing network protocol control using ION Setup

Use ION Setup to enable, disable or change the port number of the network protocols supported
on your meter.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.

NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To manage network protocol control using ION Setup:

1. Open the Setup Assistant for your meter.

2. Click Communications > Advanced Ethernet > Protocols.

3. Select a protocol from the list and click Edit.

4. Select the Enabled check box to enable the port. Clear the check box to disable the port.

NOTE: The IEC61850 port is enabled when a valid CID file is uploaded to the meter. The
port is disabled by removing the CID file.
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NOTE: For EtherGate functionality, the EtherGate protocol must be enabled and the
applicable serial port set to EtherGate. For Secure EtherGate functionality, select Secure
EtherGate instead of EtherGate.

5. Select a port number from the Port Number drop-down list box or by clicking in the Port
Number field and entering a port number.

6. ClickOK.

If multiple ports are set to the same number, ION Setup responds with a message indicating
that the port is already in use by another protocol.

Managing network protocol control using the meter webpages

Use the meter webpages to enable, disable or change the port number of the network protocols
supported on your meter.

The Setup tab contains configurable elements for enabling, disabling, and changing the port
numbers for your network protocols.

When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.

NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

To manage network protocol control using the meter webpages:

1. Open a web browser and enter your meter’s IP address in the address bar.

The webpage login is displayed.

2. Enter your login credentials.

3. Navigate to Setup > Ethernet.

4. Click Advanced Settings at the bottom of the screen.

5. Select YES or NO to enable or disable each configurable protocol.

6. Enter the port number for each configurable protocol.

7. Click Apply to send these settings to your meter.

Managing network protocols using the display

The Ethernet Port Enable Setup allows you to enable or disable your network protocols through
the display.



When configuring communications parameters, ensure you maintain at least one communication
path that allows full access to your device; otherwise, you may permanently lose the ability to
change your device’s configuration and access to additional data.

NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

NOTE: You cannot change the Ethernet port number assignments through the display.

To manage network protocol control using the display:

1. Press the Home button on the display.

2. Navigate to Setup Menu > Ethernet Port Enable Setup.

3. Press Edit. Enter your meter’s password, if prompted.

4. Press the up or down icons to navigate available Ethernet protocols. A gray bar appears
behind the active selection.

5. Press Enable/Disable.

6. Press Select to accept the change.

7. Press Select to confirm.

Serial communications
The meter supports serial communications through its onboard RS-485 ports. Your meter
supports the 4-wire RS-485 option module through use of the existing COM1 port.

RS-485
In an RS-485 network, there is one client device, typically an Ethernet to RS-485 gateway. It
provides the means for RS-485 communications with multiple server devices, such as meters. For
applications that require only one dedicated computer to communicate with the server devices, a
USB to RS-485 converter can be used to connect to the server device.

Up to 32 devices can be connected on a single RS-485 bus.

RS-485 wiring
Connect the devices on the RS-485 bus in a point-to-point configuration, with the (+) and (-)
terminals from one device connected to the corresponding (+) and (-) terminals on the next
device.
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NOTE: If using the 4-wire RS-485 option module follow the wiring instructions in your
installation guide. Your wiring may depend on serial or gateway configuration.

RS-485 cable

Use a shielded 2 twisted pair or 1.5 twisted pair RS-485 cable to wire the devices. Use one twisted
pair to connect the (+) and (-) terminals and use the other insulated wire to connect the C
terminals.

The total distance for devices connected on an RS-485 bus should not exceed 1200 m (4000 ft).

RS-485 terminals

C
Common. This provides the voltage reference (zero volts) for the data plus and data minus
signals

Shield. Connect the bare wire to this terminal to help suppress signal noise that may be
present. Ground the shield wiring at one end only (either at the client or the last server
device, but not both).

- Data minus. This transmits/receives the inverting data signals.

+ Data plus. This transmits/receives the non-inverting data signals.

NOTE: If some devices in your RS-485 network do not have the C terminal, use the bare wire in
the RS-485 cable to connect the C terminal from the meter to the shield terminal on the devices
that do not have the C terminal.

RS-485 configuration
Before connecting your device to the RS-485 bus, use ION Setup, meter webpages or the display
to configure your meter’s default RS-485 settings.

Your meter has two RS-485 connections.

Each RS-485 connection must have a unique unit identifier (Unit ID) and have the following
settings match the rest of the devices on the RS-485 bus:

• Protocol

• Baud rate

• Parity and stop bits

You can configure the following settings to help optimize communications performance:

• RTS delay

• RS-485 bias

You can use a communications converter (USB to RS-485 or RS-232 to RS-485) or an Ethernet
gateway device to connect to your meter.

RS-485 bias

You can use the RS-485 bias setting to fine-tune communications.



Set the RS-485 bias to ON when the meter is acting as a client over RS-485 communications and
set the RS-485 bias to OFF when the meter is acting as a server. You can configure RS-485
biasing through ION Setup, the meter webpages or the display.

Serial protocols and ports

Your meter supports serial communications protocols on the RS-485 ports.

• ION

• Modbus RTU

• Modbus Master

• DNP 3.0

• DLMS

• EtherGate 1

• Secure EtherGate 1

• GPS: Truetime/Datum 2

• GPS: Arbiter 2

• GPS: Arbiter-Vorne 2

• None 3

1 – These are serial port protocol settings that allow protocols to work with other connected RS-
485 devices.

2 – These protocol settings are used for connecting to a GPS receiver communicating in serial
ASCII format.

3 – This protocol setting stops communications using this port.

Configuring serial communications settings using ION Setup

Use ION Setup to configure the meter’s serial communications settings.

Prerequisites:

Make sure you have a unique unit ID for your meter and know the serial network settings
(protocol, baud rate, parity and stop bits).

To configure the meter’s serial communications settings using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your device.

3. Click Communications > Serial Settings.

4. Select COM1 or COM4 tab, depending on which hardware serial port you are configuring.

5. Select a setting, and then click Edit to configure the setting to match your communications
system.
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Parameter Values Description

Protocol

ION, Modbus RTU, Modbus
Master, DNP v3.00, DLMS,
EtherGate, GPS:
Truetime/Datum, GPS:
Arbiter, GPS: Arbiter-Vorne,
Factory, None

Sets the communications protocol for your
meter’s RS-485 port

The NONE setting stops communications
using this port.

Baud Rate
2400, 4800, 9600, 19200,
38400, 57600, 115200

Sets the data rate, in bits per second

Rx Timeout1 0.1–15
Sets the transmit delay (timeout for receiving
an entire message from a device) in seconds.

Unit ID 1–9999

Sets the meter’s unique ID on the RS-485
network

Note: Modbus serial device range 1 to 247

Serial Port
8N1, 8N2, 8E1, 8E2, 8O1,
8O2

Sets the parity and stop bits for the port

RS485 Bias OFF, ON
Turns on biasing on the client device over the
RS-485 port

Serial communications settings available using ION Setup

1Only applies to a subset of protocols.

Configuring serial communications settings using the webpages

You can use the meter’s webpages to configure your serial communications settings.

Before configuring serial parameters, make sure you have a unique unit ID for your meter and
know the serial network settings (protocol, baud rate, parity, and stop bits).

To configure the meter’s serial communications settings using the meter webpages:

1. Connect to your meter’s webpages using the meter’s IPv4 address or its IPv6 link local
address, or use self-discovery then double-clicking the meter’s network icon.

2. Navigate to Setup > Serial Port.

3. Enter the appropriate value for the settings.

4. Click Advanced Settings to configure additional settings, if needed (for example, RS485
biasing or Rx Timeout).



Parameter Values Description

Protocol

ION, Modbus RTU,
Modbus Master, DNP
v3.00, DLMS, EtherGate,
GPS: Truetime/Datum,
GPS: Arbiter, GPS:
Arbiter-Vorne, Factory,
None

Sets the communications protocol for your
meter’s RS-485 port

NONEstops communications using this
port.

Baud Rate
2400, 4800, 9600, 19200,
38400, 57600, 115200

Sets the data rate, in bits per second

Unit ID 1–9999

Sets the meter’s unique ID on the RS-485
network

NOTE:Modbus serial device range 1 to
247

Basic serial communications settings available using the webpages

Parameter Values Description

RTS Delay 0–1
The delay in seconds before the
transmission of the packet.

Rx Timeout1 0.1–15
Sets the transmit delay (timeout for
receiving an entire message from a device)
in seconds.

Serial Port
8N1, 8N2, 8E1, 8E2,
8O1, 8O2

Sets the parity and stop bits for the port

RS485 Bias OFF, ON
Turns on biasing on the client device over
the RS-485 port

Advanced serial communications settings available using the webpages

1Only applies to a subset of protocols.

Configuring serial communications using the display

You can configure your meter’s basic serial communications settings using the display.

Before configuring serial parameters, make sure you have a unique unit ID for your meter and
know the serial network settings (protocol, baud rate, parity and stop bits).

To configure the meter’s serial communications settings using the display:

1. Press the Home button.

2. Press Setup Menu > Communications Setup.
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3. Press the up and down icons to scroll and select COM1 Setup or COM4 Setup.

4. Configure your meter’s serial settings as required.

Parameter Values Description

Protocol

ION, Modbus RTU,
Modbus Master, DNP
v3.00, DLMS, EtherGate,
GPS: Truetime/Datum,
GPS: Arbiter, GPS:
Arbiter-Vorne, Factory,
None

Sets the communications protocol for your
meter’s RS-485 port

The None setting stops communications
using this port.

Baud Rate
2400, 4800, 9600, 19200,
38400, 57600, 115200

Sets the data rate, in bits per second

Rx Timeout 0.1–15 Sets the transmit delay in seconds

Unit ID 1–9999

Sets the meter’s unique ID on the RS-485
network

NOTE:Modbus serial device range 1 to
247

Serial Port
8N1, 8N2, 8E1, 8E2,
8O1, 8O2

Sets the parity and stop bits for the port

RS485 Bias OFF, ON
Turns on biasing on the client device over
the RS-485 port

Serial communications settings

Disabling serial communications ports
You can disable serial communications ports using ION Setup, meter webpages, or the display.

Disabling serial communications using ION Setup

NOTE: Disabling unused ports is considered a cybersecurity best practice to help minimize
unauthorized access to your meter.

To disable serial communications using ION Setup:

1. Open the Setup Assistant for your meter.

2. Click Communications > Serial Settings.

3. Click the COM1 or COM4 tab.

4. Select Protocol and click Edit.

5. Select None from the drop-down list box and clickOK.



Disabling serial communications using the webpages

NOTE: Disabling unused ports is considered a cybersecurity best practice to help minimize
unauthorized access to your meter.

To disable serial communications using ION Setup:

1. Open a web browser and enter your meter’s IP address in the address bar. The webpage
login prompt is displayed.

2. Enter your login credentials.

3. Navigate to Setup > Serial Port and expand the Basic Settings section.

4. Choose COM1/ RS485#1 - Protocol or COM4/ RS485#2 - Protocol from the drop-down
list box and select None to disable the port.

5. Click Apply. When prompted, click Yes to save the changes.

Disabling serial communications using the display

NOTE: Disabling unused ports is considered a cybersecurity best practice to help minimize
unauthorized access to your meter.

To disable serial communications using ION Setup:

1. Press the Home button.

2. Press Setup Menu > Communications Setup.

3. Press Select.

4. Scroll then select COM1 Setup or COM4.

5. Press the navigation icon to scroll and select Protocol.

6. Press the Edit button. Enter user credentials if prompted.

7. Press the down icon and then select None to disable the port.

8. Press the Select button when you are finished. If prompted, press Select button again to
accept the changes.

ION
ION is the architecture of your meter.

The basic building blocks of ION architecture are the ION modules, each of which is specialized to
perform a specific task and contains data and instructions on how to manage that data. ION
modules are linked together to create the meter’s functions and features. ION modules that are
linked together to perform a specialized task are called a framework, such as the Power Quality
framework. These different functional frameworks are then grouped together to define the entire
meter and are collectively referred to as the device template.

Your meter ships with a default device template which provides extensive capabilities. You can
also configure the meter’s template to modify existing meter functions or to create new functions.
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Related resources:

For more information on ION architecture and a detailed description of the different ION modules,
see ION Reference, available from www.se.com.

Secure ION
Secure ION, or ION over TLS, enhances the security of the ION protocol by using a Transport
Layer Security (TLS) encrypted tunnel between the device and the software client.

NOTE: The additional TLS layer applies to a TCP/IP based connection (Ethernet) only. It does
not apply to serial communications.

To use Secure ION your IT infrastructure must be configured to allow the traffic on the Secure ION
port to pass. The default port for Secure ION is 7443.

Connecting to a device using Secure ION

Use ION software to connect to a device using Secure ION.

If you are using ION Setup in Network mode or Power Monitoring Expert, configure the device to
use the Secure ION programmed IP port.

Prerequisites:

Your IT infrastructure must be configured to allow the traffic on the Secure ION port to pass.

To connect to a device using Secure ION:

1. In Device Properties, set the IP Port to the Secure ION port:

2. ClickOK.

NOTE: If you connect to a device in ION Setup using Single ION Device mode, ION Setup will
try to connect to the Secure ION port automatically. If the defined port isn’t available on your
network, the device will connect using ION over TCP. You can use ION software to configure
devices to override the default connection process, see Setting the ION protocol connection
and port number for details.



Secure ION security certificates

Devices that support Secure ION include a self-signed SSL certificate. When you connect to a
device using Secure ION, a certificate must be associated with the TLS connection.

You can upload a Certificate Authority (CA) signed certificate. For details, see Uploading a
custom SSL certificate.

NOTE: To reduce cybersecurity risk, use a Certificate Authority (CA) signed SSL certificate and
external network controls. To learn more about this risk, see Security risks and mitigation
strategies.

In ION Setup, you can view the certificate information—including its SHA1 thumbprint—by
clicking View Certificate Info.

For example:
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ION Setup stores the certificate when using Network mode. In Single Device mode, you must
accept the certificate every time you connect to a device using Secure ION.

Setting the ION protocol connection and port number

When connecting to a device in ION Setup using Single ION Device mode, ION Setup will try to
connect to the Secure ION port automatically. If your IT infrastructure isn't configured to allow
traffic on the Secure ION port to pass, the device will connect using ION over TCP.

You can override the default ION connection on a device that supports Secure ION by manually
appending the IP address connection options to the IPv4 address. Doing so explicitly defines the
connection process.

The following table describes the override values you can use and the resulting connection
process:

Example override value Connection process

10.168.68.245/7443
Explicitly connects to port 7443. If the registry dictates that ION
over TLS = 7443, this will be a TLS connection.

10.168.68.245/TLS
Explicitly uses the registry to connect to what is specified as the
ION over TLS port. By default: 7443.

10.168.68.245/TLS:7443
Explicitly uses a TLS connection to the specified port. In this
example, 7443.

For example:

ION sessions
An ION session uses a session token ID to authenticate ION requests to a device. The first
ION request sends the user credentials to the device. Upon successful validation, the device
creates a unique, non-transferable ION session token ID. Subsequent ION requests are validated
using the ION session token ID, not the user credentials.



An ION session token ID has a fixed inactivity session timeout of 5 minutes.

There is no configuration required to enable ION sessions.

NOTE: Both the ION over TCP and ION over TLS (Secure ION) include ION session
authentication.

Modbus
Modbus is a client-server communications protocol where the client initiates transactions and the
server or servers respond with the requested information or action.

Your device can function as a Modbus client or Modbus server, depending on how it is configured.
Your device comes with Modbus server functionality configured and ready to use. You can add
customModbus information to the default Modbus server data provided by your device.

Key terms

Term Definition

Modbus gateway
A communications method that lets you communicate through an
Ethernet gateway device to a Modbus serial network connected to
that device.

Modbus client (historically
known as Modbus master)

A device that issues commands and receives responses from
Modbus server devices. Serial Modbus networks can only have
one Modbus client per network.

Modbus RTU
Serial Modbus protocol format; Modbus RTU transmits data using
binary. Server and client devices must use the same format.

Modbus register/address

Identifies the data to read/write. Modbus register maps are
available for Modbus client devices and detail the information
available from the client device. More than one register may be
used to store a single value.

Modbus server (historically
known as Modbus slave)

A device that responds to Modbus commands and performs
actions or provides information back to the Modbus client. Most
Modbus networks contain multiple server devices.

Modbus TCP The Ethernet Modbus protocol format.

Modbus unit ID The identifier for a client Modbus device.

You can download your device’s Modbus map from www.se.com and get additional information
about the Modbus protocol from www.modbus.org.

Ethernet Modbus device prerequisites
For your meter to operate as an Ethernet Modbus device, you must complete some prerequisite
configuration.
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NOTE: You do not need to perform any Modbus-specific configuration for your meter to function
as a Modbus client device over Ethernet.

Prerequisite Description

Ethernet All devices must have a working Ethernet connection.

IP address All devices must have a unique IP address.

Port
All devices must be communicating over Ethernet port 502 for
Modbus TCP.

NOTE: Devices supporting multiple simultaneous Modbus TCP connections can have
communications delays. Adjust your network timeout settings to accommodate this.

Serial Modbus device prerequisites
For your meter to operate as a serial Modbus device, you must complete some prerequisite
configuration.

Prerequisite Description

Wiring

The device’s serial connection must be wired correctly.

The Modbus server devices must have communications wiring to
the Modbus client.

Protocol

Servers – For your meter to be a serial Modbus server, the meter’s
protocol must be set to Modbus RTU. Client and server devices
must use the same format.

Client – For your meter to be a serial Modbus client, the meter’s
protocol must be set to Modbus Master.

Baud rate
The baud rate must be the same for all devices on the serial
Modbus network.

Stop bits and parity
The communication stop bits and parity (for example, 8N1) must
be the same for all devices on the serial Modbus network.

Unit ID
Each device on the serial Modbus network must have a unique
unit ID (also called the device address).
Note:Modbus serial device range 1 to 247

Your meter as a Modbus client

Your meter as a Modbus client with Ethernet Modbus server devices

Your meter can function as a Modbus client with Ethernet Modbus server devices.



A Ethernet

B Your meter

C Modbus servers

To use the Modbus client-server architecture, add the Modbus server devices using ION Setup.

Your meter as a Modbus client with serial Modbus server devices

Your meter can function as a Modbus client with serial Modbus server devices.

A Ethernet

B Your meter

C RS-485 Modbus RTU

D Modbus servers

To use the Modbus client-server architecture, add the Modbus server devices using ION Setup.
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Modbus client best practices

For your meter to operate as a Modbus client, you must complete some prerequisite
configuration.

NOTE: These settings are required in addition to the serial or Ethernet Modbus prerequisites.

Prerequisite Description

Modbus client devices
All Modbus client devices must be communicating and
appropriately configured.

Protocol

• Modbus client-server serial devices – The client’s serial port
protocol must be set toModbus Master.

• Modbus client-server Ethernet devices – The client must be
communicating to the server devices over Ethernet port 502.

NOTE: Having more than one Modbus client on a serial Modbus
network may cause communication conflicts.

Modbus server devices
The Modbus client device must have the server device information
entered.

Configuring your meter as a Modbus client using ION Setup

You can configure your meter to Modbus client-server devices over serial or Ethernet.

Make sure your client and server devices have the prerequisite communications wiring and
configuration before configuring your meter as a Modbus client.

If the meter is a Modbus client over TCP/IP, the Modbus TCP/IP and Modbus RTU protocols must
be enabled.

NOTE: Devices supporting multiple simultaneous Modbus TCP connections can have
communications delays. Adjust your network timeout settings to accommodate this.

The meter as a Modbus client over TCP/IP attempts to communicate with a server device for up to
100 seconds (as per the RFC 1122 standard) before moving on to the next server device.

To configure your meter as a Modbus client over serial or Ethernet:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Communications > 3rd Party Protocols >Modbus Master.

4. Click Add to add a Modbus server device.

The Modbus Device dialog appears.

5. Enter the Modbus server information:

Enter the Modbus server device’s name and a label suffix (if applicable).

Select the device type of the server device from the Device Type drop-down list box.



Enter the unit ID of the Modbus server device into the Slave ID text box.

Select the serial or TCP connection from the Connected via drop-down list box. This is
the connection from the Modbus client to the server device.

6. Click Connections. The Modbus Master Connections dialog appears.

7. Select the tab that corresponds to the connection you are configuring.

For example, if you selected TCP Connection 1 from the Connected via drop-down list box,
select the TCP 1 tab.

8. Configure the connection type:

Connection type Configuration

Serial connection
Select the serial communications port that is connected to the
Modbus server devices from the Assigned Port list.

TCP connection

Enter the IP address of the Modbus server device, making
sure that the IP port is set to 502.

Make sure that the Modbus RTU and Modbus TCP/IP
protocols are enabled.

9. ClickOK to return to the Modbus Device dialog.

10. ClickOK to add the server device. The device now appears on the list.

11. Repeat steps 4 through 10 to add all your Modbus server devices.

Your meter as a Modbus server

Your meter as a Modbus server over Ethernet

Your meter can function as a Modbus server over Ethernet.

A Modbus client

B Ethernet Modbus TCP

C Your meter

Your meter does not require any Modbus-specific configuration to act as a Modbus server device
over Ethernet.
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Your meter as a Modbus server on a serial network

Your meter can function as a Modbus server on a serial network.

A Modbus client

B RS-485 Modbus RTU

C Your meter

D Modbus servers

Your meter’s serial connection must be wired and configured correctly. The same mode of serial
communication must be used for all devices on the network.

Configuring your meter as a Modbus server using ION Setup

To configure your meter as a Modbus server using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Communications > Serial settings. Select the tab for the serial port you want to
configure.

4. Highlight the parameter, and then click Edit to configure the serial port’s Modbus
parameters as required:

Parameter Setting

Protocol Modbus RTU or Modbus Master

RS485 Bias
OFF if the meter is a Modbus server

ON if the meter is a Modbus client

5. Configure the meter’s other serial port parameters as required.

Next, add the Modbus server devices using ION Setup.

See your device’s Modbus map, available from www.se.com for Modbus register information.

Configuring your meter as a Modbus server using the webpages

To configure your meter as a Modbus server using the meter webpages:



1. Connect to your meter’s webpages.

2. Navigate to Setup > Serial Port.

3. Expand Basic Settings or Advanced Settings, and then configure the serial port’s Modbus
parameters as required:

Parameter Setting

Protocol Modbus RTU or Modbus Master

RS485 Bias
OFF if the meter is a Modbus server

ON if the meter is a Modbus client

4. Configure the meter’s other serial port parameters as required.

Next, add the Modbus server devices using ION Setup.

See your device’s Modbus map, available from www.se.com for Modbus register information.

Configuring your meter as a Modbus server using the display

To configure your meter as a Modbus server using the meter display:

1. Press the Home button.

2. Navigate to Setup Menu > Communications Setup, scroll and select COM1 or COM4
Setup.

3. Configure the Modbus parameters as required:

Parameter Setting

Protocol Modbus RTU or Modbus Master

RS485 Bias OFF if the meter is a Modbus server

4. Configure the meter’s other serial port parameters as required.

Next, add the Modbus server devices using ION Setup.

See your device’s Modbus map, available from www.se.com for Modbus register information.

Supported Modbus features
Your meter supports specific Modbus data classes, data formats, function codes, and commands.

Modbus data classes

Class Description

Coils Digital bits that can be read and written to

Input status Digital bits that can be read

Input registers 16-bit integers that can be read

Holding registers 16-bit integers that can be read and written to
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Modbus data formats

Format Type # of Modbus registers used

Unsigned 16-bit Integer 1

Signed 16-bit Integer 1

Unsigned 32-bit Integer 2

Signed 32-bit Integer 2

Unsigned 32B-M10K Integer 2

Signed 32B-M10K Integer 2

IEEE float1 Floating point 2

Packed Boolean for inputs Integer 1

Packed Boolean for coils Integer 1

Unsigned 16-bit read/write Integer 1

Signed 64 bit Integer 4

1 A device acting as a Modbus client supports two versions of IEEE float with different word
orders: high/low = Big Endian, low/high = Little Endian.

16-bit data (one word) is transmitted with most-significant byte first and least-significant byte
second.

32-bit data (two words) is transmitted with the most-significant word first and the least-significant
word second.

Modbus function codes

Function Description Client / Server

1 Read coil status Client and server

2 Read input status Client and server

3 Read holding registers Client and server

4 Read input registers Client

5 Write to a coil Client

6 Write to a holding register Client and server

15 Write to multiple coils Client

16 Write to multiple holding registers Client and server

17 Report slave ID (serial only) Client and server

43 (sub code 14) Read device identification Client and server

100 Read scattered holding registers Client and server



Modbus commands

AModbus client command to unit ID 0 is broadcast (sent to) all Modbus server devices. The only
supported broadcast command is preset multiple registers.

For serial Modbus networks with only one server device, the client can send commands using the
single connection, one-to-one address of unit ID 248, regardless of the server device’s actual unit
ID.

Modbus implementation
Your meter's Modbus implementation includes exception codes, invalid register responses, fixed
and configurable register maps, and security.

Modbus exception codes

Code Name Description

01 Illegal function The requested command is invalid.

02 Illegal address

This code indicates one of the following:

• The requested address is invalid for that
function.

• The requested address is not within the
valid register range for this device.

• The requested address is protected by
device security.

03 Illegal value

This code indicates one of the following:

• The requested value is not allowed for that
register in the device.

• The requested register is part of a multi-
word value.

Modbus invalid read registers responses

Invalid type Read response

Unmapped (unused)* register 0x8000

Reserved* register responses by type

Signed integer 16-bit 0x8000

Unsigned integer 16-bit 0xFFFF

Signed integer 32-bits 0x80000000

Unsigned integer 32-bits 0xFFFFFFFF

Signed integer 64-bits 0x8000000000000000

Float32
0xFFC00000

(NaN = Not a number)
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* IRIG-B can only be connected to one of the digital inputs located on the meter base, not an
option module. Unmapped (unused) registers are registers that will never be used by the meter,
and therefore have no defined format. Reserved registers have a defined format and are intended
for use by the meter, its options, or its variants.

Modbus invalid write registers response

If the meter receives a write command to a Modbus register address that does not have a register
mapped, the meter will not respond. No data is written or stored, and the meter will not send back
a rejection to the request.

If the meter receives a write command to a read-only Modbus register address, exception code 03
(illegal value) is returned.

Fixed and configurable Modbus map

Your meter has a fixed (static) register map for meter data and a flexible, user-configured register
map.

Modbus security

Your meter’s onboard security options include Modbus-specific settings. These security settings
may need to be configured to write Modbus data to the meter.

Modbus map
Your meter’s default Modbus register information (map) is available on www.se.com.

The Modbus register information includes:

• Registers and mapped values

• Formats and scaling

• Additional details where applicable

NOTE: Your meter’s Modbus registers are specified differently than previous devices using ION
architecture. If you are configuring Modbus client information on your meter, confirm you are
using the appropriate Modbus register addressing. For more information, refer to your meter’s
Modbus map.

Your meter has a fixed (static) register map which contains the most common metering values.
This map is defined by a series of Data Mapping modules, which also determine the values shown
on the meter webpages or the display. The Data Mapping modules are named based on the type
of information they map to Modbus:

Data Mapping module Description

Data Mapping Dmd

Maps kW, kVA and kVAR demand data such as kW sd
del (sliding demand kilowatts delivered), as well as
current demand such as I a sd (sliding demand phase A
current).



Data Mapping module Description

Data Mapping Egy
Maps kWh, kVAh, and kVARh delivered, and received
data, including conditional, quadrant, and incremental
energies.

Data Mapping EN
Maps present interval EN 50160 power quality
compliance data.

Data Mapping EN Prev
Maps previous interval EN 50160 power quality
compliance data.

Data Mapping IEEE519 Maps IEEE 519 harmonics compliance data.

Data Mapping I/O
Maps input metering data, alarms, resets, and reset
counts.

Data Mapping Meas

Maps voltage, current, power, power factor, and
frequency data for one second and half-cycle
measurements.

The Cfg Modbus Map Enable setup register may exist in
this module.

Data Mapping PQ
Maps power quality data such as Crest Factor, K Factor,
and total harmonic distortion, including IEC 61000-4-30
power quality compliance data.

Data Mapping Stats
Maps statistical low, mean, and high data values, such
as I a mean (phase A current average value).

Data Mapping TOU
Maps time-of-use (TOU) data, such as seasons, rates,
and per-season demand, such as kW sd rec A (sliding
demand kilowatts received in season A).

You can add extra Modbus information or duplicate information that is already in the fixed map to
different Modbus registers using Modbus Slave modules.

For more information on Data Mapping modules and Modbus Slave modules, see ION Reference,
available on www.se.com.

Configuring custom Modbus data using ION Setup
You can add custom data to your meter's default Modbus map, completely customize your
meter's Modbus map, or revert your meter's Modbus map back to its default configuration using
ION Setup.

Download your meter’s Modbus map information from www.se.com.

To configure custom data using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Click Communications > 3rd party protocols >Modbus Slave.

The name of the meter’s current Modbus map is displayed, along with the quantity of custom
registers and their start and end addresses.

4. Select the map name and click Edit.

TheModbus Slave Mode Setup screen is displayed.

5. Select your meter’s method of Modbus client mapping. If you select Default or Disabled,
click Finish to configure your meter and return to the Setup Assistant, otherwise select
Next to access theModbus Slave Map Setup screen.

Option Description

Default

Sets your meter to use the default Modbus map. Any custom
Modbus client data is removed.

NOTE: You can download your meter’s Modbus map
information from www.se.com.

Modified
Add Modbus information in addition to the meter’s default
Modbus map.

Custom

Removes the meter’s default Modbus map so that all registers
are available, and you can create a completely custom
Modbus map.

NOTE: Use this option if you want to make your meter’s
Modbus map identical to a device that it is replacing, for
example in a retrofit application.

Disabled
Removes your meter’s Modbus data map. Modbus functions
are unaffected, but no meter Modbus data is available.

6. In theModbus Slave Map Setup screen, you can modify parameters by clicking Edit, or
add parameters by clicking Add.

TheModbus Register screen is displayed.

7. Configure the Modbus register information and clickOK to return to theModbus Slave Map
Setup screen.

a. Source: Click Select and chose a source from the Parameter Selection screen. Select
Show all available registers to see a complete list of the parameters available on your
meter. ClickOK.

b. Address: Enter the Modbus address that will hold the Source data.

NOTE: If you hover your mouse over the Address field, a tooltip indicates the Modbus
function code and start address to send for retrieving the data.

c. Format: Select the Modbus data format from the list.

d. Scaling: Select the scaling value from the list or select Custom and click Scales to
configure custom scaling.



8. In theModbus Slave Map Setup screen you can click Delete to remove a Modbus register,
Set Name to create a new name for the set of additional data mapped to Modbus, or Save
As to save the additional data you have mapped to Modbus as a separate file.

9. Click Finish to complete your meter’s Modbus client configuration and return to the Setup
Assistant.

BACnet/IP
BACnet (Building Automation and Control Network) is an open communication protocol used to
automate and control building systems. The American Society of Heating, Refrigerating and Air-
Conditioning Engineers (ASHRAE) maintains the BACnet standard. Your device can act as a
BACnet/IP server, making specific values available to your building automation system.
BACnet/IP is an Ethernet-based BACnet network type that uses UDP/IP packets.

Supported device modes
Your device can act as a normal or foreign BACnet device.

Device mode Description Purpose

Normal

Devices that communicate
using the BACnet protocol
within the same
BACnet/IP network.

Device interoperability
according to the BACnet
standard.

Foreign

Devices that are on a different
IP subnet than the BACnet/IP
network that they seek to join.
Foreign devices must register
with a BBMD on the
BACnet/IP network.

Useful in scenarios where:

1. The device must receive
broadcast messages
from other subnets.

AND

2. Installing a BBMD on the
device subnet is not
feasible or economical.

For more information, see the BACnet and ION technology technical note, available on
www.se.com.

Other device types in a BACnet/IP network
The following table summarizes other common devices found in a BACnet/IP network:

Device type Description Purpose

BACnet Broadcast
Management Device (BBMD)

Devices that facilitate
broadcast distribution
between BACnet/IP devices
on different subnets.

Used to forward broadcast
messages from one subnet to
another, allowing broadcast
messages to traverse IP
routers.
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Device type Description Purpose

BACnet router
Devices that interconnect two
or more BACnet networks.

Used to bridge networks,
route messages, and, if
necessary, translate BACnet
protocols between networks.

Configuring BACnet/IP using ION Setup
Use ION Setup to configure BACnet/IP.

Prerequisites:

• Firmware version 4.6.0 or later.

• Communication configuration security access.

• The BBMD address when using foreign device mode. If you do not know the BBMD address,
contact your local network administrator.

• Read, understand, and implement relevant cybersecurity mitigation strategies outlined in
Security risks and mitigation strategies and System defense-in-depth assumptions.

If your BACnet network uses BBMDs, ensure that you understand how to help mitigate risk in
your network. BBMDs allow broadcast messages to traverse IP routers.

NOTICE
UNAUTHORIZED ACCESS OR NETWORK DISRUPTION
• Encrypt data over all external connections.
• Physically segment control system networks from non-control system networks.
• Monitor and manage communication loads.

Failure to follow these instructions can result in unauthorized or unintended
access to data or cause network disruption.

There are two steps to configure BACnet/IP:

1. Turn on BACnet/IP.

2. Enter your BACnet/IP settings.

To turn on BACnet/IP:

1. Open ION Setup.

2. Open the Setup Assistant for your meter.

3. Select Communications > Advanced Ethernet > Protocols.

4. Select BACnet/IP, and then select Edit.

If prompted, enter the device credentials.

The BACnet/IP Protocol Settings screen appears.



5. Select Enabled.

6. SelectOK to turn on BACnet/IP.

To enter your BACnet/IP settings:

1. Open the Setup Assistant for your meter.

2. Select Communications > 3rd Party Protocols > BACnet.

3. Enter your BACnet/IP settings.

BACnet/IP settings

Parameter Values Description

Device ID
settings

Device ID

0–4194302

NOTE: The Device ID can be set
to 4194303, but this value should
only be used to indicate that the
BACnet device is uninitialized,
disabled, or unused.

Specifies the BACnet device object's
instance number (used for the
Object_Identifier property). The
default Device ID is the last five digits
of the MAC address (hexadecimal)
converted to decimal.

We recommend changing the default
Device ID to reduce the risk of an
attacker gaining device information.

TIP: The Device IDmust be
unique on the BACnet/IP network.

Device mode
settings

Device Mode Normal, Foreign

Defines the device behavior as a
BACnet device:

• Normal: Your device will
communicate over the BACnet
network without requiring
registration to a BACnet
Broadcast Management Device
(BBMD).

• Foreign: Your device will register
as a foreign device on the
BACnet network. Registration
requests are sent to the BBMD,
defined by BBMD Address.
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Parameter Values Description

BBMD Address IPv4 address

Specifies the IPv4 address of the
BBMD with which your device
registers as a foreign device.

If you do not know the BBMD
Address, contact your local network
administrator.

Port 1–65535

Specifies the UDP port of the BBMD
where registration requests are sent.
If this field is left empty, the default
port number is used (47808).

Object_Name
settings

Ethernet Device
Name

Up to 49 characters

Specifies the BACnet device object's
Object_Name property.

TIP: The Object_Name property
must be unique on the BACnet/IP
network.

By default, the meter is named
<meter type>-<last six digits of MAC
address>. For example, a meter with
a MAC address of 006078173393
appears on the network as <meter
type>-173393.

NOTE: Ethernet Device Name is
also used for DHCP with DNS and
DPWS. Changing Ethernet Device
Name will affect how you access or
find your device using DHCP and
DPWS.

For more information about the BACnet Options Module, see ION Reference, available on
www.se.com.

Ethernet gateway
Ethernet gateway is a communications method that allows you to communicate through a
gateway device to a serial network.

When a meter with gateway capabilities is installed on an Ethernet network, a client device (such
as an energy management system) can communicate through the gateway meter to a serial
network of devices connected to the gateway meter’s serial port(s). The maximum number of
devices on the serial network is determined by the limitations of the gateway meter’s serial port.



A LAN/WAN

B Ethernet gateway meter

C Serial RS-485 network of devices

D Terminating resistor

There are two types of Ethernet gateways that you can configure on your meter:

• EtherGate – A single TCP connection communicates through the gateway meter to a serial
network of devices.

• Modbus gateway – Up to a maximum of 32 Modbus client TCP connections communicate
through the gateway meter to a serial network of Modbus devices.

EtherGate configuration
The meter can function as an Ethernet gateway (EtherGate).

When a meter with gateway capabilities in installed on the Ethernet network, a client device can
communicate through the gateway meter to a serial network of devices wired to the gateway
meter’s COM port. You must create an additional communications connection to the gateway
meter to read its information.

NOTE: EtherGate supports only one client device.

Before configuring EtherGate, confirm the following:

• The serial network of devices are wired to the gateway meter’s serial communication port.

• All serial devices are configured to have the same baud rate, serial port settings (for example:
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8N1), and protocol (ION).

• Each serial device has a unique unit identifier (unit ID/address).

• Your gateway meter is communicating over Ethernet.

You can then configure the gateway meter’s serial port to use the EtherGate protocol, create the
EtherGate site in ION Setup or an energy management system, and add the serial devices to the
EtherGate site.

Secure EtherGate

Secure EtherGate enhances the security of the EtherGate protocol by using a TLS encrypted
tunnel between the device and the software client.

Secure EtherGate is an option available in the Protocol setup register of the serial communication
modules on the device.

The Secure EtherGate is available at port 7801/7802. If Secure ION is disabled, Secure
EtherGate will continue to accept and parse incoming data to the serial port.

NOTE: The additional TLS layer applies to the TCP/IP based connection (Ethernet side) only. It
does not apply to the serial side of the EtherGate connection.

Configuring EtherGate or Secure EtherGate using ION Setup

To configure EtherGate or Secure EtherGate communications using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Communications > Serial settings.

4. Select the tab (COM1 or COM4) for the serial port you want to configure.

5. Highlight the parameter, and then click Edit. Enter the meter password if prompted

6. Change the settings, and then clickOK to save the changes.

Parameter Setting

Protocol EtherGate or Secure EtherGate

Baud Rate

Serial Port

Serial port settings must match the settings for all connected
serial devices.

7. Create an Ethernet gateway site to access the serial network of devices through your
gateway meter.

Configuring EtherGate or Secure EtherGate using the webpages

To configure EtherGate or Secure EtherGate communications using the meter webpages:

1. Connect to your meter’s webpages.

2. Navigate to Setup > Serial Port.



3. Expand Basic Settings or Advanced Settings and modify the settings for the serial port you
are configuring for EtherGate communications (COM1 or COM4).

4. Change the settings, then click Apply. Click Yes to save the changes.

Parameter Setting

Protocol EtherGate or Secure EtherGate

Baud Rate

Serial Port

Serial port settings must match the settings for all connected
serial devices

You can use ION Setup to create an Ethernet gateway site and access the serial network of
devices connected through the EtherGate meter.

Configuring EtherGate or Secure EtherGate using the display

To configure EtherGate or Secure EtherGate communications using the meter display:

1. Press the Home button.

2. Navigate to Setup Menu > Communications Setup.

3. Press the Select button.

4. Scroll then select COM1 Setup or COM4 Setup.

5. Highlight the parameter and press Edit. Enter the meter password if prompted, change the
setting, then press Select to save the changes.

Parameter Setting

Protocol EtherGate or Secure EtherGate

Baud Rate

Serial Port

Serial port settings must match the settings for all connected
serial devices

You can use ION Setup to create an Ethernet gateway site and access the serial network of
devices connected through the EtherGate meter.

Modbus Ethernet gateway
AModbus Ethernet gateway allows multiple Modbus client devices on the LAN/WAN to connect
to downstream serial Modbus server devices.

A Modbus client device, such as an energy management system, can communicate through the
gateway meter to a serial network of devices connected to the gateway meter’s serial port(s). The
meter receives Modbus TCP/IP data on TCP port 502, translates it to Modbus RTU then forwards
it to the addressed server device.

This functionality allows the use of monitoring software to access information from server devices
for data collection, trending, alarm/event management, analysis, and other functions.
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Modbus Ethernet gateway implementation

There are some specific aspects to your meter’s Modbus Ethernet gateway implementation.

A Modbus request is sent through Ethernet using Modbus/TCP to the gateway meter. If this
request is addressed with the slave ID of one of the downstream serial devices, the meter
forwards the message to that device using Modbus RTU. When the downstream device
responds, the gateway meter forwards the response back to the Modbus client. In addition to
Modbus server addresses 1 to 247, the Modbus gateway supports server address 255, which
sends a Modbus request to the gateway meter only.

For Modbus gateway, you must install the serial Modbus server devices, configure them and
connect them to your Ethernet-connected Modbus gateway meter. Ensure that each serial device
is configured to communicate over Modbus with the same baud rate and has a unique unit ID.
Configure the gateway meter’s serial port to use the Modbus Master protocol and enable the
Modbus gateway feature, create a Modbus gateway site in ION Setup or an energy management
system, and add the serial devices to the Modbus gateway site.

NOTE: Modbus Ethernet gateway supports up to 32 Modbus TCP connections.

Configuring a Modbus gateway using ION Setup

You can configure Modbus gateway on your meter using ION Setup.

Before you begin, make sure you have completed the following tasks:

• Confirm the serial network of devices are wired and configured to have the same baud rate,
serial port settings (for example, 8N1), and protocol (Modbus).

• Confirm each serial device has a unique unit identifier.

• Confirm the serial network of devices are connected to the gateway meter’s serial
communication port.

• Confirm your gateway meter is communicating over Ethernet.

• Confirm that the Modbus RTU and Modbus TCP/IP Ethernet protocols are enabled on your
gateway meter.

To configure a Modbus gateway using ION Setup: 

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Communications > Serial settings and select the tab for the communications port
that the serial network is connected to.

4. Select Protocol and click Edit.

The protocol selection screen appears.

5. Set the protocol toModbus Master.

6. Click Communications > Basic Ethernet > TCP/IP.



7. SelectModbus Gateway and click Edit.

The Modbus gateway selection screen is displayed.

8. Select the communications port that the serial network is connected to (and you just set to
use the Modbus Master protocol) and clickOK. The Modbus gateway connection is created.

9. Create an Ethernet gateway site to access the serial network of devices through your
gateway meter.

Creating an Ethernet gateway site using ION Setup
You can create an EtherGate or Modbus gateway site in ION Setup to view serial devices
connected to your meter when it is functioning as an Ethernet gateway.

You must have Ethernet gateway communications configured and your gateway and serial
devices connected and communicating.

To create an Ethernet gateway site using ION Setup:

1. Open ION Setup.

2. Right-click on your workstation icon and select Insert Item.

The New Network Item dialog appears.

3. Select Site and clickOK.

The New Site dialog appears.

4. Select theGeneral tab and configure the site.

Parameter Values/Options Description

Name - Ethernet gateway site name

Comm Link Ethernet Ethernet communications

Ethernet options Gateway Ethernet gateway communications

Gateway Info: IP Addr - IP address of the Ethernet gateway meter

Gateway Info: Port 7801, 7802, 502

7801 for EtherGate (COM1)

7802 for EtherGate (COM4)

502 for Modbus gateway

5. ClickOK to create the site.

6. Right-click on your newly created site and select Insert Item.

The New Network Item dialog appears.

7. Ensure the new Ethernet gateway site is selected in the Attach to drop-down list box.

8. Select Device and clickOK.

The New Device dialog appears.

9. Enter the details of your serial device. ClickOK to add the serial device to your Ethernet
gateway site.
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10. Repeat for all the serial devices on the gateway meter.

NOTE: Use a separate standard Ethernet connection in ION Setup to connect to and read
data from your Ethernet gateway meter.

HTTPS
HTTPS (Hypertext Transfer Protocol Secure) is an extension of HTTP and is used by a web
browser to establish communication between a client computer and the meter’s web server
hosting webpages.

HTTPS uses Transport Layer Security (TLS) encryption to secure the communications channel
and protect exchanged data between the client and the server. When configured to use HTTPS,
the meter uses the self-signed certificate installed on its web server.

You can view the meter’s webpages by entering the meter’s IP address on a web browser.

The meter uses port 443 for HTTPS by default.

Changing web protocol settings using ION Setup

Web protocol settings Description

HTTPSWith HTTP
Redirect

Redirects all HTTP requests to use HTTPS.

HTTPS
Allows only secure access and encrypted communications
between the client computer and the meter’s internal web server
hosting webpages.

Disabled
Turns off the meter’s web functionality and blocks all access to the
meter’s web server.

To change web protocol settings using ION Setup:

1. Open ION Setup and select the Setup Assistant for your meter.

2. Click Communications > Advanced Ethernet > Protocols tab.

3. Select theWeb protocol and click Edit.

4. Select a web protocol setting.

5. Change the default Assigned Port Numbers for HTTPS With HTTP Redirect and HTTPS.
This requires appending the changed port number for HTTPS access to the meter’s
webpages, for example: <meter IP address>:<changed https port number>.

Secure website indicator
A secure website displays a visible indicator such as a lock icon on the web browser.

The web address prefix https:// also indicates that the website is secure.

Web browsers typically prompt or display a message to warn you if a website you are trying to
access is not secure. For https connections, this indicates that the website’s SSL certificate is not
configured properly or is missing.



Default SSL certificate and webpages security
The meter web server protocol is factory-set to HTTPS with HTTP Redirect.

The meter ships from the factory with a self-signed certificate installed and is set to use HTTPS
protocol when accessing the webpages. Because the SSL certificate is self-signed and not signed
by a trusted Certificate Authority (CA), almost all browsers will flag the webpages as unsafe.

• If your meter is accessible only inside a secure network, you can add a security exception to
override how the browser identifies the webpages.

• If your meter is outside a secure network, you can install an SSL certificate issued by a CA.

Uploading a custom SSL certificate
You can upload a custom SSL certificate through the meter webpages.

Your meter supports .pem certificate file formats.

To upload a custom SSL certificate:

1. Use a web browser to log in to your meter.

2. Navigate to Setup > HTTPS.

3. Click Upload certificate.

4. Browse to the custom certificate, select it, then clickOpen.

The certificate is uploaded to the meter and the browser session is restarted.

Generating a new self-signed SSL certificate
A self-signed certificate is valid during the lease period. Generating a new certificate renews the
lease.

To generate a new self-signed SSL certificate using the meter webpages:

1. Use a web browser to log in to your meter.

2. Navigate to Setup > HTTPS.

3. ClickGenerate new self-signed certificate.

The meter prompts that the custom certificate will be deleted and that you will be logged out.

4. ClickOK to proceed.

Deleting a custom SSL certificate
1. Use a web browser to log in to your meter.

2. Navigate to Setup > HTTPS.

3. Click Delete custom certificate.

The meter prompts that you will be logged out and that a self-signed certificate will be used.

4. ClickOK to proceed.
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Secure File Transfer Protocol (SFTP)
Your meter has an internal SSH (Secure Shell) server that can be accessed using an encrypted
connection with SFTP (Secure File Transfer Protocol) client software. The SSH server hosts an
internal SFTP site and stores files in the meter’s flash memory, such as webpages, COMTRADE
records and firmware files.

Transferring files using SFTP
Prerequisites:

• Your meter’s IP address, username, and password.

• SFTP port number, see Protocols, ports, and connections.

• SFTP client software, such as FileZilla or WinSCP.

To transfer files using SFTP:

1. Start the SFTP client software.

2. Connect to your meter using the SFTP client software.

3. Navigate to the desired folder on your system.

4. Select the files that you want to transfer to the meter.

5. Transfer the files to the appropriate folder on your meter.

For more information , see SFTP folders and file permissions

6. Close the SFTP client software to disconnect from the meter.

Free up flash memory
Error messages related to available site space for storing files can be resolved by deleting files
using an SFTP client application. Available site space is affected by the number and size of stored
files and by features that use flash memory, such as increasing the number of COMTRADE
waveform records.

SFTP folders and file permissions
SFTP folder structure:

Folder Description

COMTRADE_1 to
COMTRADE_3

View COMTRADE files from these folders. Users have read
permission of files.

documents Add any file type to this folder. Users have full control of files.

IEC61850
Add an IEC 61850 configuration (CID) file to this folder to activate
IEC 61850 functionality. Users have full control of files in the root
and read permission of files in the log folder.

optionModuleUpg and
rmdUpg

Upload firmware upgrade files for your meter’s display or option
modules to these folders. Users have full control of files.



Folder Description

web
Add custom webpages to the meter by transferring them into web
subfolders. This folder is where default meter webpages are
stored. Users have full control of files.

SFTP file name restrictions
The names of files sent to the meter using SFTP:

• Cannot include spaces

• Cannot include \ / , * ? < >

• Cannot exceed 50 characters (including the file extension)

Simple Network Management Protocol (SNMP)
Your meter supports Simple Network Management Protocol (SNMP) after you have enabled
SNMP on your meter. You need to upload the meter’s Management Information Base (MIB) file
(available from www.se.com) into the Network Management System (NMS) managing your
meter.

SNMP is part of the Transmission Control Protocol/Internet Protocol (TCP/IP) protocol suite.
SNMP is an application layer protocol that enables the exchange of network management
information between devices, allowing you to manage network performance and to identify and
solve problems on networks with devices of various types.

SNMP configuration assumes that you have an advanced understanding of SNMP and the
communications network and power system that your meter is connected to.

Key terms

Term Definition

Agent
Software resident on the managed device which interfaces
between the device and the NMS.

Managed device Your meter in the SNMP network.

Community name/string
A text string that helps authenticate requests between the
managed device and the NMS.

Managed object Any parameter referenced in the MIB file.

MIB
A management information base which organizes the OIDs in a
hierarchical tree.

NMS
A network management station, manager or client that executes
applications to monitor and control devices. An NMSmust have
the standard and customMIB files and SNMPmanager software.

OID
An object identifier that uniquely identifies and labels a managed
object in the MIB.

Trap receiver
An NMS that is configured to receive traps and whose IP address
is an SNMP trap destination.
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Your meter in an SNMP system
Your meter is a managed device with an SNMP agent in an SNMP network.

A Trap receivers

B SNMP agent (meter)

C NMS with SNMPmanager software and MIB file installed

NOTE: The NMS computer can also function as a trap receiver.

SNMP trapping
SNMP trapping allows your meter’s agent to notify the NMS of events with an unsolicited SNMP
message (a “trap” of the meter’s alarm event).

You can enter up to four IP addresses for SNMP trap notification for generic and enterprise-
specific traps. For enterprise traps, you must also define the number of events or maximum time
delay before SNMP traps are sent to the NMS.

SNMP trapping is only supported on SNMP v2.

Configuring SNMP using ION Setup
You can enable SNMP and configure SNMP trapping using ION Setup.

Download the IONMIB file from www.se.com.

To configure SNMP using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.



3. Click Communications > Advanced Ethernet > SNMP.

4. Configure your meter’s SNMP parameters by selecting the parameter and clicking Edit.
ClickOK in the editing screen to set the parameter value.

Parameter Description

Enable SNMP Enables or disables SNMP on your meter.

Enable Traps Enables or disables SNMP trapping on your meter.

Trap Rcvr1 Addr to Trap
Rcvr4 Addr

Enter up to four trap receiver IP addresses where trap
messages will be sent.

Read only community
Enter the community string used for SNMP get (read-only)
requests.

Read write community

Enter the community string used for SNMP set (read/write)
requests.

NOTE: You can use the read/write community string for
SNMP get (read-only) requests.

System contact Enter the name of your SNMP system administrator.

System name Enter a descriptive name for your meter.

System location Enter your meter’s location.

5. Review the rest of the SNMP information and modify if necessary.

Configuring SNMP using webpages
You can configure SNMP trapping using your meter’s webpages.

Download the IONMIB file from www.se.com.

1. Connect to your meter’s webpages.

2. Go to Setup > SNMP Parameters.
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3. Configure your meter’s SNMP parameters by selecting the parameter value.

Parameter Range Description

Enable SNMP Yes/no Enables or disables SNMP on your meter.

SNMP Port Number 161 (default) Enter your meter’s SNMP port number.

System contact -
Enter the name of your SNMP system
administrator.

System name - Enter a descriptive name for your meter.

System location - Enter your meter’s location.

Read-only Community
Name

-
Enter the community string used for SNMP
get (read-only) requests.

Read-write Community
Name

-

Enter the community string used for SNMP
set (read/write) requests. NOTE: You can
use the read/write community string for
SNMP get (read-only) requests.

Enable SNMP Traps Enable/disable
Enables or disables SNMP trapping on your
meter.

Enable High Priority
Alarms

Yes/no
Enables trapping of events that create high
priority alarms.

Enable Med Priority
Alarms

Yes/no
Enables trapping of events that create
medium priority alarms.

Enable Low Priority
Alarms

Yes/no
Enables trapping of events that create low
priority alarms.

Report Buffer Size 1–30

Enter the maximum number of trap
messages to be stored before the trap
messages are sent. Traps are sent when
the number of trap messages is equal to or
greater than this value.

Report Hold Time 1–300 seconds

Enter the maximum duration for trap
messages to be held. Trap messages are
sent when the time after a trap event has
occurred is equal to or greater than this
value.

Trap Rcvr1 Addr to Trap
Rcvr4 Addr

-
Enter up to four trap receiver IP addresses,
where trap messages will be sent.

4. Click Apply to configure the meter’s SNMP parameters.

SNMP implementation

MIB files

Your meter is compliant with MIB-II as defined by the standard MIB file RFC 1213.



SNMP requires that you load your meter’s ION MIB file (available for download from
www.se.com) into the NMS.

You must install RFC 1213, which is required to read basic network information for the meter (for
example, TCP/IP traffic or number of packets received), if it is not included with your SNMP
manager software.

Community strings

A community string is a text string which acts to help authenticate requests from the NMS to your
meter.

There are two community strings on your meter:

• Read Only Community: this community string is used by SNMP get (read-only) requests. The
read only community string’s initial factory-set value is public.

• ReadWrite Community: this community string is used by SNMP set (read/write) requests.
The read write community string’s initial factory-set value is private.

NOTE: You can also use the read write community string for SNMP get (read-only) requests.

If your meter receives an incorrect community string, it generates an AuthenticationFailure trap.

System strings

A system string is a text string which can be configured to provide information about your meter.

There are three system strings on your meter:

• System contact: Enter the name of the SNMP system administrator.

• System name: Enter a descriptive name for your meter.

• System location: Enter a description of your meter’s location.

SNMP trapping implementation
Generic SNMP traps supported by your meter are:

• Coldstart: The meter (SNMP agent) is starting.

• Linkup: The SNMP agent is enabled.

• AuthenticationFailure: The meter (SNMP agent) has received an incorrect community value.

Enterprise-specific SNMP traps supported by your meter are:

• Low: Trap of events with a low event priority.

• Medium: Trap of events with a medium event priority.

• High: Trap of events with a high event priority.

Trap Event priority range

Low 64–127

Medium 128–191

High 192–255
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NOTE: The number of events or maximum time delay settings only apply to enterprise SNMP
traps.

(missing or bad snippet) on the SNMPMapping, SNMP Options, and Alarm Options modules
Clock module, see ION Reference, available on www.se.com.

Default SNMP mapping
Enabling SNMP provides SNMP access to the meter values linked to the SNMPMapping module.

You can configure the SNMPMapping module to link to different meter values. By default, the
following meter values are linked to the SNMPMapping module:

I a kVAR tot Vll ca Vln avg Ib mean
kW sd mx del-
rec

I b kVA tot Vll avg Freq Ic mx kW sd del

I c PF sign tot Vln a Ia mx Ic mean kW sd rec

I avg Vll ab Vln b Ia mean kW sd mx del kW sd del-rec

kW tot Vll bc Vln c Ib mx kW sd mx rec kVAR sd mx del

kVAR sd mx
rec

kVAR sd mx del-
rec

kVAR sd
del

kVAR sd
rec

kVAR sd del-
rec

kVA sd mx del

kVA sd mx rec kVA sd mx del-rec kVA sd del kVA sd rec kVA sd del-rec kWh del

kWh rec kWh del-rec kVARh del kVARh rec kVARh del-rec kVAh del

kVAh rec kVAh del-rec

The following meter information is always provided by default and cannot be configured:

Volts mode Model number

Serial number Device name

Firmware version MIB version

If you change your meter’s default values, you must modify the custom MIB file to reflect the new
values.

Changing your meter’s default SNMP configuration assumes that you have an advanced
understanding of ION architecture, SNMP, and the communications network and power system
that your meter is connected to.

See ION Reference, available from www.se.com, for detailed information on the SNMPMapping
module.

Configuring SNMP MIB files
You must configure your MIB file if you modify the default SNMP information provided by the
meter for the MIB file labels to reflect the modified values.



Download the IONMIB file from www.se.com.

NOTE: You should only configure the variable name and description. Changing other fields in
your MIB file may cause the client software to report problems or return errors when trying to
retrieve or view parameters.

The variable name must conform to the following rules:

• The first character must be a letter.

• The first character must be lower case.

• The name must not contain any special characters such as *, ?, &.

• The name must not contain spaces.

To configure your SNMP MIB file:

1. Open your meter’s MIB file in a text editing program (such as Notepad).

2. Update the variable name and description so they match the meter values connected to the
SNMPMapping module.

3. Save your meter’s MIB file. Keep the original file extension of .MIB.

Example:

This example shows an original and an updated OID entry in an MIB file, where the default meter
value of voltage line-to-neutral phase A is modified in the meter’s SNMPMapping module and is
now connected to voltage line-to-neutral phase C.

Original OID entry

Vln_a OBJECT-TYPE

SYNTAX DisplayString (SIZE (0. . 255))

ACCESS read-only

STATUSmandatory

DESCRIPTION “Host Meter Voltage Line A to Neutral Units = V (Volts)” ::= {  Schneider Electric
34 }

You must update the variable name and description to match the meter values connected to the
SNMPMapping module:

Value Original Updated

Variable name Vin_a Vin_c

Description
“Host Meter Voltage Line A to
Neutral Units = V (Volts)” ::= { 
34 }

Host Meter Voltage Line C to
Neutral Units = V (Volts)” ::= { 
Schneider Electric 34 }
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The SNMP client software reads the original and updated file as follows:

Original Updated

variable name: Vln_a

Description: “SNM1 Input 1 - Voltage (line-to-
neutral) phase A”

variable name: Vln_c

Description: “SNM1 Input 1 - Voltage (line-to-
neutral) phase C”

IEC 61850
IEC 61850 is an Ethernet-based communications protocol designed for electrical substations.

Your meter can be integrated into an IEC 61850 system as an Intelligent Electronic Device (IED)
or server that supports concurrent IEC 61850 client connections and an SFTP connection.

Go to the IEC International Electrotechnical Commission website at www.iec.ch for more
information on the IEC 61850 protocol.

Refer to the IEC 61850 and ION technology protocol document at www.se.com for information
about setup and configuration.

Mapping additional data to IEC 61850
Map additional data, such as Inputs and Outputs, to IEC 61850. You do not need to have IEC
61850 enabled on your meter to perform this procedure.

To map additional data to IEC 61850:

1. Open ION Setup > select the meter > Setup Assistant.

2. Communications > 3rd Party Protocols > IEC 61850.

3. Highlight a parameter to add to IEC 61850 data. Select analog for numeric information and
digital for Boolean or binary information.

4. Click Edit. The custom configuration screen is displayed.

5. Select the desired meter value. If the value you want is not shown, select Show all
available registers.

6. Select an IEC 61850 item:

Click >> to map the value.

Click << to unmap values.

7. ClickOK.

Enabling IEC 61850 functionality
Your meter is configured with a default set of data available to IEC 61850 that can be integrated
into an IEC 61850 system. To enable this functionality, upload a CID (Configured IED Description)
file to your meter.



If more than one CID file is stored in the meter, IEC 61850 functionality is deactivated until
additional files are deleted.

Prerequisites:

• CET850 IEC 61850 configuration tool installed on your computer. Download the software at
www.se.com.

• Meter connection using ION Setup over IPv4 Ethernet.

• Download the firmware package for your meter and select an ICD (IED Capability
Description) file that matches your meter’s profile. Go to www.se.com and search for firmware
and associated files (ZIP) for your meter.

Enabling IEC 61850 functionality consists of 2 steps:

1. Build the CID file using the CET850 IEC 61850 configuration tool.

2. Upload the CID file using ION Setup.

Step 1 – Build the CID file:

1. Open the CET850 IEC 61850 configuration tool.

2. File > New.

3. Add > IED. The Add IED dialog box opens.

4. Click more options ... in the IED identification area. The Add a Device dialog box opens.

5. SelectOther device.

6. Click more options ... .

7. Browse to the location of the ICD file, select it and clickOpen.

8. ClickOK.

9. Enter values for the device in the IED dialog box and clickOK.

10. File > Build a CID file.

11. Click Yes on the CET850 message box.

12. Save the file as an SCD file. The Save as dialog box opens.

13. Ensure CID files (*cid) is selected and click Save.

14. Close the CET850 IEC 61850 configuration tool.

Step 2 – Upload the CID file:

1. Open ION Setup > select the meter > Setup Assistant.

NOTE: The CID file can also be uploaded using SFTP. Refer to SFTP folders and file
permissions for more information.

2. Communications folder > 3rd Party Protocols > IEC 61850 > Upload CID.

3. Navigate to the CID file, select it and clickOpen. CID file validation can take several
minutes.
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The CID status on the IEC 61850 tab indicates if the meter is operating as an IEC 61850 IED
or server.

Watch the video on How to Enable IEC 61850 Functionality on Your Meter.

Configuring digital outputs for IEC 61850 control
Configure default settings for digital outputs to use IEC 61850 for non-critical control of the
meter’s digital outputs.

This procedure is optional. Your meter has comprehensive default settings for IEC 61850 that
meet the needs of most systems without configuration. This is an advanced procedure that
requires in-depth knowledge of your meter, its underlying architecture, and the system in which it
is installed.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

To configure digital outputs for IEC 61850 control: 

1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

3. IEC 61850 GGIO Onb Modules folder > double-click module > Setup Registers.

4. Select the desired SPCS Control Mode register > Edit. A dialog opens.

5. Select IEC 61850 CtlVAL from the drop-down list box >OK > Inputs.

6. Select the digital output Status register > Delete.

Note: This digital input register must be deleted to prevent a circular reference that will
cause the affected modules to go offline.

7. Click Send.

8. Navigate to the Digital Out Modules folder > double-click on the module selected to control
via IEC 61850.

9. Select the Setup Registers tab and confirm that the Digital Output module’s setup registers
are configured.

10. Inputs > Source register > Edit.

11. Navigate to the IEC 61850 GGIO Onb folder and select the SPCS.stVal output register that
corresponds to the digital output.

https://www.youtube.com/watch?v=gPYb_8k6LkU


12. ClickOK > Send.

See ION Reference, available from www.se.com, for information about IEC 61850 GGIO
and Digital output modules.

Deleting an IEC 61850 configuration file
1. Open SFTP client software. See Secure File Transfer Protocol (SFTP) for information about

connecting with SFTP client software.

2. Connect to the meter using the meter’s IP address and SFTP port number. See Protocols,
ports, and connections for information on port numbers.

3. Open the IEC61850 folder in SFTP file directory and delete the CID file.

4. Close SFTP client software.

MQTT
MQTT (Message Queuing Telemetry Transport) is a lightweight messaging protocol designed for
devices with limited resources and networks with low bandwidth or high latency. MQTT uses a
publish-subscribe model, which helps reduce network traffic and simplifies communication
between devices.

MQTT overview
• Publish-subscribe model: Devices (clients) publish messages to topics. Other devices
subscribe to those topics to receive messages.

• Broker: A central server that manages distribution between publishers and subscribers.

• Quality of Service (QoS):MQTT supports three levels of message delivery:

QoS 0: At most once (no confirmation).

NOTE: Your device uses QoS 0.

QoS 1: At least once (confirmation required).

QoS 2: Exactly once (guaranteed delivery).

Your meter as an MQTT client
As an MQTT client, your meter can:

• Publish data: Publish data (such as voltage, current, or any other numeric value) to the
broker (QoS 0).

• Communicate securely: TLS encryption and optional authentication help the meter secure
data exchange with the MQTT broker.

For more information on the MQTT Export Module, including a detailed description of the payload
format, see ION Reference, available on www.se.com.
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Uploading an MQTT certificate authority file
To connect the meter to an MQTT broker, you need to provide a file that lets the meter trust the
broker. This file is called a certificate authority (CA) file; the CA file contains one or more trusted
certificates. The CA file must be in Privacy-Enhanced Mail (PEM) format and uploaded to the
meter before making an MQTT connection.

Prerequisites:

• A CA file in PEM format.

TIP: The broker's certificate chain must include one of the certificates in the CA file.

• The file name is exactly CAfile.pem.

NOTE: The file name is case-sensitive.

• SFTP access

To upload an MQTT certificate authority file:

1. Connect to the meter using an SFTP client.

2. Navigate to where you have saved CAfile.pem on your system.

3. Navigate to the meter's documents folder.

4. Transfer CAfile.pem from your system to the meter's documents folder.

For more information, see Transferring files using SFTP.

Configuring MQTT using ION Setup
Use advanced mode in ION Setup to:

• Select the data to publish.

NOTE: Data comes from linking numeric ION output registers from other modules to the
MQTT Export Module's input registers. You cannot link other types of ION registers. For
more information, see ION Reference, available on www.se.com.

• Enter the connection details between the meter and the broker.

• Check the status of the MQTT connection.

Prerequisites:

• An understanding of ION architecture.

• The MQTT broker's IPv4, IPv6, or fully-qualified domain name.

• Full meter configuration access.

• You have uploaded a certificate authority (CA) file for the broker. For more information, see
Uploading an MQTT certificate authority file.



To configure MQTT:

1. Open ION Setup.

2. Open advanced mode for your meter.

If prompted, enter the device credentials.

TIP: To open advanced mode, Ctrl+Select your meter in the Network Viewer.

3. OpenMQTT Export Modules.

4. If you do not already have an MQTT module:

a. Right-clickMQTT Export Modules.

b. Select Insert Module.

MQTT Export 1 is created.

5. OpenMQTT Export 1.

6. Go to Inputs, select the Source that you want to link, and then select Edit.

The ION Input Selection screen appears.
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7.  Link the source inputs:

a. To link one input at a time:

a. Go to Inputs, and then select the Source of the MQTT module that you want to link.

b. Go toOutput Registers, and then:

a. Select a module type that has a numeric register.

b. Select the module that you want to open.

c. Select the numeric register that you want to link to the selected Source.

c. SelectOK.

TIP: You must select a register forOK to become active.

OR



b. To link multiple inputs at once:

a. Go to Inputs, select a range of sources from the MQTT module that you want to link
using Shift+Select or Ctrl+Select.

b. Go toOutput Registers, and then:

a. Select a module type that has a numeric register.

b. Select the module that you want to open.

c. Select the starting numeric register that you want to link to the Source range.

TIP: ION Setup will automatically link as many available contiguous registers after
the starting register.

c. SelectOK.

TIP: You must select a register forOK to become active.

c. Repeat until all the desired links are created.

8. Select Setup Registers.

9. Enter your MQTT connection settings.

10. Select Send.

11. Confirm your MQTT connection.

MQTT connection settings
MQTT connection settings define how the device connects to an MQTT broker. Specify the broker
address and client ID to establish communication. Optionally, provide a username and password
if the broker requires authentication.
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Parameter Values Description

Broker Address

Fully qualified
domain name
(FQDN), IPv4
address, IPv6
address

Enter the MQTT broker’s FQDN or IP
address.

NOTE: If you enter a FQDN for the Broker
Address, the meter connects to the broker
using its IPv4 interface. To connect using
IPv6, enter an IPv6 Broker Address.

TIP: You can include a port number if the
port is different from the default (8883), for
example: 169.254.1.11:8884.

Client ID 1–23 characters

Enter a unique identifier for the MQTT client.

A valid Client ID:

• Has 1–23 characters.

• Uses characters from the following
groups:

A–Z

a–z

0–9

Hyphen (-)

Username 1–255 characters

Enter the username for authentication with
the broker.

A valid Username:

• Has 1–255 characters.

• Uses printable ASCII characters (0x20–
0x7E).

• Has no leading or trailing spaces.



Parameter Values Description

Password 1–511 characters

Enter the password for authentication with
the broker.

NOTE: Password is write-only.

A valid Password:

• Has 1–511 characters.

• Uses printable ASCII characters (0x20–
0x7E).

• Has no leading or trailing spaces.

The Password is deleted during firmware
upgrades and when applying a template.

NOTICE
LOSS OF COMMUNICATION

Ensure that you re-enter the MQTT
password after upgrading firmware or
applying a template.

Failure to follow these instructions
can result in loss of communication.

NOTE: To connect without authentication, leave Username and Password empty.

Confirming your MQTT connection
Use ION Setup to confirm that you have an active connection with the MQTT broker.

To confirm your MQTT connection:

1. Open ION Setup.

2. Open advanced mode for your meter.

If prompted, enter the device credentials.

TIP: To open advanced mode, Ctrl+Select your meter in the Network Viewer.

3. SelectMQTT Export Modules.

4. SelectMQTT Export 1.

5. Shift+Select Output Registers.

Status indicates the connection status:
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True: The meter is connected to the MQTT broker.

False: The meter is not connected to the MQTT broker.

Distributed Network Protocol (DNP)
Your meter can be integrated into a DNP network as a DNP slave.

The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used in the electric
utility industry for communications and interoperability among substation computers, Remote
Terminal Units (RTUs), Intelligent Electronic Devices (IEDs, for example: meters), and master
stations.

DNP supported features and default implementation
Your meter is pre-configured for basic DNP slave functionality.

Your meter supports a maximum of three concurrent connections (sessions) using the DNP 3.0
protocol; one for each serial port, up to three using Ethernet, or a combination of both.
Combinations available depend on the meter's communications options. A session consists of all
incoming and outgoing DNPmaster-slave traffic on one of the meter's communications ports.

For serial DNP communications, you must assign the DNP protocol to the appropriate serial
communication port on your meter; you do not have to configure your meter’s Ethernet ports.

You can modify your meter’s default DNP map using configuration software.

Data can be imported into the meter from a DNP control relay or analog output device. This is an
advanced feature intended for users with an in-depth understanding of the DNP 3.0 and ION
protocols.

See the online ION Setup help for instructions on connecting to your meter and accessing the
Setup Assistant, which can be used to modify your meter’s DNP port settings and default DNP
map.

For more information, see the Multiport DNP 3.0 and ION Technology technical note, available on
www.se.com.

DLMS/COSEM
The Device Language Message Specification (DLMS) is described by the international standard
IEC 62056. It defines structured modeling and meter data exchange for an interoperable
environment.

DLMS supports applications such as remote meter reading, remote control, and value-added
services for metering different kinds of energy, such as electricity, water, gas, or heat.

COSEM stands for Companion Specification for Energy Metering. It is an interface model for
communicating with energy metering equipment, providing a view of the functionality available
through the communications interfaces. The model uses an object-oriented approach.

The COSEMmodel allows for a manufacturer-independent and controlled method to identify,
retrieve, and interpret the information held in any meter.

For more information, see the DLMS/COSEM and ION technology technical note, available on
www.se.com.

https://www.se.com/ca/en/download/document/70072-0158-04/
https://www.se.com/ca/en/download/document/7EN22-0123/


Inputs/Outputs
Inputs/Outputs overview

Your meter has onboard digital Input/Output (I/O) which can be increased by adding optional
digital and analog I/O modules to expand your meter’s I/O capabilities.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Your meter base has:

• Eight digital inputs

• Four form A digital outputs

• Two form C relays

• kWh energy pulsing LEDs (one visible, one infrared)

• kVARh energy pulsing LEDs (one visible, one infrared)

You can view information about your meter’s I/O through the display or webpages and configure
your meter’s I/O using ION Setup.

Input/output ION modules
ION modules are used to configure your meter’s digital or analog inputs/outputs (I/O).

You need to configure the following IONmodules to use the meter’s digital or analog I/O.

• Digital input – Uses the Digital Input module, which tells the meter how to interpret incoming
signals.

• Digital output – Uses one of three IONmodules depending on the application.

Digital Output module – Monitors a change of state to control relay operation via a
hardware output device.

Pulser module – Transfers high-speed pulses to a hardware pulse counting device that is
used to track energy usage.

Calibration Pulser module – Integrates instantaneous power inputs, then outputs high-
speed pulses to an LED that can be monitored for energy accuracy verification.

• Analog input – Uses the Analog Input module, which tells the meter how to interpret an
incoming analog voltage or current signal from transducers.
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• Analog output – Uses the Analog Output module to deliver a continuous direct voltage or
current analog signal to transducers.

NOTE: All of these modules can act as intermediaries between the physical hardware port and
the other modules in the meter. They define the characteristics of the incoming and outgoing
signals.

For more information on the IONmodules, see ION Reference, available from www.se.com.

Input/output ION modules, ports, and labels
You can configure the Digital Output, Digital Input, Analog Input, Analog Output, Pulser and
Calibration Pulser ION modules to specify which port handles the outgoing or incoming signals.

To assign a port to one of these modules, modify the Port setup register by picking a port from the
enumerated list.

NOTE: If the port you want to use does not appear in the Port setup register list, that port is in
use by another module. Edit the Port setup register of the module using that port and set it to
Not Used. The port is then available to other modules.

Factory configured settings

ION module
type

ION module name Hardware port
(device label)

Port setup
register name

Description

Digital
Output

Port D1–D4 D1–D4 Port D1–D4 Form A relay

Port R1–R2 R1–R2 Port R1–R2 Form C relay

Calibration
Pulser

WATT LED kWATT WATT LED
kW energy pulsing
(total)

VAR LED kVAR VAR LED
kVAR energy pulsing
(total)

Digital Input Port S1–S8 S1–S8 Port S1–S8
Internally/externally
excited

Onboard input and output ports

ION module
type

ION module name Hardware port
(device label)

Port setup
register name

Description

Digital Input Port A/B/C/D S1–S6 S1–S6

Port A S1–S6

Port B S1–S6

Port C S1–S6

Port D S1–S6

Option module
digital inputs

Option module(s) input and output ports



ION module
type

ION module name Hardware port
(device label)

Port setup
register name

Description

Digital
Output

Port A/B/C/D D1–D2 Relay 1–Relay 2

Port A D1–D2

Port B D1–D2

Port C D1–D2

Port D D1–D2

Option module
digital output

Analog Input Port A/B/C/D A1–A4 A1–A4

Port A A1–A4

Port B A1–A4

Port C A1–A4

Port D A1–A4

Option module
analog input

Analog
Output

Port A/B/C/D Q1–Q2 Q1–Q2

Port A Q1–Q2

Port B Q1–Q2

Port C Q1–Q2

Port D Q1–Q2

Option module
analog output

NOTE:When configuring your meter, the configuration interface may show all the possible
ports, regardless of what is physically available on your meter.

For more information, see ION Reference, available on www.se.com.

I/O option modules
I/O option modules provide increased digital and analog input/output (I/O) capabilities for your
meter.

These I/O modules can be used to monitor the status of breakers, control analog or digital
transducers, or receive signals that can be interpreted to provide WAGES data for your energy
system. For applications requiring high accuracy, such as energy pulsing to verify accuracy, the
digital output on the meter base is recommended.

Your meter’s analog I/O option modules can measure and output either low voltage or current
using standard analog transducers such as 4–20 mA current transducers.

Viewing I/O option module data
View I/O option module data using ION Setup, meter webpages, or the display.

To view option module data using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Select Expansion Modules > Option Modules, and then select the desired I/O option
module tab.
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4. If there are no I/O option modules connected, no information other than column headers is
displayed.

To view option module data using meter webpages:

1. Connect to your meter webpages.

2. Go toMonitoring > Inputs/Outputs, and then select Digital Inputs, Digital Outputs,
Analog Inputs, or Analog Outputs.

3. If there are no I/O option modules of the specified type, no entries other than column
headers are displayed.

To view option module data using the display:

Go to Inputs/Outputs, and then select Digital Inputs, Digital Outputs, Analog Inputs, or
Analog Outputs.

I/O option module configuration
You can configure your meter’s I/O option modules using ION Setup.

The Option Modules screen has tabs corresponding to the possible option modules, which are
identified based on how the option modules are connected to the meter. Each tab indicates the
module’s type and status and has an area where the module’s ports are listed for viewing and
configuration. You can also reset your meter’s option modules using ION Setup.

Status examples Description

None No option module detected

Normal The option module is operating normally

Option module added A new option module is detected

Option module removed The option module has been removed

Invalid S19 The option module’s firmware is not supported

Invalid card The option module type is not supported

Analog inputs
Analog input applications

You can use an analog input to monitor an analog signal, for example a flowmeter, to monitor how
much water flows through a pipe.

For analog input operation, your meter takes an analog input signal and provides the resulting
scaled value.

Your meter’s analog I/O option modules can measure either low voltage or current using standard
analog transducers such as 4–20 mA current transducers.

Analog input voltage and current mode
You can set the analog input’s mode for voltage or current sensing.



In current mode, the analog inputs have a low input resistance while the meter is powered on, and
a high input resistance when the meter is powered off. In voltage mode, the analog inputs have a
high input resistance regardless of whether the meter is powered or not.

NOTE:When unpowered, your meter’s analog inputs act like they are in voltage mode (high
input resistance).

When connected to a current output transducer, this high resistance can create a high voltage.
Standard (i.e., 4–20 mA) current transducers have open circuit protection and can handle a high
input resistance; however, if non-standard transducers are used high voltages may be generated.
Your meter’s analog input has circuitry to limit this voltage, but it may not be sufficient with a very
high-power current source.

NOTICE
EQUIPMENT DAMAGE

• Ensure the analog input is configured for the correct voltage or current mode before
connecting or activating the current transducer.

• Do not exceed the device’s ratings for maximum limits.

Failure to follow these instructions will result in equipment damage.

Analog input behavior
Analog inputs may show a value below zero scale if an open circuit is detected on the input port.

Analog input zero scale and full scale values
In most cases the output range of the sensor feeding the analog input matches the hardware
limits of your meter’s analog input port. In that case, the analog input’s zero scale and full scale
values are the same as the sensor’s represented range. For example:

Analog sensor Meter’s analog input signal Analog input register values

0–50 psi represented by a

4–20 mA signal

4–20 mA analog input range

Input value: 12 mA

Full scale = 50 (psi)

Zero scale = 0 (psi)

Scaled value: 25 (psi)

0–50 psi represented by a

0–20 mA signal

0–20 mA analog input range1

Input value: 12 mA

Full scale = 50 (psi)

Zero scale = 0 (psi)

Scaled value: 30 (psi)

1 Analog I/O option module must have firmware version v1.2 or later.

If the sensor’s output range does not match your meter’s hardware limits, you must calculate the
full scale and/or zero scale values by analyzing the system.

For more information on the Analog Input module, see ION Reference, available on www.se.com.
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Configuring option module analog inputs using ION Setup
You can configure analog inputs using ION Setup.

Analog inputs are available on the optional I/O modules.

Calculate your zero scale and full scale values based on the analog source and the input range of
your meter.

Make sure that the analog input port that you want to use is properly configured and connected to
a valid external analog signal source.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Expansion Modules >Option I/O Modules and select the module tab that
corresponds to the option module with the analog input you want to configure.

4. Select the analog input channel and click Edit. Enter the meter password if prompted. The
setup screen for that analog input is displayed.

5. Configure the analog input by selecting the parameter and clicking Edit.

Parameter Value/Range Description

Zero scale 0 to ±109
The minimum source value that matches
the minimum analog input signal.

Full scale 0 to ±109
The maximum source value that matches
the maximum analog input signal.

Port - The physical analog input port connection.

Mode Voltage, current
Determines whether the analog input is
monitoring voltage or current.

Update Rate One Second/High Speed Defines how frequently the input is updated.

Analog outputs
Analog output applications

You can use an analog output to send a signal to an external analog input, for example an analog-
controlled valve, to modify a water pipe’s valve position to change the flow rate.

For analog output operation, your meter takes an input value and scales it to the appropriate
signal value to send out the physical analog output port.

Your meter’s analog I/O option modules can output either low voltage or current using standard
analog transducers such as 4–20 mA current transducers.

Analog output behavior
Your meter’s analog output, after it is configured, outputs voltage or current signals. If your
meter’s analog output source becomes unavailable (N/A) the analog output level should go to
zero (0 V/0 mA) under most conditions.



When your meter is powered off or configured to send voltage, the meter registers as a high
impedance.

The electrical signal on the analog output is DC; make sure proper polarity is observed when
wiring external devices to the analog output ports.

Analog output zero scale and full scale values
In most cases, your meter’s analog output range matches the range of the analog sensors that
your meter’s outputs are connected to. In that case, your meter’s analog output zero scale and full
scale values are the maximum and minimum values of the source driving your meter’s analog
output. These values are used to normalize the source value to a value between 0 and 1 which is
applied to the operating range of the analog output port to determine the analog output current or
voltage. For example:

Source value Analog output register values Meter’s analog output signal

0–120 kW range

100 kW

Full scale = 120 (kW)

Zero scale = 0 (kW)

Normalized: 0.83

4–20 mA range

Output: 17.33 mA

0–120 kW range

100 kW

Full scale = 120 (kW)

Zero scale = 0 (kW)

Normalized: 0.83

0–20 mA range1

Output: 16.67 mA

1 Analog I/O option module must have firmware version v1.2 or later.

If your meter’s analog output range does not match the range of the connected analog sensor,
you must calculate the full scale and zero scale values by analyzing the system.

For more information on the Analog Output module, see ION Reference, available on
www.se.com.

Configuring option module analog outputs using ION Setup
You can configure option module analog outputs using ION Setup.

Analog outputs are available on the optional I/O modules.

Calculate your zero scale and full scale values based on the measured value and the analog
output range of your meter.

Make sure that the analog output port that you want to use is properly connected to an analog
receiver.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Expansion Modules >Option I/O Modules and select the module tab that
corresponds to the option module with the analog output you want to configure.

4. Select the analog output channel and click Edit. Enter the meter password if prompted. The
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setup screen for that analog output is displayed.

5. Configure the analog output by selecting the parameter and clicking Edit.

Parameter Value/Range Description

Zero scale 0 to ±109
The minimum source value that matches the minimum
analog output signal.

Full scale 0 to ±109
The maximum source value that matches the maximum
analog output signal.

Port - The physical analog output port connection.

Mode
Voltage,
current

Determines whether the analog output is monitoring
voltage or current.

Digital inputs
Digital input applications

Digital inputs are typically used for monitoring the status of switches or contacts, such as status
contacts on circuit breakers.

They can also be used for pulse counting or input metering applications, such as WAGES (water,
air, gas, electricity, steam) monitoring, or conditional energy applications, or IRIG-B time
synchronization.

Pulse mode

If you set Input Mode to PULSE, a pulse is generated at the Trigger output when the State output
changes from OFF-to-ON. No pulse is generated when State changes from ON-to-OFF.

KYZ mode

If you set Input Mode to KYZ, a pulse is generated at the Trigger output for each change of state
transition, for example from OFF-to-ON and from ON-to-OFF transitions.



A/C mode

If you set Input Mode to A/C, the digital input port is configured to detect the presence of a low
voltage AC signal. The next illustration shows how a digital input can be used to monitor the
operation of a low voltage AC fan controller.

IRIG-B time synchronization
You can use a digital input to synchronize the meter time to an IRIG-B time source.

You can connect an IRIG-B time source to one of meter’s digital inputs for IRIG-B time
synchronization. For IRIG-B time synchronization, you must configure both the meter’s digital
input and the meter’s clock.

NOTE: For improved accuracy use the digital inputs on the meter base.

Configuring onboard digital inputs using ION Setup
You can use ION Setup to configure your meter’s digital inputs.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. ClickOnboard I/O > Digital Inputs. The tabs correspond to each digital input. Click on the
tab for the digital input you want to edit.

4. Configure the digital input by selecting the parameter and clicking Edit.

5. After the parameter is configured, clickOK to save the setting to the meter.
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Parameter Value/range Description

Input Mode
Pulse, KYZ, A/C,

IRIG-B*

Specifies how the meter processes the signal:

• Pulse: the meter counts an entire pulse (from
off-on to on-off) as one input.

• KYZ: the meter counts a transition (from off-on
or from on-off) as one input.

• A/C: the meter detects analog signals where the
ON condition is based on the presence of an AC
signal.

• IRIG-B*: the meter detects an IRIG-B time
synchronization signal.

Polarity Inverting/Non-Inverting
Specifies if the signal from the digital port is inverted
or not inverted.

Debounce 0.000–1.000
Specifies how long (in seconds) the signal must
remain in a state to be considered a valid state
change.

Assigned Port
Defined by your meter’s
hardware

Your meter’s physical digital input port.

EventLog Mode Log Off/Log On Specifies if events generate log entries.

State OFF/ON Indicates the status of the digital input.

* You must also configure your meter’s clock to use IRIG-B time synchronization.

Configuring option module digital inputs using ION Setup
You can configure option module digital inputs using ION Setup.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Expansion Modules >Option Modules and select the module tab that corresponds
to the option module with the digital input you want to configure.

TIP: The tabs correspond to the slot in which the option module is installed. For more
information, see Option modules.

4. Select the digital input channel and click Edit.

The setup screen for that digital input is displayed.

5. Configure the digital input by selecting a parameter and then select Edit.

After configuring a parameter, selectOK to save the setting to the meter.



Parameter Value/Range Description

Input Mode
Pulse, KYZ, A/C,
IRIG-B*

Specifies how the meter processes the signal:

• Pulse: the meter counts an entire pulse (from off-
on to on-off) as one input.

• KYZ: the meter counts a transition (from off-on or
from on-off) as one input.

• A/C: the meter detects analog signals where the
ON condition is based on the presence of an AC
signal.

• IRIG-B*: the meter detects an IRIG-B time
synchronization signal.

EvLog Mode Log Off/Log On Specifies if events generate log entries.

Event Priority 0–255 Specifies the priority of an event.

Polarity
Inverting/Non-
Inverting

Specifies if the signal from the digital port is inverted
or not inverted.

Debounce 0.000–1.000
Specifies how long (in seconds) the signal must
remain in a state to be considered a valid state
change.

Port
Defined by your
meter’s hardware

Your meter’s physical digital input port.

Enable Enabled/Disabled Specifies whether the module is enabled or disabled.

Alarm Trigger
Mode

Alarm on ON/Alarm
on OFF

Specifies the behavior of the digital input alarm.

* IRIG-B time synchronization is not supported on the option module digital inputs.

WAGES monitoring
WAGESmonitoring lets you record and analyze all energy sources and utilities usage.

Your system may use several different types of energy. For example, you may consume steam or
compressed air for industrial processes, electricity for lights and computers, water for cooling and
natural gas for heating. WAGESmonitoring collects the usage information from all these different
energy sources to enable a more complete energy analysis.

WAGES information can help you:

• Identify losses or inefficiencies.

• Modify demand to reduce costs.

• Optimize energy source usage.

WAGES monitoring example

The following example showsWAGESmonitoring for a water flow meter.

PowerLogic™ ION9000 series - User manual Inputs/Outputs

7EN02-0390-10 Public 155



Inputs/Outputs PowerLogic™ ION9000 series - User manual

156 Public 7EN02-0390-10

You can connect your meter’s digital input to a transducer that sends a pulse for every 15 kiloliters
(4000 US Gal) of water. After configuring an input metering channel and assigning it to the digital
input, the meter can detect and record the incoming pulses. An energy management system can
then use the information from the meter to performWAGES analysis.

A Water flow meter (15 kL/pulse)

B
Energy meter with digital input 1 assigned to input metering channel 1 and configured with
unit kL (kiloliters)

C Energy management system with WAGES analysis capabilities

Input metering
Your meter’s digital inputs can be used to count pulses from transducers and convert the pulses
to energy measurements.

Your meter’s input metering channels count pulses received from the digital inputs assigned to
that channel. The incoming pulses are used in calculating and measuring consumption data (e.g.,
BTU, kWh, L, kg). Each channel must have the following values configured to match the pulse
data:

• Pulse Weight: the pulses per unit value.

• Unit Code: the unit of measure associated with the monitored value.

• Demand Code: for time-based values (such as kWh), this provides the associated demand
units (kW) for demand calculations; for other values (such as kg), this can be configured to
provide rate information (kg/h or kg/s).

• Mode: whether a pulse is based on a complete pulse or a transition.

For example, if each complete pulse represents 125Wh, you can configure for Wh pulsing as
follows:

• Pulse Weight = pulses/Wh = 1/125 = 0.008

• Unit Code =Wh

• Demand Code = kW (this is automatically set)

• Mode = pulse

If you want to configure for kWh pulsing, you must adjust the pulse weight calculation and unit
code as follows:

• Pulse Weight = pulses/kWh = 1/0.125 = 8

• Unit Code = kWh



Configuring standard input metering using ION Setup

You can configure input metering with standard units and rates using ION Setup.

When configuring your meter, the configuration interface may show all the possible ports,
regardless of what is physically available on your meter.

NOTE: Your device’s digital input must be connected to the input metering pulse source.
Review the digital inputs assigned to applications to help you understand your existing
configuration.

NOTE: To disable an input metering channel and remove any port associations, set Assigned
Input to No connection.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Digital Input Based.

4. Select the input metering channel you want to configure and click Edit. The Input Metering
Channel Setup screen is displayed.

5. Select Enabled to enable the input metering feature.

6. Click Select to define which digital input is the pulse source for the input metering channel.

7. Configure the remaining parameters as required.

8. ClickOK to save your configuration.

9. Configure your meter to log the input metering data if required.

Parameter Description

Pulse Weight Enter the value per pulse.

Units Select the measurement units associated with the pulse.

Demand Period
Enter the frequency in minutes that input metering data is calculated in your
energy management system.

Rate Select the rate associated with the defined Units.

Source ID

Enter a data identifier. This value is added to the input metering channel’s
output register labels to uniquely identify the data within your energy
management system.

NOTE: You must select a Unit for this field to appear.

Configuring custom input metering using ION Setup

You can configure input metering with custom units and rates using ION Setup.

When configuring your meter, the configuration interface may show all the possible ports,
regardless of what is physically available on your meter.
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NOTE: Your device’s digital input must be connected to the input metering pulse source.
Review the digital inputs assigned to applications to help you understand your existing
configuration.

NOTE: To disable an input metering channel and remove any port associations, set Assigned
Input to No connection.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Digital Input Based.

4. Select the input metering channel you want to configure and click Edit. The Input Metering
Channel Setup screen is displayed.

5. Select Enabled to enable the input metering feature.

6. Click Select to define which digital input is the pulse source for the input metering channel.

7. Clear the Standard quantity check box. The screen changes to display custom input
metering parameters.

8. Configure the remaining parameters as required.

9. ClickOK to save your configuration.

10. Configure your meter to log the input metering data if required.

Parameter Description

Pulse Weight Enter the value per pulse.

Units

Select the measurement units associated with the pulse.

Note: Include source identification information by entering “@” followed by
the source identifier.

Demand Period
Enter the frequency in minutes that input metering data is calculated in your
energy management system.

Rate Select the rate associated with the defined Units.

Scaling Select the scaling value based on the relationship between Units and Rate.

Time Base Select the value and units to match the Rate.

Digital outputs
Digital output applications

Digital outputs are typically used in switching applications, for example, to provide on/off control
signals for switching capacitor banks, generators, and other external devices and equipment.

The digital output can also be used in demand synchronization applications, where the meter
provides pulse signals to the input of another meter to control its demand period. The digital
output can also be used in energy pulsing applications, where a receiving device determines
energy usage by counting the kWh pulses coming from the meter’s digital output port.



Configuring onboard digital outputs using ION Setup
To configure the meter’s digital outputs using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. ClickOnboard I/O > Digital Outputs and select a digital output tab. Configure the digital
output by selecting the parameter and clicking Edit. Enter the meter password if prompted.

Parameter Value/range Description

Source Digital/Boolean

Link this input to the value that drives the state of the
digital output.

If Source is not linked, the digital output state is
driven by the Force ON, Force OFF values.

Force ON Pulse
Link this input to a pulse that forces the digital output
on for the PulseWidth duration, regardless of the
Source input.

Force OFF* Pulse
Link this input to a pulse that forces the digital output
off.

Normal* Pulse
Pulsing this input will switch the driver of the digital
output from Force ON to Source.

Polarity Inverting/non-inverting
Specifies if the signal to the digital port is inverted or
not inverted.

PulseWidth 0–2,000,000
Specifies the duration of the pulse, in seconds.
Setting this parameter to 0 sets the digital output
continuously on.

Assigned Port -
The physical digital output port connection. Only
available ports are shown.

State
Open/Closed/Not
Available

Indicates the status of the digital output.

* These parameters are only valid when pulse width is set to 0.

Configuring option module digital outputs using ION Setup
To configure the option module digital outputs using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Select Expansion Modules >Option Modules.

4. Select the module tab that corresponds to the option module with the digital output you want
to configure.
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TIP: The tabs correspond to the slot in which the option module is installed. For more
information, see Option modules.

5. Select the digital output channel and then select Edit.

The setup screen for that digital output is displayed.

6. Configure the digital output by selecting a parameter and then selecting Edit.

After configuring a parameter, selectOK to save the setting to the meter.

Parameter Value/Range Description

Source Digital/Boolean

Link this input to the value that drives the state of the
digital output.

If Source is not linked, the digital output state is
driven by the Force ON, Force OFF values.

Force ON Pulse
Link this input to a pulse that forces the digital output
on for the PulseWidth duration, regardless of the
Source input.

Force OFF* Pulse
Link this input to a pulse that forces the digital output
off.

Normal* Pulse
Pulsing this input will switch the driver of the digital
output from Force ON to Source.

EventLog Mode Log Off/Log On Specifies if events generate log entries.

Polarity
Inverting/non-
inverting

Specifies if the signal to the digital port is inverted or
not inverted.

PulseWidth 0–2,000,000

Specifies the duration of the pulse, in seconds.

Setting this parameter to 0 sets the digital output
continuously on.

Port -
The physical digital output port connection. Only
available ports are shown.

* These parameters are only valid when pulse width is set to 0.

7. Select Send.

Energy pulsing
You can configure the meter’s energy pulsing LEDs or onboard digital outputs for energy pulsing
applications.

When an LED or output is set to energy pulsing, the meter sends a readable pulse or signal based
on the measured energy source value. This pulse can be used for accuracy verification or as an
input to another energy monitoring system.



Default energy pulsing LED sources
Your meter’s energy pulsing LEDs have default energy source values configured for accuracy
verification testing.

For LED locations, see your meter’s installation guide.

Calibration Pulser LED LED Default energy pulsing source

WATT LED
kWh pulse LED

kWh pulse infrared LED
kW del-rec

VAR LED
kVARh pulse LED

kVARh pulse infrared LED
kVAR del-rec

NOTE: The energy pulsing LEDs are configured in pairs. For example, changing the energy
source value will change it for both the regular and infrared LEDs.

NOTE: To modify your default energy source value, go into the advanced mode of ION Setup
and modify the associated Calibration Pulser module. This is an advanced procedure that
should only be performed if you have advanced knowledge of ION and the power system your
meter is connected to.

For more information on the Calibration Pulser module, see ION Reference, available on
www.se.com.

For more information on other LED indicators, see Alarm and status LED indicators.

Configuring LED energy pulsing using ION Setup
You can configure your meter’s energy pulsing LEDs for energy pulsing using ION Setup.

1. Start ION Setup.

2. Open the Setup Assistant for your device.

If prompted, enter your device credentials.

3. Select LED pulsing.

4. Select the tab that corresponds to the energy pulsing LED you want to configure.

5. Configure the following basic parameters for your meter’s energy pulsing LEDs.

Parameter Description

Source Link this input to the value that you want to pulse on the LED.

Enable
Configuring this setting should only be performed by users with advanced
knowledge of ION, the device template and the power system the device is
connected to.

Energy pulsing LED parameters available through ION Setup
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Parameter Description

Int Mode
Specifies the integration mode for the LED (forward, reverse, absolute or
net).

Kt The amount of source energy required to make the LED pulse.

Pulse Width The minimum time in seconds between LED pulse transitions.

Pulser Mode

Select when the energy pulsing LEDs will pulse:

• Always: the energy pulsing LEDs are always pulsing based on their
energy source value.

• Test Only: the energy pulsing LEDs will only pulse when the meter is in
test mode.

Pulse ovrld

Pulsing normally indicates that the energy pulsing LED should be operating
normally.

Pulsing suspended indicates that the energy pulsing LED is not able to pulse
quickly enough. Modify the Kt value to decrease the number of energy pulses
or decrease the pulse width, if supported by the device collecting pulses.

NOTE: To perform specialized configuration go into the advanced mode of ION Setup and
modify, disable or add a new Calibration Pulser module. These are advanced procedures that
should only be performed if you have advanced knowledge of ION and the power system your
meter is connected to.

For more information on the Calibration Pulser module, see ION Reference, available on
www.se.com.

Configuring digital output energy pulsing using ION Setup
You can configure your meter’s onboard digital outputs for energy pulsing using ION Setup.

When configuring your meter, the configuration interface may show all the possible ports,
regardless of what is physically available on your meter.

Ensure that the digital output port is available for energy pulsing and not associated with another
function.

NOTE: For applications where accuracy is important, use the digital output located on the meter
base.

1. Start ION Setup.

2. Open the Setup Assistant for your device.

3. Select Energy pulsing.

4. Select an energy pulsing source tab (such as Wh Del) to configure energy pulsing using
your meter’s digital output.



Parameter Description

Kt
The amount of energy source required to trigger the digital output. For
example, in the Wh Del tab, the Kt value would be amount of real energy
delivered (Wh Del) per pulse.

Pulse Width The minimum time in seconds between pulse transitions.

OutputMode

Select the desired output mode:

• Pulse: the digital output sends a complete pulse when triggered.

• KYZ: the digital output makes a transition (off-to-on, or on-to-off) when
triggered.

Port
Select an output port from the list. Only available output ports are shown
(ports that are not associated with another function).

(energy source)
ovrld

Pulsing normally indicates that the output port should be operating normally.

Pulsing suspended indicates that the output port is not able to pulse quickly
enough. Modify the Kt value to decrease the number of energy pulses.

Digital output energy pulsing parameters available through ION Setup

NOTE: To perform specialized configuration go into the advanced mode of ION Setup and
modify or add a new Calibration Pulser module. This is an advanced procedure that should only
be performed if you have advanced knowledge of ION and the power system your meter is
connected to.

For more information, see ION Reference, available on www.se.com.

Calculate your maximum kWh/pulse (pulse weight) value
To calculate the kWh/pulse (pulse weight) value, divide the highest kW value you can expect by
the required pulse rate.

Make sure the required pulse rate does not exceed the maximum pulse rate for the digital output.

NOTE: To convert from kWh/pulse to pulse/kWh you must invert (take the reciprocal) of the
value. For example, 1.8 kWh/pulse becomes 0.556 pulse/kWh.

Example pulse weight calculation

For a maximum load of 1600 kW and a pulse rate of two pulses per second, calculate the
kWh/pulse value as follows:

1. Convert 1600 kW load into kWh/second:

(1600 kW)*(1hr) = 1600 kWh

(1600 kWh)/(3600 sec) = (X kWh)/(1sec)

X = 0.444 kWh/sec
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2. Calculate the kWh required per pulse:

(0.444 kWh/sec)/(2 pulses per second) = 0.222 kWh/pulse

3. If using KYZ Output Mode, adjust for the KY giving one pulse per two transitions if
necessary.

(0.222 kWh/pulse)/(2) = 0.111 kWh/pulse

For more information on the Calibration Pulser module, see ION Reference, available on
www.se.com.



Webpages
Webpage interface

Your meter comes with default webpages that contain typical elements.

A Meter type and model, device name

B Username

C Main menu

D Webpage menu

E Webpage content

NOTE: This graphic is representative only. Your meter’s webpages may appear differently than
shown.

Default meter webpages
The following table lists the available webpages and their content.

Webpage Content

Instantaneous Readings

• Basic Readings

• Energy Readings

• Demand Readings

• Voltage Readings

• Power Quality

Trending & Forecasting
Select the target and interval for trending and forecasting and view
the results.

Monitoring
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Webpage Content

Power Quality Summary

• Harmonics Chart

• ITI (CBEMA)-SEMI

• NEMAMotor Derating Curve

• EN50160

• IEEE 519 Harmonics

• HSTC (ION9000T only)

Inputs/Outputs

• Digital Inputs

• Digital Outputs

• Analog Inputs

• Analog Outputs

Waveforms
View waveforms from your meter, using the meter’s COMTRADE
files.

Webpage Content

Resets Perform resets, and view when previous resets were performed.

Control

Webpage Content

Statistics

• Communications

• Ethernet

• Serial Port

• Meter - Basic

• Meter - Advanced

Phasor Diagram View the phasor diagram and numeric values.

Diagnostics

Webpage Content

Ethernet
• Basic Settings

• Advanced Settings

Serial Port
• Basic Settings

• Advanced Settings

SNMP Parameters Configure your meter’s SNMP parameters.

NTP Configure your meter’s NTP parameters.

Setup



Webpage Content

SMTP Configure your meter’s SMTP parameters.

Date & Time Configure your meter’s time and time synchronization.

Preferences Enter your meter’s nameplate information.

Metering
• Basic Settings

• Advanced Settings

HTTPS Certificate Management.

Webpage Content

-

Custom. No default content.

By default, the Maintenance menu is empty and the menu is not
displayed until information is added to it.

Maintenance

Accessing webpages for data viewing and meter configuration
You can access the meter’s webpages through the meter’s Ethernet connection using a web
browser.

You must have cookies enabled to access your meter’s webpages.

You may need to configure your meter’s security settings to view webpages and configure your
meter using webpages.

On a hardware-locked meter, you cannot add, delete, or modify any webpage files.

If you are connected to your device over Ethernet, changing Ethernet configuration parameters
without another method of configuration enabled may cause loss of communications with your
device and render it inaccessible.

NOTICE
LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

1. Open a web browser and enter your meter’s IP address in the address bar. The webpage
login prompt is displayed.

If the browser cannot connect to the webserver, check the web protocol setting.

2. Enter a valid username and password.

PowerLogic™ ION9000 series - User manual Webpages

7EN02-0390-10 Public 167



Webpages PowerLogic™ ION9000 series - User manual

168 Public 7EN02-0390-10

3. Select your desired Language from the drop-down list box, and click Log In.

Your meter’s webpages are displayed. The default page is theMonitoring webpage,
showing real-time data.

4. Select the main menu tab that corresponds to the category of information you want to view
and select the webpage menu from the list.

The webpage content is displayed.

5. Click the webpage content headings to expand and view the meter’s data.

6. Select Setup to view and edit your meter’s configuration.

Embedding images and files in meter webpages
Upload images, documents, audio and video files to meter webpages using SFTP.

NOTE: Images cannot be scaled after they are uploaded. Format images to the desired size
before uploading.

1. Access your meter’s internal SFTP site.

2. Open theweb folder. Copy your file into the subfolder that corresponds to the webpage
main menu tab you want to access your file from.

3. Connect to your meter’s webpages. Select the main menu item that corresponds to the
folder you previously selected. Your file is listed in the webpage menu.

4. Select your file from the webpage menu to view it.

Creating custom webpages
Create custom webpages to view data or access configuration parameters from your meter.

Download the meter’s Modbus registers map from www.se.com.

1. Open SFTP client software.

2. Go toweb > examples. Select samplereadings.html to create a data value webpage or
select sampleconfiguration.html to create a configuration parameters webpage.

3. Save a copy of the sample file. This filename is the webpage name.

4. Open your webpage in an HTML or webpage editor program.

5. Modify the webpage to reference the desired meter data or parameters from the Modbus
registers map, and update the other fields where required.

6. Save your custom webpage.

The meter will display translated content if it exists in the meter’s memory. If translated
content is not available, English is displayed.

7. Connect to your meter’s internal SFTP site.

If you have created a data viewing webpage, copy your custom webpage toweb >
monitoring.



If you have created a configuration webpage, copy your custom webpage toweb >
setup.

8. Login to your meter’s webpages.

Your custom webpage is available from the webpage menu under theMonitoring (data viewing)
or Setup (configuration) tab.

Watch the video on how to create custom webpages: How to Create CustomWebpages for Your
Meter

Deleting custom webpages
1. Open the SFTP client software.

2. Connect to the meter using the meter’s IP address and SFTP port number. See Protocols,
ports, and connections for information on port numbers.

3. Open the web folder in SFTP file directory and delete all files in subfolders.

4. Close the SFTP client software.

Loading webpages using ION Setup
Prerequisites:

• Webpage files in the upgrade .zip folder. Go to www.se.com to download upgrade files.

• Meter connection using SFTP client application.

To load webpages using ION Setup: 

1. Obtain the webpage upgrade files (.zip folder) that you want to upload onto your meter. Save
the files where they can be accessed by the computer running ION Setup.

2. Start ION Setup.

3. Open the Setup Assistant for your meter.

4. Click Template >Web.

NOTE: You can preview meter webpages using the Test Web Viewing feature. Select
an IP addressing method from the drop-down list box to generate a test link using your
default web browser.

5. Click Upload to navigate to the folder (.zip) containing the meter upgrade files. Select the
folder and clickOpen.

6. An ION Setup dialog box will open. Click Yes to confirm uploading of the webpage files.

NOTE: The upload process replaces files with matching filenames only.

Confirmation of uploaded files is displayed in the bottom status bar.

Loading webpages using SFTP
You can upgrade your meter’s webpages using your meter’s internal SFTP site.
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Prerequisites:

• Your meter’s webpage upgrade files. Go to www.se.com to download upgrade files.

• Access to your meter’s internal SFTP site.

To load webpages using SFTP:

1. Connect to your meter’s internal SFTP site and open theweb folder.

2. Navigate to the location on your local machine where you saved the webpage .zip file.

NOTE: Extract the contents of the upgrade file.

3. Drag the resources and examples folders into theweb folder. Confirm to overwrite existing
files when prompted.

The files are transferred to the meter.

Sample data viewing webpage
You can create custom data viewing webpages using the sample webpage stored on your meter.

The sample webpages are stored in the documents folder on your meter’s internal SFTP site.

Your meter’s Modbus register map is available from www.se.com.

If required, your meter’s ION handles document is packaged with the meter firmware file which is
available for download from www.se.com.

The data viewing webpage must be stored on your meter’s internal SFTP site in the
web/monitoring folder. The custom webpage is viewed by selecting theMonitoringmain menu
tab on your meter’s webpage.

Configuring the HTML code other than where described is an advanced procedure and should
only be performed by those with an advanced understanding of webpages and how your meter
processes them.

Sample webpage data viewing result

NOTE: The following graphic is representative only. Your meter’s webpages may appear
different than shown.

A HTML filename

B Content pane title



C Row heading

D Units

E Column heading

F Named register instantaneous value

G Second content pane A title
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Sample HTML code for data viewing webpage content
Content and formatting of a data viewing webpage is controlled by its HTML code.

Sample data viewing webpage content

1 SampleMonitorPane.html
2 <div class="content-fit">
3 <div class="accordion">
4 <h3 target="sample-readings">$%localizedString(Basic Readings)#$</h3>
5 <div id="sample-readings">
6 <table class="datatable">
7 <tr>
8 <th>&nbsp;</th>
9 <th>$%localizedString(Minimum)#$</th>

10 <th>$%localizedString(Present)#$</th>
11 <th>$%localizedString(Maximum)#$</th>
12 </tr>
13 <tr class="minor">
14 <td>$%localizedString(I a)#$ <span unitsreg="I a"></span></td>
15 <td regname="I a mn"></td>
16 <td regname="I a"></td>
17 <td regname="I a mx"></td>
18 </tr>
19 <tr class="minor">
20 <td>$%localizedString(I b)#$ <span unitsreg="I b"></span></td>
21 <td regname="I b mn"></td>
22 <td regname="I b"></td>
23 <td regname="I b mx"></td>
24 </tr>
25 </table>
26 </div>
27 <h3 target="sample-energy">$%localizedString(Energy Readings)#$</h3>
28 <div id="sample-energy">
29 <table class="datatable">
30 <tr>
31 <th>&nbsp;</th>
32 <th>$%localizedString(Present)#$</th>
33 </tr>
34 <tr>
35 <td>$%localizedString(Active Energy)#$ <span unitsreg="kWh del-rec"></span></td>
36 <td regname="kWh del-rec"></td>
37 </tr>
38 <tr>
39 <td>$%localizedString(Reactive Energy)#$ <span unitsreg="kVARh del-rec"></span></td>
40 <td regname="kVARh del-rec"></td>
41 </tr>
42 </table>
43 </div>
44 </div>
45
46
47 <script type="text/javascript">
48
49 instantaneousReadings.initInstantaneousReadings('sample-readings');
50
51 </script>
52 </div>



Line # Description

1

SampleMonitorPane.html 

The HTML filename, including the HTML extension (.html). This filename must comply with SFTP
filename requirements (no spaces or special characters). The filename (without the HTML extension) is
the name shown on the webpage menu.

4

<h3 target="sample-readings">

This creates the first webpage content pane. “sample-readings” is the name of the webpage content.
This name must be unique.

$%localizedString(Basic Readings)#$</h3>

Basic Readings is the title of the webpage content pane. This title is translated if possible.

5
<div id="sample-readings">

This must match the name of the webpage content in line 4.

9
<th>$%localizedString(Minimum)#$</th>

Minimum is the heading for the first column. This heading is translated if possible.

10
<th>$%localizedString(Present)#$</th>

Present is the heading for the second column. This heading is translated if possible.

11
<th>$%localizedString(Maximum)#$</th>

Maximum is the heading for the last column. This heading is translated if possible.

14

<td>$%localizedString(I a)#$ 

I a is the row heading. This heading is translated if possible.

<span unitsreg="I a"></span></td>

This displays the units that the meter has defined for the named register I a.

15
<td regname="I a mn"></td>

This displays the instantaneous value of the named register I a mn.

16
<td regname="I a"></td>

This displays the instantaneous value of the named register I a.

17
<td regname="I a mx"></td>

This displays the instantaneous value of the named register I a mx.

Sample webpage data viewing content description
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Line # Description

20

<td>$%localizedString(I b)#$ 

I b is the second row heading. This heading is translated if possible.

<span unitsreg="I b"></span></td>

This displays the units that the meter has defined for the named register I b.

21
<td regname="I b mn"></td>

This displays the instantaneous value of the named register I b mn.

22
<td regname="I b"></td>

This displays the instantaneous value of the named register I b.

23
<td regname="I b mx"></td>

This displays the instantaneous value of the named register I bmx.

27

<h3 target="sample-energy">

This creates the second webpage content pane. Sample-energy is the name of the webpage content.
This name must be unique.

$%localizedString(Energy Readings)#$</h3>

Energy Readings is the title of the webpage content pane. This title is translated if possible.

28
<div id="sample-energy">

This must match the name of the webpage content in line 27.

32
<th>$%localizedString(Present)#$</th>

Present is the heading for the last column. This heading is translated if possible.

35

<td>$%localizedString(Active Energy)#$ 

Active Energy is the row heading. This heading is translated if possible.

<span unitsreg="kWh del-rec"></span></td>

This displays the units that the meter has defined for the named register kWh del-rec.

36
<td regname="kWh del-rec"></td>

This displays the instantaneous value of the named register kWh del-rec.1

39

<td>$%localizedString(Reactive Energy)#$ 

Reactive Energy is the row heading. This heading is translated if possible.

<span unitsreg="kVARh del-rec"></span></td>

This displays the units that the meter has defined for the named register kVARh del-rec.



Line # Description

40
<td regname="kVARh del-rec"></td>

This displays the instantaneous value of the named register kVARh del-rec.1

49

instantaneousReadings.initInstantaneousReadings('sample-readings');

Sample-readings is the unique name of the first webpage content name. This HTML code updates all the
webpage’s values.

1 Named registers are listed in the Modbus registers map. You can also reference a value by its ION handle using the
following format: <td regname=”_0x####”></td>.

Sample setup webpage
You can create custom setup webpages using the sample webpage stored on your meter.

Sample webpages are stored in the documents folder on your meter’s internal SFTP site.

Your meter’s Modbus register map is available from www.se.com.

If required, your meter’s ION handles document is packaged with the meter firmware file which is
available for download from www.se.com.

Custom setup webpages must be stored on your meter’s internal SFTP site in theweb/setup
folder. The custom webpage is viewed by selecting the Setupmain menu tab on your meter’s
webpage.

Configuring the HTML code other than where described is an advanced procedure and should
only be performed by those with an advanced understanding of webpages and how your meter
processes them.

Sample webpage setup result

NOTE: The following graphic is representative only. Your meter’s webpages may appear
different than shown.

A HTML filename

B Content pane title

C Sub-heading

D Row heading
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E Named register value

F Second content pane title



Sample HTML code for setup webpage content
Content and formatting of a setup webpage is controlled by its HTML code.

Sample setup webpage content

1 SampleSetupPane.html
2
3 <div class="content-fit">
4 <form id="formSampleSettings">
5
6 <div class="accordion">
7 <h3 target="sample-basic">$%localizedString(Basic Settings)#$</h3>
8 <div id="sample-basic">
9 <table class="formtable">

10 <tr>
11 <th>&nbsp;</th>
12 <th>&nbsp;</th>
13 </tr>
14 <tr>
15 <td>$%localizedString(Ethernet)#$</td>
16 <td>&nbsp;</td>
17 </tr>
18 <tr class="minor">
19 <td>$%localizedString(MAC Address)#$</td>
20 <td regname="MAC Address"></td>
21 </tr>
22 <tr class="minor">
23 <td>$%localizedString(Ethernet Device Name)#$</td>
24 <td><input name="Ethernet Device Name" type="text" /></td>
25 </tr>
26 <tr class="minor">
27 <td>$%localizedString(IP Address)#$</td>
28 <td><input name="IP Address" type="text" /></td>
29 </tr>
30 </table>
31
32 </div>
33
34 <h3 target="sample-advanced">$%localizedString(Advanced Settings)#$</h3>
35 <div id="sample-advanced">
36 <table class="formtable" id="frameFormatDropdownContainer">
37 <tr>
38 <th>&nbsp;</th>
39 <th>&nbsp;</th>
40 </tr>
41 <tr>
42 <td>$%localizedString(TCP Keep Alive Minutes)#$</td>
43 <td><input type="text" name="TCP Keep Alive Minutes" class="small" /> <span unitsreg="TCP Keep

Alive Minutes"></span></td>
44 </tr>
45 <tr>
46 <td>$%localizedString(Enable Web Server)#$</td>
47 <td><select name="Enable Web Server"></select> </td>
48 </tr>
49 </table>
50
51 </div>
52 </div>
53
54 <input type="submit" class="apply" value='$%localizedString(Apply)#$' />
55
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56 </form>
57
58
59 <script type="text/javascript">
60
61 SetupPane.init('formSampleSettings');
62 formChangeDetection.initFormChangeDetection('#formSampleSettings', '#dialogFormChanges');
63
64 </script>
65 </div>

Line # Description

1

SampleSetupPane.html

The HTML filename, including the HTML extension (.html). This filename must comply with SFTP
filename requirements (no spaces or special characters). The filename (without the HTML extension) is
the name shown on the webpage menu.

4
<form id="formSampleSettings">

“formSampleSettings” is the name of the webpage content. This name must be unique

7

<h3 target="sample-basic">

This creates the first webpage content pane. “sample-basic” is the name of the webpage content. This
name must be unique.

$%localizedString(Basic Settings)#$</h3>

Basic Settings is the title of the webpage content pane. This title is translated if possible.

8
<div id="sample-basic">

This must match the name of the webpage content in line 7.

15
<td>$%localizedString(Ethernet)#$</td>

Ethernet is the subheading. This heading is translated if possible.

19
<td>$%localizedString(MAC Address)#$</td>

MAC Address is the row heading. This heading is translated if possible.

20
<td regname="MAC Address"></td>

This displays the value of the read-only named register MAC Address.

23
<td>$%localizedString(Ethernet Device Name)#$</td>

Ethernet Device Name is the row heading. This heading is translated if possible.

Sample setup webpage content description



Line # Description

24

<td><input name="Ethernet Device Name" type="text" /></td>

This displays the instantaneous value of the configurable named register Ethernet Device Name in a
text-edit field.

The type must match the named register type, in this case, an alphanumeric string.

27
<td>$%localizedString(IP Address)#$</td>

IP Address is the row heading. This heading is translated if possible.

28

<td><input name="IP Address" type="text" /></td>

This displays the instantaneous value of the configurable named register IP Address in a text-edit field.

The type must match the named register type, in this case, an alphanumeric string.

34

<h3 target="sample-advanced">

This creates the second webpage content pane. Sample-advanced is the name of the webpage content.
This name must be unique.

$%localizedString(Advanced Settings)#$</h3>

Advanced Settings is the title of the webpage content pane. This title is translated if possible.

35
<div id="sample-advanced">

This must match the name of the webpage content in line 34.

42
<td>$%localizedString(TCP Keep Alive Minutes)#$</td>

TCP Keep Alive Minutes is the row heading. This heading is translated if possible.

43

<td><input type="text" name="TCP Keep Alive Minutes" class="small" /> 

This displays the instantaneous value of the configurable named register TCP Keep Alive Minutes in a
text-edit field.

The type must match the named register type, in this case, an alphanumeric string.

<span unitsreg="TCP Keep Alive Minutes"></span></td>

This displays the units that the meter has defined for the named register TCP Keep Alive Minutes.

NOTE: There are no defined units for TCP Keep Alive Minutes, so no units are displayed.

46
<td>$%localizedString(Enable Web Server)#$</td>

Enable Web Server is the row heading. This heading is translated if possible.

47

<td><select name="Enable Web Server"></select> </td>

Enable Web Server is the named register that is displayed. Named registers are listed in the meter’s
registers map.

The type must match the named register type, in this case, an enumerated value that is displayed as a
drop-down list box.
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Line # Description

61
SetupPane.init('formSampleSettings');

This must match the webpage content name from line 4.

62

formChangeDetection.initFormChangeDetection('#formSampleSettings',

'#dialogFormChanges');

This must match the webpage content name from line 4. This HTML code updates all the webpage’s
values.



Display
Display overview

The display allows you to view meter data and perform basic configuration.

NOTE: The display backlight dims after a defined period of inactivity. When the meter detects
an unacknowledged active high priority alarm, the display flashes until the alarm is
acknowledged.

Display

A Display port K Home button

B
Optional 24 V DC AUX power input (label
not pictured)

L Power/status LED, green or red

C Date and time M Alarm LED, red

D Mode indicator N VAR visible energy pulsing LED, orange

E Revenue lock icon O VAR infrared energy pulsing LED, 940 nm

F Alarm icon P Watt visible energy pulsing LED, orange

G Touch-screen display Q Watt infrared energy pulsing LED, 940 nm

H USB ports cover R ANSI optical port

I USB host port (Type A) S IEC optical port adapter (optional)

J USB device port (Mini-B)

Mode indicator
The display mode indicator identifies whether the meter is in normal (NORM), alternate display
(ALT), or test (TEST) mode.
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Home button
Press the Home button to access display menus or return to the active menu.

Press the Home button twice to access the last data screen displayed or the Summary screen, if
in ALT mode.

The function of the home button varies:

• NORMmode: Displays Energy and Demand screens.

• ALT mode: Displays ALT mode display and setup menus. Select Normal Display Mode from
the ALT display menu to exit the ALT display mode.

• TEST mode: Displays Test mode and Setup menus.

• Setup Menu: Displays active menu item.

Revenue lock icon
The revenue lock icon indicates the lock status of the meter.

When gray and open, the meter is unlocked. When green and closed, the meter is locked. You
can lock and unlock your meter using the revenue lock switch located on the body of your meter.

Alarm icon
The alarm icon indicates the highest level and state of alarms detected by your meter.

For example, if the meter detects a low priority and a high priority active alarm, the alarm icon
indicates a high priority active alarm.

NOTE: Alarms can only be viewed and acknowledged through the display.

Icon Description

Active alarm indicator:

• Red: high priority alarm state detected

• Yellow: medium priority alarm state detected

• Blue: low priority alarm state detected

The alarm indicator flashes until you acknowledge the alarm.

The alarm indicator changes to the historic alarm indicator of the appropriate
level when the alarm state is no longer detected by the meter.

NOTE: The display backlight flashes for unacknowledged high priority
active alarms.



Icon Description

Unacknowledged historic alarm indicator:

• Red: unacknowledged high priority historic alarm

• Yellow: unacknowledged medium priority historic alarm

NOTE: Low priority historical alarms are not indicated.

The active alarm indicator changes to the historic alarm indicator of the
appropriate level when the alarm state is no longer detected by the meter.

Gray: no active or unacknowledged high or medium priority historic alarms

Alarm and status LED indicators
Your meter has alarm and status LEDs.

These LEDs cannot be configured for other uses.

LED Description

Status

Off: unpowered

Steady green: normal operation

Flashing red: no communications (remote display only)

Steady red: firmware upgrade required (remote display only)

Flashing red/green: startup or firmware upgrade sequence in progress

Alarm

Off: no active or unacknowledged historic alarms

On: acknowledged active alarm

Flashing: active alarm

NOTE: The display backlight flashes for unacknowledged high priority
active alarms.

Display icons
Icons are displayed on the bottom of the screen.

NOTE: If the icon is gray, the function is not available.

Icon Description

TapMore to access additional screens.

Tap Left arrow to select item to the left or to return to the previous screen.

Tap Right arrow to select item to the right.

Tap Up to navigate menu items or screens.
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Icon Description

Tap Down to navigate menu items or screens.

Tap Select to confirm selection or change.

Tap Cancel to exit and return to previous screen.

TapGraphic to view graphical representation of data.

Tap Numeric to view numerical representation of data.

Tap Info to display screen details.

Tap Edit to enter parameter values or select setting.

Tap Check Box to perform an action.

Tap double-arrow to select parameter.

More screens access
You can access additional screens.

Pressing the More icon opens a list of additional screens related to the active screen. Press
Cancel to close the list. If you do not select a screen, you are returned to the last data screen
displayed.

Overrange indication
If any value measured by the meter is too large to fit on the display, the meter initially reduces the
size of the text to try and make the value fit.

If the value is still too large to be displayed, the meter truncates the value starting with the least
significant digit and encloses the truncated value in a red box.

Interrupted display data
The meter updates the display data every second during normal operation.

If the display detects a data interruption, the following occurs:

• Date/time information is cleared.

• Display mode indicator is set to normal (NORM) mode.

• Revenue lock icon indicates a locked state (green and closed).

• Alarm icon indicates an unacknowledged high priority historic alarm (red outline bell).

• All parameter labels and associated parameter data are cleared.

Display screen title bar and display icons are retained.



Auto-scaling feature
Measurement units on the meter display and webpages automatically scale, depending on the
value of PT Primary and CT Primary.

Voltage units are scaled based on the PT Primary value:

PT Primary value Units or scaling

< 1000 V

1000–999,999 kV

Current units are scaled based on the CT Primary value:

CT Primary value Units or scaling

< 1000 A

1000–999,999 kA

Power units are scaled according to the value of (CT Primary x PT Primary x 3):

(CT Primary x PT Primary x 3) value Units or scaling

< 1,000,000 kW, kVAR or kVA

1,000,000–999,999,999 MW, MVAR or MVA

≥ 1,000,000,000 GW, GVAR or GVA

Display screens
Display modes

Your meter has three display modes and provides access to your meter’s setup screens:

• Normal Mode Screens (NORM) – In Norm mode, your meter automatically scrolls through a
series of customizable display screens. You can add or remove Norm mode display screens.
If there are no Norm mode display screens, the meter displays a message stating that there
are no available screens. To exit Norm mode, press the home button to access the display
modes selection screen.

• Alt Display Mode (ALT) – In Alt mode, you can navigate to view the different alternate
screens. You cannot modify the default Alt mode display screens, but you can add custom
screens. To exit Alt display mode, select Normal Display Mode to access the display modes
selection screen.

• Test Mode (TEST) – In Test mode, you can manually scroll through a series of default
screens. To exit Test mode, press the home button and select Exit Test Mode.

NOTE: In Test mode, your meter’s billing quantities stop accumulating and the data is sent
to special test mode registers. These registers are cleared when you exit Test mode.

Access your meter’s setup screens by pressing the home button in NORM, ALT or TEST mode.
To exit the setup screens, press the home button.
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Norm mode display menu
The Norm mode display screens show measured and calculated information about the power
system being monitored.

NOTE: Your meter’s menus may appear slightly different than shown depending on your
display settings.

Alt mode display menu
The alt mode display menu allows you to view data screens and access the setup menu.

Alt mode data display screens
Your meter’s default display screens show measured and calculated information about the power
system being monitored.

NOTE: Minimum, maximum (peak), average and time of use (TOU) values are typically
accessed by pressing More to open a list of additional screens.

Menu Submenu Content

Summary Summary Power system summary

Alarms Active alarms, Active alarms can be viewed and acknowledged.

Historical alarms Historical alarms can be viewed and acknowledged.

Basic readings Voltage • Power system voltage (line-to-line or line-to-neutral),
current and frequency values.

• Average, minimum, and maximum values are also
provided.

Current

Frequency

Power Power summary Per-phase and total kW, kVAR and kVA values, along with
minimum and maximum values.

Demand Delivered and received demand values including peak
demand.

Power factor Per-phase and total power factor along with minimum and
maximum values.



Menu Submenu Content

Energy Energy Energy delivered-received, delivered and received.

Events Events Meter event log entries listing and details.

Power quality EN50160 EN50160 values.

Harmonics Voltage and current harmonics, with individual and total
harmonic values.

Phasors Phasor diagram with magnitude and angle values.

Inputs/outputs Digital inputs Digital and analog I/O values and counts.

Digital outputs

Analog inputs

Analog outputs

Nameplate Nameplate • Owner and tag information, meter model, and serial
number.

• Meter feature set, firmware version, and firmware
CRC.

• RMD serial number and firmware version.

• Meter volts mode, meter nominals (voltage, current,
and frequency), and PT/CT ratio.

• Demand configuration values.

• Regulation tag.

Custom
screens

— Custom screens

Setup Menu — Access to the setup menu screens.

Setup menu
Meter configuration can be performed through the display.

Configure your meter’s security settings to allow front panel (display) programming to set up the
meter using the display.

NOTE: Your display may appear differently than shown, depending on your meter’s power
system, configuration, and display settings.

NOTE: Some setup parameters cannot be configured when revenue security is enabled.
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Menu Submenu

Meter Setup Volts Mode

PT/CT Setup

Voltage Polarity Setup

Current Polarity Setup

Nominal Values

Ethernet Port Enable Setup Ethernet Port Enable Setup

Communications Setup IPv4 Assignment Mode Setup

Stored IPv4 Address Setup

IPv6 Link Local Address

IPv6 Assignment Mode Setup

Stored IPv6 Global Address

Ethernet Device Name

DNS Setup

COM1 Setup

COM4 Setup

NTP Address

SMTP Address

Display Setup Screen Setup

Label & Symbol Setup

Numeric Format Setup

Date/Time/Clock Setup Date & Time Setup

Clock Setup

Alarm Setup Alarm Setup

Language Setup Language Setup

Time of Use Setup TOU Active Rates

TOU Season

Resets Resets

Meter setup using your display
Navigate to Setup screens and enter parameters to configure your meter.

Your meter’s default display password is 0 (zero).

NOTE: Your meter locks you out of display configuration after you have exceeded the
maximum number of attempts to enter a password.

The following example shows how to use the navigation icons to select parameters, enter numeric
information or select parameter values from lists.



NOTE: Your display may appear differently than those shown, depending on your meter’s
power system and display and localization settings.

Example: Setting volts mode and PT/CT ratios

Use the display navigation icons to set your meter’s volts mode and PT ratios.

NOTE: Potential transformers (PT) are also known as voltage transformers (VT).

1. Press to display the menu. Press until Setup Menu is highlighted. Press to display
the Setup Menu. The Setup Menu lists the setup selections on your meter.

2. Press or to highlight the different setup menu selections. HighlightMeter Setup and

press to select the meter setup screens. The Volts Mode setup screen is displayed.

3. Press to highlight Volts Mode. Press to edit the volts mode. The Enter Password
screen is displayed.

4. Press to change the value of the highlighted digit (0 - 9). Press to go to the next digit.

Press to enter your password using the onscreen keyboard. The Volts Mode
configuration screen is displayed.
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5. Press or to highlight the desired volts mode from the list, in this case, 3W-WYE.

Press to select the highlighted volts mode. A confirmation screen is displayed, showing
your meter’s previous setting and newly selected setting.

6. Press to confirm, and the new setting is applied to your meter. Press to cancel and
maintain your meter’s original setting.

7. In the Volts Mode screen, press to go to the PT/CT Setup screen.

8. In the PT/CT Setup screen, press to highlight the potential transformer (PT) or

current transformer (CT) value for editing. Press to edit the highlighted value.

NOTE: If you have exceeded the password timeout period, you are prompted to enter
your meter’s display password.

9. Press to change the value of the highlighted digit (0 - 9). Press to go to the next digit.

Press to enter the new value. When the confirmation screen is displayed, press to

confirm the new value or to revert to the original value.

Display setup
You can configure basic display parameters using the display.



Screen setup

Parameter Values Description

Backlight
Timeout

0–7200
Specifies how many seconds the display’s backlight
remains lit after the last button press

Label and symbol setup

Parameter Values Description

Phase Lbls ABC, 123 Sets the voltage and current phase labels

Measurement
Symbols

IEEE, IEC
Specifies whether IEEE or IEC measurement
symbols are applied to displayed values

PF Convention IEEE, IEC
Specifies whether IEEE or IEC power factor
conventions are applied to displayed values

Numeric format setup

Parameter Values Description

Digit Grouping 1000.0, 1,000.0, 1 000,0 Specifies how digits are grouped for display

Volts
Resolution

1., 1.X, 1.XX, 1.XXX,
1.XXXX

Specifies the number of decimal places displayed
for voltages

Current
Resolution

1., 1.X, 1.XX,1.XXX,
1.XXXX

Specifies the number of decimal places displayed
for currents

Power
Resolution

1., 1.X, 1.XX, 1.XXX,
1.XXXX

Specifies the number of decimal places displayed
for power and energy measurements

Language setup
Set your meter display to one of the following languages:

• English (default)

• Spanish

• French

• Russian

• German

• Italian

• Portuguese

• Chinese (simplified)

Creating custom displays using ION Setup
Use ION Setup to create new custom displays.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
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3. Click Displays > Front Panel.

4. Select Displays and click Edit.

ION Setup loads your meter’s display information into the Display Editor screen.

5. Select the display mode of the custom screens from the drop-down list box, and rename,
delete, or change the order of custom displays.

a. Click New to add a new display screen in the selected display mode.

b. Click Edit to open the Display setup screen, where you can configure new or existing
custom displays.

6. Configure your screen.

Screen Type: Specify the number of parameters displayed on the screen.

Screen Title: Enter the title to be shown at the top of your custom display.

7. Click Edit to select the displayed parameters.

The number of parameters displayed is determined in the Screen Type selection described
above.

8. Select your digit display properties.

Resolution: Specifies the number of decimal places displayed.

Last Digit: Specifies if the last digit is rounded or truncated.

9. Click Send to save the changes in the meter.

Display units scaling
You can customize the units for metered values shown on the display and webpages.

You can configure the units for voltage, current, power and energy values shown on the display
and webpages from their default units, and you can set the resolution for the display. To identify
which values will have the modified units, refer to the display and web units information in your
meter’s Modbus map, available from www.se.com.

Configuring display units scaling using ION Setup
You can customize the units for metered values shown on the display and webpages using ION
Setup.

Configuring display units scaling is an advanced procedure that requires in-depth knowledge of
your meter, its underlying architecture, and the system in which it is installed.

To identify which values will have the modified units, refer to the display and web units information
in your meter’s Modbus map, available from www.se.com.

NOTE: Custom units and resolution settings are automatically adjusted for current and voltage
values to help prevent the display from showing incorrect zero values.

1. Start ION Setup.

2. Connect to your meter in advanced mode.

3. Navigate to the Display Options Modules folder and double-click on the module in the right-
hand pane.



The Display Options screen is displayed.

4. Select the Setup Registers tab.

5. Select the display units you want to configure: Voltage Units, Current Units, Power Units or
Energy Units. Click Edit.

A unit selection screen is displayed.

6. Select the desired units from the drop-down list, and then clickOK.

7. When you have finished configuring the display units, click Send to send your changes to
the meter and close the Display Options screen.

For more information on the Display Options module and your meter’s ION architecture, see ION
Reference, available on www.se.com.

Remote display troubleshooting icons
The remote display shows troubleshooting icons in addition to the meter’s status LED information.

Icon Description

The display is connecting to your meter.

The display cannot communicate to your meter. Check the connection
between your meter and the display. Check the meter’s status LED to
confirm that the meter is operating normally.

The display needs updated firmware for compatibility with your meter.

The display is downloading a firmware upgrade. Do not disconnect the
display from your meter.

The display is undergoing a firmware upgrade. Do not disconnect the
display from your meter.
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Alarms and alerts
Alarms

An alarm is the meter’s means of notifying you when an alarm condition is detected, such as an
error or an event that falls outside of normal operating conditions. Alarms are typically setpoint-
driven and can be programmed to monitor certain behaviors, events, or unwanted conditions in
your electrical system.

You can configure your meter to generate and display high, medium, and low priority alarms when
predefined events are detected in the meter’s measured values or operating states. Your meter
also logs the alarm event information.

The meter ships with some alarms already enabled from the factory. Other alarms need to be
configured before the meter can generate alarms.

Customize meter alarms as required, such as changing the priority. You can also create custom
alarms using the advanced features of your meter.

Alarm types
Your meter has five types of alarms:

Alarm type Description

Setpoint
(standard)

Setpoint alarms compare the actual value of a parameter to a specified limit
or range of values. These include measured voltage and current values and
calculated power quality values.

Some setpoint alarms use high-speed measurements for up to 1 millisecond
resolution.

Digital Digital alarms are triggered on a digital input’s on/off state.

Disturbance
(sag/swell)

Disturbance alarms are triggered on a measured sag or swell.

Transient Transient alarms are triggered on a measured transient event.

Unary
Unary alarms are not configurable and generate an alarm based on the
meter’s state, for example, the meter powering up.

Alarms have two states:

Alarm state Description

Active The meter detects the alarm condition is met.

Historical
The alarm condition previously existed but the condition has since returned
to a non-alarm state.

For more information on Setpoint, Relative Setpoint, Digital Input, Disturbance Analyzer,
Transient, High-Speed Transient (ION9000T only), and Sag/Swell modules, see ION Reference,
available on www.se.com.



Standard and high-speed alarms
Alarm speed is determined by the update rate of the framework for the particular alarm.

Standard alarm

Standard alarms have a detection rate of once every one second.

High-speed alarm

High-speed alarms have a detection rate of once every half-cycle.

3-phase alarms

Alarms on 3-phase systems are evaluated per phase and reported for each phase.

Some alarms, such as the sag/swell alarm, are evaluated per phase, but reported as a single
alarm: Each of the three phases are evaluated for the setpoint condition individually, but there is
only one alarm generated. The alarm pickup occurs when the first phase exceeds the alarm
pickup magnitude for the pickup time delay. The alarm is active as long as any phase remains in
an alarm state. The alarm dropout occurs when the last phase drops below the dropout
magnitude for the dropout time delay.

Over and under setpoint (standard) alarm operation - Example

The meter supports over and under setpoint conditions on standard alarms.

A setpoint condition occurs when the magnitude of the signal being monitored crosses the limit
specified by the pickup setpoint setting and stays within that limit for a minimum time period
specified by the pickup time delay setting.

The setpoint condition ends when the magnitude of the signal being monitored crosses the limit
specified by dropout setpoint setting and stays within that limit for a minimum time period
specified by dropout time delay setting.

Over setpoint

When the value rises above the pickup setpoint setting and remains there long enough to satisfy
the pickup time delay period (ΔT1), the alarm condition is set to ON. When the value falls below
the dropout setpoint setting and remains there long enough to satisfy the dropout time delay
period (ΔT2), the alarm condition is set to OFF.
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A Pickup setpoint

B Dropout setpoint

ΔT1 Pickup time delay period (in seconds)

EV1 Start of alarm condition

ΔT2 Dropout time delay (in seconds)

EV2 End of alarm condition

ΔT3 Alarm duration (in seconds)

Max1 Maximum value recorded during pickup period

Max2 Maximum value recorded during alarm period

The meter records the date and time when the alarm event starts (EV1) and when it ends (EV2).
The meter also performs any task assigned to the event, such as operating a digital output. The
meter also records maximum values (Max1, Max2) before, during or after the alarm period.

Under setpoint

When the value falls below the pickup setpoint setting and remains there long enough to satisfy
the pickup time delay period (ΔT1), the alarm condition is set to ON. When the value rises above
the dropout setpoint setting and remains there long enough to satisfy the dropout time delay
period (ΔT2), the alarm condition is set to OFF.



A Pickup setpoint

B Dropout setpoint

ΔT1 Pickup time delay period (in seconds)

EV1 Start of alarm condition

ΔT2 Dropout time delay (in seconds)

EV2 End of alarm condition

ΔT3 Alarm duration (in seconds)

Min1 Minimum value recorded during pickup period

Min2 Minimum value recorded during alarm period

The meter records the date and time when the alarm event starts (EV1) and when it ends (EV2).
The meter also performs any task assigned to the event, such as operating a digital output. The
meter also records minimum values (Min1, Min2) before, during or after the alarm period.

Relative setpoint
The meter’s Relative Setpoint modules behave similarly to the Setpoint modules, except the
pickup and dropout levels are set relative to the Nominal input source.

For more information on Relative Setpoint modules, see ION Reference, available on
www.se.com.

Sag/swell alarms
Your meter monitors your power system’s voltage and current for sags and swells.

When sag/swell limits are defined and alarming is enabled, the meter reports the disturbance’s
magnitude and duration, and logs data and waveform records associated with the disturbance.

You must configure nominal voltage and current for these alarms to function.
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You can manually enter the limits (criteria) used by the meter to identify a sag or swell, or you can
have your meter learn sag/swell limits by monitoring your power system.

For more information on the Sag/Swell and Disturbance Analyzer modules, see ION Reference,
available on www.se.com.

Digital alarms
These alarms are triggered when the associated digital input changes state.

You can configure the alarm to be active when the digital input is on or off, depending on the
alarm’s purpose.

For example, if you used a digital input to monitor a breaker that is always supposed to be on, you
would set the alarm to be active when the breaker has tripped.

NOTE: To stop a digital alarm from being displayed, set the alarm priority to Info Only.
Disabling the digital alarm will disable all alarming functions of the associated digital input.

For more information on the Digital Input module, see ION Reference, available on www.se.com.

Transient alarms
Transient alarms are triggered by voltage transient activity (for example, ITI CBEMA Type 1
disturbances).

You must configure nominal voltage for these alarms to function.

The Threshold setup register in the Transient module defines what voltage disturbance
magnitude should be considered as transient activity. Threshold is interpreted as a percentage of
the nominal system voltage, plus 100. For example, if you want transients recorded when voltage
deviates from nominal by 20%, enter 120 into the Threshold setup register.

For more information, see Transients.

For more information on the Transient module, see ION Reference, available on www.se.com.

Alarm event priorities
Your meter’s alarm priorities correspond to event priority ranges.

Alarm priority Event priority

High (red) 192–255

Medium (yellow) 128–191

Low (blue) 64–127

Info Only (no alarm)* 1–63

None (no alarm or event)* 0

* Alarms with priority of Info Only or None are not indicated or displayed.

Info Only and None event priority

Alarms with a priority of Info Only or None are not shown on the meter’s display, and do not
function as alarms. If the alarm’s priority is set to Info Only, and the event priority is greater than
the event log cutoff value, the associated event is recorded in the meter’s event log. If the alarm’s



priority is set to None, the event priority is automatically set to zero, and no associated event is
logged in the meter’s event log.

For events that you want to log for future reference or troubleshooting, but don’t want alarm
functions, set the alarm priority to Info Only.

For nuisance events that frequently occur, and you have no desire to log for reference or
troubleshooting, set the alarm priority to None.

Alarm indicators
Your meter’s display has an alarm indicator to show you what alarm levels have been detected
(active or historic) and whether they have been acknowledged.

For active high priority alarms, the display will also flash until the alarm is acknowledged. There is
also an alarm LED to indicate the meter’s alarm condition.

Alarm Alarm icon Alarm icon flash Alarm LED Display

Active high Red solid bell
Flash if not
acknowledged

• Flash if not
acknowledged

• Steady if
acknowledged

Flash if not
acknowledged

Active medium
Yellow solid
bell

Flash if not
acknowledged

• Flash if not
acknowledged

• Steady if
acknowledged

No flash

Active low Blue solid bell
Flash if not
acknowledged

• Flash if not
acknowledged

• Steady if
acknowledged

No flash

Historic high
Red outline
bell

Flash if not
acknowledged

• Flash if not
acknowledged

• Steady if
acknowledged

No flash

Historic medium
Yellow outline
bell

Flash if not
acknowledged

• Flash if not
acknowledged

• Steady if
acknowledged

No flash

Historic low Gray solid bell No flash Off No flash

No active or
unacknowledged
alarms

Gray solid bell No flash Off No flash

If there are multiple active alarms, the alarm condition associated with the highest priority is
displayed. If there are multiple unacknowledged historic alarms, the meter displays the alarm
condition associated with the highest priority unacknowledged historic alarm.
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NOTE: To stop an alarm from being displayed without impacting other metering features, set
the alarm priority to Info Only.

Default alarms
Your meter comes with default alarms. Some alarms are enabled by default.

NOTE: Some alarms require configuration to operate.

Name Priority Description Default

Current Sag Ph1 - 3 High Current sag alarms for phase 1, 2, 3 Disabled

Current Swell Ph1 - 3 High
Current swell alarms for phase 1, 2,
3

Disabled

Sag/Swell High Voltage sag/swell alarm Disabled

Over I unbal Medium Over unbalanced current alarm Disabled

Over V unbal Medium Over unbalanced voltage alarm Disabled

Over THD V1 - 3 Medium
Over total harmonic distortion
(THD) voltage alarms

Enabled

Over kW (P) sd Medium Over kW sliding demand alarm Disabled

Over I a - c, (1 - 3) 4 Medium Over current alarms Disabled

V1 - V3 Setpoint Medium Voltage setpoint alarms Disabled

Freq Setpoint Medium Frequency setpoint alarm Enabled

4-30 Volt Intrp Ph1 - 3 Low
4-30 voltage interruption power
quality alarms

Enabled

Transient/Waveshape High Transient alarm Disabled

High-speed Transient
(ION9000T only)

High High-speed transient alarm Disabled

Digital In Info Only

Digital input alarms

Number of alarms determined by
the total number of available digital
inputs

Note: Info Only alarms are not
displayed.

Enabled

Alarm information
You can view information about an alarm from your meter’s display.

Only alarms with a priority of low, medium, or high are displayed.



Parameter Description

Alarm The name of the alarm (for example, Over THD V1).

Priority Low, medium, or high alarm priority.

Date The date and time the alarm was triggered.

Duration The duration of the alarm (only applies to inactive alarms).

Ack
The date and time when the alarm was acknowledged (only applies to
acknowledged alarms).

Value

Active alarm: The minimum or maximum value detected when the alarm was
triggered.

Historic alarm: The minimum or maximum value detected during the duration
of the alarm.

Viewing and acknowledging alarms using the display
To view and acknowledge alarms using the display:

1. Press the Home button on the display.

2. Press Alarms > Active Alarms or Historical Alarms.

3. Press Select.

4. Press the up or down icons to navigate alarms. A gray bar appears behind the active
selection.

NOTE: You can press Info to display alarm details.

5. To acknowledge alarms press Acknowledge All.

Alarm configuration
Topics in this section:

Alarm setup using the display

You can enable and disable alarms through the display.

WARNING
INACCURATE DATA RESULTS
• Do not use data displayed on the display or in software as a substitute for proper workplace
practices or equipment maintenance.

• Confirm your alarm is properly configured.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Default alarms available on the display
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Parameter* Description

Over I unbal Over unbalanced current alarm

Over THD V1 V1 over total harmonic distortion (THD) voltage alarm

Over THD V2 V2 over total harmonic distortion (THD) voltage alarm

Over THD V3 V3 over total harmonic distortion (THD) voltage alarm

Over kW sd Over kW sliding demand alarm

Over Ia Ia over current alarm

Over Ib Ib over current alarm

Over Ic Ic over current alarm

Over I4 I4 over current alarm

Over V unbal Over unbalanced voltage alarm

V1 Setpoint V1 setpoint alarm

V2 Setpoint V2 setpoint alarm

V3 Setpoint V3 setpoint alarm

Freq Setpoint Frequency setpoint alarm

Sag/Swell 1 Voltage sag/swell alarm

Current Sag Ph1** Current sag alarms for phase 1

Current Sag Ph2** Current sag alarms for phase 2

Current Sag Ph3** Current sag alarms for phase 3

4-30 Volt Intrp Ph1
4-30 voltage interruption power quality alarm for phase
1

4-30 Volt Intrp Ph2
4-30 voltage interruption power quality alarm for phase
2

4-30 Volt Intrp Ph3
4-30 voltage interruption power quality alarm for phase
3

Current Swell Ph1** Current swell alarms for phase 1

Current Swell Ph2** Current swell alarms for phase 2

Current Swell Ph3** Current swell alarms for phase 3

HSTC 1 (ION9000T
only)

High-speed transient alarm

* Any Setpoint or Relative Setpoint module with an event priority greater than or equal to the Low
alarm event priority is also displayed on this screen.

** Enabling or disabling one phase for each alarm type will enable or disable all phases for that
type.

NOTE: Configuring alarms must be done using ION Setup.



Alarms with a priority less than Low (Info Only or None) are not displayed.

You must configure all the parameters related to the alarm for alarm functions to operate. For
example, for the Over Ia alarm to operate, you must enter the nominal value and the conditions
that define an alarm state, even if the alarm is shown as Enabled on the Alarm Setup screen.

Disabling and enabling alarms using the display

Disable alarms using the display when you are performing maintenance tasks on your system and
want to prevent nuisance alarms.

NOTE: To stop an alarm from being displayed without impacting other metering features, set
the alarm priority to Info Only.

To disable alarms using the display:

1. Press the Home button on the display.

2. Press Setup Menu > Alarm Setup.

3. Press Select.

4. Press Edit. Enter your meter’s password, if prompted.

5. Press the up or down icons to navigate alarms. A gray bar appears behind the active
selection.

6. To select the item(s) press Select for Enable/Disable.

7. Press Select to accept the change.

8. Press Select to confirm.

9. Complete the system maintenance tasks.

10. Enable the alarms you disabled.

Configuring setpoint/standard alarms using ION Setup

To configure standard alarm settings using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Standard.

4. Select a setpoint and click Edit.

5. Enter the password and clickOK, if required.

The Setpoint Setup screen is displayed.

6. Configure the setpoint values as required.

7. Click Save to save the settings to your meter.
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Parameter Value/Range Description

By Percentage
By Percentage/By
Value

When available, specifies if the Pickup and
Dropoff entries are by percentage or by value. If
the option is not available, pickup and dropoff
entries are by value.

Disabled/Enabled Checked/Unchecked

Forcing the alarm off disables all functions of the
associated input.

To stop an alarm from being displayed without
affecting other meter features, set the alarm
priority to Info Only.

Label String value
When available, lets you modify the default label
so it more clearly identifies the alarm. Letters,
numbers, and underscores are permitted.

Pickup Numeric value
Use this setting to provide a value for when the
alarm turns on.

Pickup Delay Numeric value
This specifies the number of seconds the input
must be over the alarm pickup value before the
alarm turns on.

Dropout Numeric value
Use this setting to provide a value for when the
alarm turns off.

Dropout Delay Numeric value
This specifies the number of seconds the input
must be below the alarm dropoff value before the
alarm turns off.

Alarm Priority
None, Info Only, Low,
Medium or High

Specifies the priority level of the standard alarm.
When priority is set to Info Only, the alarm does
not appear on the display.

Custom Priority 0–255

Select custom priority to view and configure the
event priority of the event associated with the
alarm. The event log cutoff value is displayed for
reference; priorities above the cutoff are stored in
the meter’s event log.

Sag/swell overview

Your meter monitors your power system’s voltage and current for sags and swells (INCITS
(CBEMA) Type 2 and Type 3 disturbances).

When sag/swell limits are defined and alarming is enabled, the meter reports the disturbance’s
magnitude and duration, and logs data and waveform records associated with the disturbance.

You can manually enter the limits (criteria) used by the meter to identify a sag or swell, or you can
have your meter learn sag/swell limits by monitoring your power system.

Configuring sag/swell alarms using ION Setup

To configure sag/swell alarm settings using ION Setup:



1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Sag/Swell.

4. Select the parameter you want to configure and click Edit.

The setup dialog box for that parameter appears.

5. Configure the parameters as required.

The values you need to set vary depending on the type of sag/swell alarm you are
configuring.

Parameter Value/Range Description

Enable/Disable
Enabled or
Disabled

Specifies if sag/swell recording and alarming is enabled.

Nominal 1–999,999

The primary RMS voltage for the power system. Use the
line-to-line voltage for a Delta configured device and line-
to-neutral voltage for a Wye configured device.

For more information on configuring Volts Mode, see
Configuring metering parameters.

Swell Limit
Percentage of
nominal

Specifies the swell limit expressed as a percentage of the
nominal voltage.

Sag Limit
Percentage of
nominal

Specifies the sag limit expressed as a percentage of the
nominal voltage.

Hysteresis
Percentage –
see description

Specifies the difference in magnitude between the sag or
swell limit and the threshold for the power quality event to
be considered over.

For example, if the meter has the sag limit set to 90% of
nominal and the hysteresis is set to 2%, this means that in
a sag event, the voltage needs to return to 92% of nominal
for the sag event to be considered over

Alarm priority
See
description

Select the alarm priority you want to associate with
Sag/Swell alarms.

To stop an alarm from being displayed without affecting
other meter features, set the alarm priority to Info Only.

Voltage sag/swell setup parameters

Parameter Value/Range Description

Enable/Disable
Enabled or
Disabled

Specifies if sag/swell recording and alarming is enabled.

Nominal 1–999,999
Specifies the nominal current value used for current sag or
current swell detection.

Current sag/swell setup parameters
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Parameter Value/Range Description

Pickup
Percentage of
nominal

Specifies the percentage the current must deviate from the
nominal current to be classified as a sag or a swell.

Dropout
Percentage of
nominal

Specifies the percentage of nominal to which the current
must recover to signal the end of the sag or the swell.

Hysteresis N/A

Displays the difference in magnitude between the sag or
swell Pickup and Dropout values.

To change the hysteresis, change the Pickup or Dropout
values.

Alarm priority See description

Select the alarm priority you want to associate with
Sag/Swell alarms.

To stop an alarm from being displayed without affecting
other meter features, set the alarm priority to Info Only.

Configuring transient alarms using ION Setup

To configure transient alarm settings using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Transient.

4. Select Transient/Waveshape and click Edit.

The setup dialog box for that parameter appears.

5. Configure the parameters as required.

Parameter Value/Range Description

Enabled/Disabled
Enabled or
Disabled

Specifies if transient recording and alarming is
enabled.

Nominal 1–999,999
Specifies the nominal voltage value used for transient
detection.

Threshold
Percentage of
nominal

Specifies the threshold expressed as a percentage of
the nominal voltage, plus 100.

For example, if you want transients recorded when
voltage deviates from nominal by 20%, enter 120.

Alarm priority See description

Select the alarm priority you want to associate with
Transient alarms.

To stop an alarm from being displayed without
affecting other meter features, set the alarm priority to
Info Only.

Transient setup parameters



Configuring digital input alarms using ION Setup

To configure digital alarm settings using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Digital Input.

4. Configure the digital input alarm settings by selecting an input and clicking Edit. Some
settings are not configurable and are grayed out.

5. Click Save to save the changes to the meter.

Parameter Value/Range Description

Input Input On/Input Off

Specifies the input state/alarm behavior:

• Input On: the alarm is on when the digital input
is on.

• Input Off: the alarm is on when the digital input
is off.

Disable/Enable Checked/Unchecked

Disable or enable the associated alarm.

To stop an alarm from being displayed without
affecting digital input features, set the alarm priority
to Info Only.

Label String value
When available, lets you modify the default label so
it more clearly identifies the alarm. Letters,
numbers, and underscores are permitted.

Alarm Priority
None, Info Only, Low,
Medium, or High

Specifies the priority level of the digital input alarm.
To disable the alarm, set priority to Info Only.

Custom Priority 0–255

Select custom priority to view and configure the
event priority of the event associated with the
alarm. The event log cutoff value is displayed for
reference; event priorities above the cutoff are
stored in the meter’s event log.

Alerts
An alert is an external notification from the meter to indicate changes, for example, a change of
state for a digital input, or a power quality event such as a sag or swell.

When an alert condition occurs, a pulse or trigger is sent and generates the alert. You can
configure alerts to send notification emails or messages to your energy management system
through your meter’s existing Ethernet communications connections. You can configure alert
messages as a simple text string or you can also include device information. You can configure
the alert’s priority so that alerts are also recorded in the meter’s event log.

You can configure multiple alerts on a single meter, each having different activation triggers,
messages and/or transmission types. For instance, you can have two alerts, one generating an
email, the other sending a message to your energy management system, but using the same
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trigger conditions; or you can have two alerts with different conditions that send two unique emails
to two different email addresses. You can also generate alerts based on triggers from devices
connected to your meter.

Creating alerts is an advanced feature that requires familiarity with ION architecture and your
power system and communications network. To create an alert, you must configure the Alert
module using a configuration tool. You must also configure your device’s communications as
needed to send the alerts, such as configuring your meter’s SMTP settings and connecting it via
Ethernet to an SMTPmail server in order to send an alert by email.

For more information, see the ION Meter Alerts technical note, available on www.se.com.

Setpoint learning
Your meter can learn acceptable ranges or thresholds by monitoring normal operating values to
determine what constitutes a voltage sag, swell or transient to help identify high and low setpoints.

NOTE: To help your meter learn the most accurate values possible, it is important that learning
occur during a period of normal operation. Do not schedule learning during a period of unusual
operations in your system. Do not modify your meter’s configuration during the learning period
as it may stop the learning process.

You can configure the meter so that learned values are applied automatically after the learning
period is complete or require that they are reviewed and manually applied. If a learned value is
invalid, the learned values are not automatically applied, but logged for review.

Setpoint learning can be used to identify the following values:

Feature Values

Setpoints (Alarms)

High limit

Low limit

Sustain until ON

Sustain until OFF

Sag Voltage sag limit

Swell Voltage swell limit

Transient Threshold

Learning installation mode and learning duration
You can configure learning for manual or automatic mode.

There are two learning installation modes:

1. Manual: The meter learns the applicable values but does not begin using the learned
values. The learned values are recorded for review, and you can decide to use the learned
values or adjust them as required before manually implementing the learned values.

2. Automatic: The meter learns the applicable values and begins using those learned values
automatically at the end of the learning period. If a learned value is invalid, the meter does
not apply the value, but the value is recorded in the event log.



You can configure the maximum learning duration. The actual learning duration may vary,
depending on the stability of the system. If the system is stable for a period equal to one quarter of
the maximum learning duration, learning is complete; otherwise, the learning period will be the
maximum learning duration.

Example: Setpoint learning duration in a stable system

In this example, the learning duration is 30 days. When the system is stable for 7.5 days (one
quarter of 30 days) learning is complete.

Example: Setpoint learning duration in an unstable system

In this example, the learning duration is 30 days. Because the system is not stable for 7.5 days
(one quarter of the 30 days) learning is complete at the end of the maximum learning duration.

For more information on Sag/Swell, Setpoint, and Relative Setpoint modules, see ION Reference,
available on www.se.com.

Implementing standard alarm setpoint learning using ION Setup
You can use ION Setup to implement setpoint learning, which analyzes your power system and
recommends settings.
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NOTE: To learn valid setpoint values the meter’s power system must be stable.

To implement setpoint alarm setpoint learning using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Standard.

NOTE: You can manually configure setpoint values by selecting the setpoint and clicking
Edit.

4. Select a setpoint and click Learn.

TheGlobal Setpoint Learning screen is displayed.

5. Select the setpoint tabs to view existing configured or learned setpoint information.

6. Click Setup.

The Alarm Learning Setup screen is displayed.

Parameter Value/Range Description

Install mode
Automatic,
Manual

Automatic: The learned values are automatically
applied.

Manual: The learned values are stored for you to
review and enter.

Duration 1–365 Days for maximum learning duration.

Setpoint learning parameters

7. Configure the learning parameters for each setpoint and click Save.

8. Click Start All to begin setpoint learning for all setpoints. Click Yes to confirm or No to
cancel.

Learning status and time remaining are indicated in the Learning Status box.

Click Abort to stop learning for a specific setpoint. To stop all setpoint learning, repeat
for each setpoint tab.

9. Apply the learned setpoint values:

Automatic: The setpoint values are automatically applied unless the learning process
has issues or the learned values are invalid.

Manual: Navigate to Alarming > Setpoints, and then click Learn. On each setpoint
tab, click Install to apply the learned values to that setpoint.

NOTE: If you click Install while learning is in progress (in either manual or automatic
installation mode), it stops the learning process and prompts you for confirmation that you
want to stop learning and install the learned values. Once you confirm, the learned values
are automatically installed or prepared for manual installation.



Implementing sag and swell limit learning using ION Setup
You can use ION Setup to implement voltage sag/swell learning, which analyzes your power
system and recommends settings.

NOTE: Your meter’s power system must be stable to learn valid sag/swell limits.

NOTE: Learning is not supported for Current Swell and Current Sag.

To implement sag/swell limit learning using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Sag/Swell.

4. Select Voltage and click Learn.

NOTE: You can manually configure the limit values by selecting the parameter and
clicking Edit.

TheGlobal Setpoint Learning screen is displayed.

5. Click Setup.

The Alarm Learning Setup screen is displayed.

Parameter Value/Range Description

Install mode
Automatic,
Manual

Automatic: the learned values are automatically
applied.

Manual: the learned values are stored for you to
review and enter.

Duration 1–365 Days for maximum learning duration.

Sag/swell limit learning parameters

6. Configure the sag/swell limit learning parameters and click Save.

7. Click Start to begin sag/swell limit learning.

Learning status and time remaining are indicated in the Learning Status box.

Click Abort to stop sag/swell limit learning.

8. Apply the learned sag/swell limits.

Automatic: the limits are automatically applied unless there are issues with the learning
process.

Manual: navigate to Alarming > Sag/Swell. Select Voltage and click Learn. Click
Install to apply the learned limits.
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NOTE: If you click Install while learning is in progress (in either manual or automatic
installation mode), it stops the learning process and prompts you for confirmation that you
want to stop learning and install the learned limits. Once you have confirmed, the learned
limits are automatically installed or prepared for manual installation.

Implementing transient learning using ION Setup
You can use ION Setup to implement voltage transient learning, which analyzes your power
system and recommends settings.

NOTE: Your meter’s power system must be stable to learn valid transient thresholds.

To implement transient learning using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Alarming > Transient.

4. Select Transient/Waveshape and click Learn.

TheGlobal Setpoint Learning screen is displayed.

5. Click Setup.

The Alarm Learning Setup screen is displayed.

6. Configure the transient threshold learning parameters and click Save.

7. Click Start to begin transient learning.

Learning status and time remaining are indicated in the Learning Status box.

Click Abort to stop transient learning.

8. Apply the learned values.

Automatic: the threshold is automatically applied unless there are issues with the
learning process.

Manual: Click Alarming > Transient. Select Transient/Waveshape and click Learn.
Click Install to apply the learned values.

NOTE: While learning is in progress (in either manual or automatic installation mode), it
stops the learning process and prompts you for confirmation that you want to stop learning
and install the learned limits. Once you have confirmed, the learned values are
automatically installed or prepared for manual installation.



Parameter Value/Range Description

Install mode
Automatic,
Manual

Automatic: the learned values are automatically
applied.

Manual: the learned values are stored for you to
review and enter.

Duration 1–365 Days for maximum learning duration.

Transient learning parameters
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Power quality
Your meter measures voltage and current harmonics, and calculates several harmonic distortion
values, including K-factor and crest factor.

Configure your meter with the power system’s nominal values for voltage, current, and frequency
for the meter to perform power quality calculations.

Power quality configuration
Use ION Setup to configure sag/swell, transient and advanced power quality logging.

NOTE: For waveform recording to trigger automatically, enter your system’s nominal (normal)
voltage and current values and the amount of deviation from the nominal that is considered a
sag or a swell using theMetering > Basic or Alarming screen

NOTE: Changing your meter’s data logging (including burst data logging) and waveform
recording configuration clears your meter’s existing data logs, waveform records and
COMTRADE waveform files.

Before setting up the Power Quality (PQ) parameters, make sure the meter is configured
correctly:

• Metering parameters such as volts mode and PT/CT ratios

• Time sync settings, for integrating the meter in an energy management system such as
EcoStruxure™ Power Monitoring Expert

• Nominal system parameters (nominal volts, nominal current and nominal frequency), for
detecting power quality events

• Amount of deviation from the nominal that is considered a sag or swell

Make sure you understand:

• The structure of the meter’s logging framework

• The meter’s existing logging configuration

• Your data logging requirements

Changing the meter’s data recorder and waveform recorder configuration clears existing data and
waveforms in those recorders.

NOTICE
DATA LOSS

Ensure that all important data and waveforms have been recorded before configuring the data
and waveform recorders.

Failure to follow these instructions can result in data loss.



Power quality logging
Sags and swells

Your meter monitors your power system’s voltage and current for sags and swells (INCITS
(CBEMA) Type 2 and Type 3 disturbances).

When sag/swell limits are defined and alarming is enabled, the meter reports the disturbance’s
magnitude and duration, and logs data and waveform records associated with the disturbance.

Configuring sag and swell logging

Use ION Setup to configure your meter to log data and waveform records related to sag/swell
events, and to export the waveform data to COMTRADE files.

There are two data recorders for logging sag/swell related data:

• Sag/Swell Log (Data Rec 5) records data for plotting the ITIC (CBEMA) curve.

• Sg/Sw HS Log (Data Rec 6) records voltage and current data from the High-Speed Power
Meter module.

To configure the Sag/Swell Log, Sg/Sw HS Log, Sag/Swell Waveform Log, and Sag/Swell
COMTRADE files:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Power Quality > Sag/Swell Logging.

4. Select the data log and click Edit.

5. Enter the meter password, if prompted.

The Sag/Swell Logging Wizard appears.

6. The Device setting verification screen shows results of the meter configuration check for
possible errors related to sag/swell monitoring and reporting. Click Fix to view details or click
Next to ignore the results and proceed to the next screen.

7. The Disturbance Logging Setup screen displays the Log Depth setting for the Sag/Swell
Log (Data Rec 5). (Optional) Change the maximum number of records to store in this log.

8. Click Next.

9. The High Speed Recording screen displays the settings for the high-speed Sag/Swell data
recorder (Sg/Sw HS Log - Data Rec 6). Configure these settings for the meter to perform
burst data logging.

Parameter Description Notes

Enable Burst Data
Logging

Select or clear this check box to
turn burst data logging on or off.

-
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Parameter Description Notes

Pre-trigger recording

Specifies, in seconds, how many
pre-event records to capture.
The actual number of records
set in the high-speed Sag/Swell
data recorder’s Pre-trigger
Records setup register = (2 x
system frequency) x (number of
seconds).

If system frequency is changed,
the recording duration for Pre-
trigger recording and Post-
trigger recording automatically
adjusts to reflect the new
frequency setting.

Post-trigger
recording

Specifies, in seconds, how many
post-event records to capture.
The actual number of records
set in the high-speed Sag/Swell
data recorder’s Post-trigger
Records = (2 x system
frequency) x (number of
seconds).

If system frequency is changed,
the recording duration for Pre-
trigger recording and Post-
trigger recording automatically
adjusts to reflect the new
frequency setting.

Total # of recordings

Specifies how many burst data
log sets to save in long-term
memory (NVRAM). The actual
number of records is configured
in the high-speed Sag/Swell
data recorder’s Depth setup
register = (Total # of recordings)
x (Pre-trigger Records + Post-
trigger Records + 1). For details
on how a data log set is
calculated, see Data recorder
burst data.

When burst data logging is
enabled, the equivalent number
of records for 2 burst data log
sets is allocated in short-term
memory (RAM). The actual
number of records set in the
high-speed Sag/Swell data
recorder’s Buffer Depth setup
register = 2 x (Pre-trigger
Records + Post-trigger Records
+ 1).

10. Click Next.

11. Use theWaveform Log Setup screen to configure the waveform recorder for Standard or
Delayed waveform capture.

NOTE: The Sag/Swell Logging Wizard does not support Extended waveform capture.
For more information on Standard, Delayed, and Extended waveform capture, see
Waveform capture.

Parameter Description

Waveform Depth
Specifies the maximum number of waveform records stored on the
meter.

Waveform Format
Specifies the number of samples per cycle and the number of
cycles that are stored in a waveform record.



Parameter Description

Trigger Position
Specifies the number of cycles to capture before the waveform
versus after the waveform. Trigger position can be set using the
pre-cycle arrows or the slider bar.

NOTE: The maximum number of cycles (pre-event + post-event) cannot exceed the total
number of cycles in the waveform format.

12. Click Next.

13. Configure your meter’s COMTRADE settings:

a. Select or clear theGenerate COMTRADE files checkbox to enable or disable the
creation of COMTRADE records.

NOTE: The waveform viewer on your meter’s webpages uses the meter’s
COMTRADE files. If you want to view waveforms on the meter’s webpages, select
Generate COMTRADE files.

NOTE: The factory-default configuration for COMTRADE only supports Standard
waveform capture.

b. Set the Log depth for the COMTRADE files to specify the maximum number of records
stored on your meter’s SFTP site.

14. Click Finish.

You are returned to the Sag/Swell Logging screen and the entry shows your new
configuration.

If nothing happens after you click Finish, check the log depths and buffer depths for your
other data logs to make sure that the meter has enough memory for these changes. Adjust
the log depth and buffer depth of the data and waveform recorders, if needed.

Transients
Your meter monitors your power system’s voltage and detects ITI (CBEMA) type disturbances
related to transients.

When voltage transient limits are defined and alarming is enabled, the meter reports the
disturbance’s magnitude and duration, and logs data and waveform records associated with the
disturbance.

Configuring transient logging using ION Setup

Use ION Setup to configure your meter to log data and waveform records related to voltage
transient events, and to export the waveform data to COMTRADE files.

NOTE: Transient Log (Data Rec 15) records voltage transient related data.

To set up the Transient Log, Transient Waveform Log, and Transient COMTRADE files:
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1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Power Quality > Transient Logging.

4. Select the data log and click Edit. Enter the meter password if prompted.

The Transient Logging Wizard appears.

5. The Device setting verification screen displays the results of meter configuration check
for potential errors related to transient monitoring and reporting. Click Fix to view details or
click Next to ignore the results and proceed to the next screen.

6. The Transient Logging Setup screen displays Transient data recorder’s Log Depth
setting. You can change the maximum number of records to store in the Transient data log.
Click Next to proceed to the next screen.

7. TheWaveform Log Setup screen allows you to configure the waveform recorder for
Standard or Delayed waveform capture.

NOTE: The Transient Logging Wizard does not support Extended waveform capture. See
“Waveform capture” for details on Standard, Delayed and Extended waveform capture.

Parameter Description

Waveform
Depth

Specifies the maximum number of waveform records stored on the
meter.

Waveform
Format

Specifies the number of samples per cycle and the number of cycles that
are stored in a waveform record.

Trigger
Position

Specifies the number of cycles to capture before the waveform versus
after the waveform. Trigger position can be set using the pre-cycle
arrows or the slider bar.

NOTE: The maximum number of cycles (pre-event + post-event) cannot exceed the total
number of cycles in the waveform format.

Click Next.

8. Configure your meter’s COMTRADE settings:

a. Select or clear theGenerate COMTRADE files check box to enable or disable the
creation of COMTRADE records.

NOTE: The waveform viewer on your meter’s webpages uses the meter’s
COMTRADE files. If you want to view waveforms on the meter’s webpages, select
Generate COMTRADE files.

NOTE: The factory-default configuration for COMTRADE only supports Standard
waveform capture.

b. Set the Log depth for the COMTRADE files to specify the maximum number of records
stored on your meter’s internal SFTP site.



9. Click Finish.

You are returned to the Transient Logging screen and the entry shows your new
configuration.

If nothing happens when you click Finish, check the log depths and buffer depths for all your
other data logs to make sure that the meter has enough memory for these changes. Adjust
the log depth and buffer depth of the data and waveform recorders if needed.

Configuring Advanced Power Quality
Use ION Setup to configure your meter’s power quality monitoring and logging settings for IEC
61000-4-30, EN 50160, IEEE 519, and Rapid Voltage Change (RVC).

Prerequisites and notes

Ensure that Sag/Swell alarming is enabled and configured. For details on how to setup Sag/Swell
alarming, see Configuring sag/swell alarms using ION Setup.

NOTE: IEC 61000-4-30 must be enabled before configuring EN 50160 or IEEE 519 logging.

NOTICE
DATA LOSS

• Enable Sag/Swell alarming before configuring power quality disturbance related features.

• Enable IEC 61000-4-30 before enabling other power quality monitoring and recording
features.

Failure to follow these instructions can result in data loss.

To configure Advanced Power Quality:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Power Quality > Advanced PQ.

4. Configure IEC 61000-4-30.

5. (Optional) Configure EN 50160.

6. (Optional) Configure IEEE 519.

7. (Optional) Configure RVC.

Configuring IEC 61000-4-30
To configure IEC 61000-4-30:

1. Select 4-30 Enable.

2. Click Edit to configure your meter’s IEC 61000-4-30 logging parameters.
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3. Configure the settings as needed:

Parameter Description

Enabled

Select if you want to enable IEC 61000-4-30 monitoring.

NOTE: This option must be enabled when monitoring EN 50160 or
IEEE 519 parameters.

Threshold
Specifies the percentage of nominal voltage that defines a disturbance.
For example, if you set this to 10% of 120 V nominal, the disturbance
occurs when the voltage dips to 12 V and below.

Hysteresis

Specifies the percentage above the Threshold that defines the end of
the disturbance. For example, if you set this to 2%, the end of the
disturbance occurs when the voltage rises to (10% + 2%) of nominal, or
14.4 V and above.

Log 4-30 3s
measurements

Select if you want to enable IEC 61000-4-30 3-second interval data
logging.

Log 4-30 10s
measurements

Select if you want to enable IEC 61000-4-30 10-second interval data
logging.

IEC 61000-4-30 Setup

4. Click Send to save your changes.

The Advanced PQ screen shows the new configuration.

Configuring EN 50160
To configure EN 50160:

1. Select EN50160 Enable.

If you want to delete all logged EN 50160 data, click Reset, and then click Yes to confirm.

2. Click Edit to configure your meter’s EN 50160 logging parameters.

NOTE: You must enable IEC 61000-4-30 before the meter can start monitoring EN 50160
parameters.

3. Configure the settings as needed:

Parameter Description

Enabled Select if you want to enable EN 50160 monitoring.

Nominal Voltage Specifies the nominal voltage value used for EN 50160.

Nominal
Frequency

Specifies the nominal frequency used for EN 50160.

EN 50160 Setup



Parameter Description

Log EN50160
measurements

Select if you want to log EN 50160 parameters.

NOTE: You need to enable EN 50160 monitoring to log the
parameters.

4. Click Send to save your changes.

The Advanced PQ screen shows the new configuration.

Configuring IEEE 519
To configure IEEE 519:

1. Select 519 Enable.

2. Click Edit to configure your meter’s IEEE 519 logging parameters.

NOTE: You must enable IEC 61000-4-30 before the meter can start monitoring IEEE 519
parameters.

3. From the Harmonics Limits drop-down list, select the IEEE 519 edition you want the meter
to use when analyzing harmonic data.

4. Click Next.

5. Configure the voltage settings as needed:

Parameter Description

Nominal Voltage

Displays the nominal voltage value used for IEEE 519.

NOTE: If you change the Nominal Voltage, you must return to this
setup screen and update the IEEE 519 configuration.

<Bus voltage
options>

Select the bus voltage at the point of common coupling.

Select Disabled if you do not want to log IEEE 519 related data.

IEEE 519 Setup

6. After specifying the bus voltage, click Next to configure the IEEE 519 current parameters.

Parameter Description

Maximum short
circuit current

Enter the maximum short-circuit current at the point of common
coupling.

Maximum demand
load current

Enter the maximum demand load current at the point of common
coupling.

Ratio
This displays the maximum short-circuit to maximum demand load
ratio. This is used to determine the voltage and current distortion
limits.

IEEE 519 Setup
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7. Click Next to view the screen that displays the voltage and current distortion limits for the
harmonic content.

Harmonics 2 to 50 and THD/TDD are displayed, with the corresponding set limits for Voltage
Distortion % and Current Distortion %.

8. Click Finish to save your changes.

The Advanced PQ screen shows the new configuration.

Configuring RVC
To configure RVC:

1. Select RVC Enable.

2. Click Edit to configure your meter’s RVC feature.

NOTE: You must enable the Sag/Swell module before the meter can start monitoring and
detecting RVC.

3. Configure the settings as needed:

Parameter Description

Enabled

Disabled: ION Setup has detected that the Sag/Swell module is
disabled. Go to Alarming > Sag/Swell and enable Sag/Swell
first for the meter to detect RVC.

Yes: RVCmonitoring is on.

No: RVCmonitoring is off.

Threshold
Specifies, as a percentage, the RMS voltage limit that must be
exceeded for an RVC event to occur.

Hysteresis
Specifies, as a percentage, the difference in magnitude between the
start and end thresholds for an RVC event.

Rapid Voltage Change Setup

4. Click Send to save your changes.

The Advanced PQ screen shows the new configuration.

Rapid Voltage Change
Rapid Voltage Change (RVC) is a quick transition in RMS voltage between two steady-state
conditions, during which the voltage does not exceed the sag/swell thresholds.

You can configure the Sag/Swell module to detect and measure RVC and record the event in the
meter’s Event Log.

For more information on the Sag/Swell module, see ION Reference, available on www.se.com.

Harmonics
Harmonics are integer multiples of the fundamental frequency of the power system.



Harmonics information is valuable for power quality analysis, determining properly rated
transformers, maintenance, and troubleshooting. Evaluation of harmonics is required for
compliance with system power quality standards such as EN 50160 and meter power quality
standards such as IEC 61000-4-30.

Harmonics measurements include per-phase magnitudes and angles (relative to the fundamental
frequency of the phase A voltage) for the fundamental and higher order harmonics relative to the
fundamental frequency. The meter’s power system setting defines which phases are present and
determines how line-to-line or line-to-neutral voltage harmonics and current harmonics are
calculated.

Harmonics are used to identify whether the supplied system power meets required power quality
standards, or if non-linear loads are affecting your power system. Power system harmonics can
cause current flow on the neutral conductor, and damage to equipment such as increased heating
in electric motors. Power conditioners or harmonic filters can be used to minimize unwanted
harmonics.

Viewing harmonics information using the display
To view detailed harmonics data through the display:

1. Press the Home button on the display.

2. Press Power Quality > Harmonics. The total harmonic distortion (THD) screens are
displayed.

3. PressMore, then use the up or down icons to select the desired harmonics. The per-phase
harmonics are graphically displayed.

4. Press the left and right icons to move to individual harmonics. The harmonic number,
magnitude and phase angle are displayed.

Voltage crest factor
Crest factor is the ratio of peak to RMS voltage values.

For a pure sinusoidal waveform, crest factor is equal to 1.414. The meter uses the following
equation to calculate crest factor:

C = Crest factor

Vpeak = Voltage peak

VRMS = Voltage RMS

Current crest factor
Crest factor is the ratio of peak to RMS current values.

For a pure sinusoidal waveform, crest factor is equal to 1.414. The meter uses the following
equation to calculate crest factor:

C = Crest factor

Ipeak = Current peak

IRMS = Current RMS
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K-factor
K-factor relates the heating effect of a distorted current in a transformer to a sinusoidal current
with the same RMSmagnitude— it describes a transformer’s ability to serve non-linear loads
without exceeding rated temperature rise limits.

The K-factor is equal to the sum of the squares of the harmonic currents multiplied by the squares
of the harmonic order. The meter uses the following equation to calculate K-factor:

Where K is the K-factor, h is the harmonic order and Ih is the true RMS current of harmonic order
h.

Harmonic content calculations
Harmonic content (HC) is equal to the RMS value of all the non-fundamental harmonic
components in one phase of the power system.

The meter uses the following equation to calculate HC:

THD% calculations
THD% is a quick measure of the total distortion present in a waveform and is the ratio of harmonic
content (HC) to the fundamental harmonic (H1).

By default, the meter uses the following equation to calculate THD%:

thd and TDD
Your meter can be configured to provide thd (total harmonic distortion using the total RMS value
for the content rather than the fundamental content) and TDD (total demand distortion, the
harmonic current distortion against the maximum demand of the electrical system).

thd = HC / RMS *100%

TDD = HC / DemandMax *100%

For more information on the Harmonics Measurement module, see ION Reference, available on
www.se.com.



Phasors
Phasors are used to represent the voltage and current magnitude and angles.

The length of the lines in the phasor diagram represent the relative magnitude of the voltages with
respect to the other phase voltages, and the currents with respect to the other phase currents. All
angles are measured with respect to the Va/V1 phase. The Va/V1 phasor is fixed to the right-hand
horizontal axis (positive x-axis). Positive angles are measured counterclockwise.

Measured values are provided for the magnitude and relative angle for each voltage and current
phase.

Delta vector diagrams can be configured to display two different ways:

• Instrument (voltage vectors appear 60 degrees apart - showing the actual voltage and current
values that the meter is measuring).

• System (voltage vectors appear 120 degrees apart - showing true system operation including
any calculated values).

Phasor information can be used to troubleshoot incorrect connections on the meter’s voltage and
current inputs (for example, switched phase wiring or polarity errors), if you know how the phasors
should be oriented for your power system.

Phasor information can be viewed using ION Setup, meter webpages, or the display.

Power quality standards compliance
Meter compliance

Your meter is compliant with the following power quality standards.

IEC 62586-1 and IEC 62586-2

Your meter is compliant with IEC 62586-1 and IEC 62586-2. The meter classification is PQI-A-
FI1, defined as follows:

Product Code Description

PQI Power quality instrument

A Functions class A according to IEC 61000-4-30

F Fixed installed equipment

I Indoor application

1 Indoor environment with uncontrolled temperature variations

NOTE: Your meter has Power station electromagnetic immunity compliance in accordance with
IEC 61000-6-5.

IEC 61000-4-30

IEC 61000-4-30 power quality standard compliance is provided by IONmodules including: Power
Quality Aggregator, Harmonics Measurement, Disturbance Analyzer, Symmetrical Components,
Mains Signaling Evaluation, and Sag/Swell.
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For more information, see the IEC 61000-4-30 compliance and IONmeters technical note,
available on www.se.com.

Power quality standards compliance reporting
Your meter can measure and record compliance data for the following power quality standards.

EN 50160

The EN 50160 framework includes IONmodules such as Flicker, Mains Signaling Evaluation,
Harmonics Evaluation, and Voltage Harmonics.

NOTICE
DATA LOSS

Use an Uninterruptible Power Supply (UPS) to help maintain EN 50160 framework operation
during a power outage.

Failure to follow these instructions can result in data loss.

For more information about EN 50160, see the Power Quality: ION Meters and EN50160:2010
technical note, available on www.se.com.

IEEE 519

The IEEE 519 framework includes IONmodules, such as: Harmonics Evaluation, Harmonics
Measurement, and Counter.

Disturbance direction detection
Your meter has disturbance direction detection capabilities to help you determine the location of a
power system disturbance.

When a disturbance occurs, the meter analyzes the disturbance information to determine the
direction of the disturbance relative to the meter. This analysis includes a confidence level
indicating the level of certainty that the disturbance is in the determined direction and is stored in
your meter’s event log.

Disturbance direction detection is enabled on your meter by default and does not require any
additional configuration beyond setting the nominal voltage and nominal frequency.

Disturbance direction detection can help locate the source of a disturbance when used in a
system of disturbance direction detection devices. In the diagram below, meters (B), (C) and (D)
are installed on the power consumer side, while meter (E) is installed on the utility side.

https://www.se.com/ca/en/download/document/7EN72-0185/
https://www.se.com/ca/en/download/document/7EN72-0197/


A Disturbance location

B Meter (B) reports downstream disturbance

C Meter (C) reports upstream disturbance

D Meters (D) report upstream disturbance

E Meter (E) reports downstream disturbance

The arrows show the direction the meters have determined for the disturbance. With this
information, you can determine that the disturbance occurred between meter (B) and meter (C)
and can focus on that section of your system to find the cause of the disturbance.

Disturbance direction detection events
The results of the disturbance direction detection algorithm appear in the meter’s event log.

The image below shows an example of how a Disturbance Direction Detection event appears in
your meter's event log when viewed using ION Setup.
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You can view your meter’s event log through ION Setup or display.

For details on how to view the event log, see Viewing and downloading an event log.

For more information on the Disturbance Direction Detection module, see ION Reference,
available on www.se.com.

COMTRADE
The meter provides waveforms in COMmon format for TRAnsient Data Exchange (COMTRADE)
format. IEC 60255-24 defines the COMTRADE format. COMTRADE files simplify the retrieval,
analysis, and exchange of power quality event (disturbance) data between many sources and
vendors.

COMTRADE records are generated from the existing Waveform Recorder modules that are
connected to the COMTRADEmodule.

Your meter can generate COMTRADE files and store them on the meter’s internal SFTP site.

COMTRADE can be used in conjunction with IEC 61850.

For more information, see the COMTRADE and ION technology technical note, available on
www.se.com.

COMTRADE implementation
COMTRADE is configured as part of the default waveform recording framework.

COMTRADE records are created for sag/swell events. Configure your meter's nominal voltages
to enable waveform recording. COMTRADE records are stored as read-only files on the meter’s
internal SFTP site. A master reset, firmware upgrade, or waveform recorder change will delete the
records.

NOTE: Sag/Swell alarms must be enabled when using COMTRADE. For details on how to set
up Sag/Swell alarming, see Configuring sag/swell alarms using ION Setup.

By default:

• The meter is configured so COMTRADE records are created for the default waveform
recorders.

TIP: If you create a waveform recorder, the recorder will not create COMTRADE files by
default. Configure a new COMTRADEmodule if you want COMTRADE files created by new
recorders. You can configure up to three COMTRADEmodules using ION Setup in
Advanced mode. For more information on how to switch ION Setup to Advanced mode, see
Meter configuration.

• The oldest COMTRADE record is overwritten by the newest record when the COMTRADE
depth is exceeded.

https://www.se.com/ca/en/download/document/70072-0192-02/


NOTE: COMTRADE files can only be downloaded using an Ethernet connection. They cannot
be downloaded using serial, modem, or Ethernet gateway connections.

For more information, see the COMTRADE and ION technology technical note, available on
www.se.com.

Waveforms on the meter webpages
You can use the waveform viewer on the meter’s webpages to view waveforms generated as a
result of power quality events.

Set up the meter to view waveforms on the webpages
Before you can view waveforms on the meter’s webpages, you need to perform some basic
configuration to enable waveform capture and store the waveforms in COMTRADE format.

1. Enable waveform
capture on your meter

Set the meter’s nominal
voltage using ION Setup or
meter webpages.

2. A waveform is captured when
a power quality event occurs

A COMTRADE record is
generated and saved to your
meter’s internal SFTP site.

3. View the waveform on the
meter’s webpages

Go to the waveform viewer
(Monitoring > Waveforms) to
explore the waveform data.

The waveform viewer uses the meter’s COMTRADE files to display the waveforms. If the events
you want to capture are not included in the default framework, you can customize the meter’s
waveform recording framework.

Webpage waveform viewer
After COMTRADE files are generated by your meter, you can view them using the waveform
viewer.
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A
Select the COMTRADEmodule to view (COMTRADE_1 is set up by default; you can also
set up COMTRADE_2 or COMTRADE_3)

B Select the particular COMTRADE waveform to view

C Show/hide parameters

D View details

E Zoom in/out

Viewing waveforms on meter webpages
Use the waveform viewer on your meter’s webpages to view the meter’s COMTRADE waveform
files.

Prerequisites:

Ensure the meter is configured to record waveforms by setting the nominal voltage.



To view waveforms on meter webpages:

1. Open a browser and go to the IP address for your meter, entering valid login credentials
when requested.

2. Navigate toMonitoring > Waveforms.

A screen displays with accordion menus for three COMTRADEmodules (regardless of
whether or not that COMTRADEmodule is being created by the meter). The waveform
viewer for COMTRADE_1 is expanded.

By default, COMTRADE_1 displays the sag/swell waveform records. COMTRADE_2 and
COMTRADE_3 are used if you have configured additional waveform recorders and
connected them to COMTRADEmodules.

3. Select the accordion menu for the COMTRADE records you want to view, for example
COMTRADE_2.

The waveform viewer for those COMTRADE records is displayed.

4. Select the file you want to view from the record drop-down list box.

The numbering starts at 0 (zero), which means you select cmt0_00004 to view the fifth file
for COMTRADE_1.

5. Click or tap an individual voltage or current channel in the legend to show or hide it in the
waveform viewer.

Visible

Hidden

6. Use the bar at the bottom to zoom in/zoom out on a particular section of the waveform, or to
scan through the waveform with the selected zoom level.

Draw a window over a particular area to zoom in on that section of the waveform.

Drag the selected area to move the zoom across the waveform.

Drag the start and end points to expand or narrow the zoom.

7. Hover over or tap a spot on the waveform to view the values associated with that particular
moment in time.

Burst data logging
Burst data logging is a recording method that captures a snapshot of data that occurred
immediately before and immediately after a triggered recording.
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Burst data logging is analogous to continuous shooting mode or “burst mode” in photography. An
understanding of pre and post event data assists in the analysis of undesired power quality events
such as sags or swells.

Burst logging is typically used for high-speed RMS (half-cycle) data capture, but the data recorder
supports standard speed (1-second) recording as well, depending on the IONmodules connected
to the inputs of the Data Recorder module.

NOTE: To maximize the performance of your power management system, it is recommended
that devices be connected directly to an Ethernet network.

Data recorder burst data
The meter’s Data Recorder modules support burst data logging.

The Data Recorder module’s Pre-trigger Records setup register specifies how many pre-event
records are saved with each triggered recording. The Post-trigger Records setup register
specifies how many post-event records are saved with each triggered recording.

Both Pre-trigger Records and Post-trigger Records are set to zero by default. To configure the
data recorder for burst data logging, either or both of these setup registers must be set to a non-
zero positive integer value.

The data log set for each triggered recording is equal to the sum of Pre-trigger Records + Post-
trigger Records + 1 (where 1 is the actual record when the Data Recorder module’s Record input
was triggered).

For example, if Pre-trigger Records is set to 10 and Post-trigger Records is set to 5, the number of
records for each data log set is 16:

Burst data log set = [pre-trigger records] + [post-trigger records] + [actual trigger record] = 10 + 5 +
1 = 16.

When burst data logging is enabled, both Buffer Depth and Depth setup registers must be set to a
positive integer multiple of the data log set.



Use the system frequency to calculate the number of records needed to capture 1 second of data:

• For 60 Hz, total number of records per second = 60 cycles/second x 2 half-cycles = 120

• For 50 Hz, total number of records per second = 50 cycles/second x 2 half-cycles = 100

You can use the Power Quality setup assistant in ION Setup to specify how many seconds of
pre-trigger and post-trigger data you want to capture. ION Setup automatically calculates the
required number of records based on your input.

Subsynchronous oscillation monitoring
Subsynchronous oscillations occur below the fundamental frequency of a power system. These
oscillations typically range from 0–50 Hz and can indicate potential issues which can lead to
mechanical resonance or instability in equipment.

Your meter can help detect subsynchronous oscillations.

Overview
Use subsynchronous oscillation monitoring to continuously analyze a numerical input signal (such
as power or current).

Your meter monitors subsynchronous oscillations by:

1. Converting the most recent 10 seconds of time-domain data into the frequency-domain.

2. Identifying the top ten frequency components with the highest magnitudes within the 0–50
Hz range.

NOTE:

The meter ignores peaks below the greater of these two thresholds:

a. A magnitude less than 0.1.

OR

b. A magnitude less than 0.1% of the sliding window’s average magnitude.

3. Calculating the RMSmagnitudes for up to 50 configurable frequency groups.

4. Repeating the transformation and calculations approximately every second.

For more information about the Subsynchronous Oscillation Module, see ION Reference,
available on www.se.com.

Subsynchronous oscillation frequency groups
Frequency groups define specific ranges within the subsynchronous spectrum (0–50 Hz) that
your meter monitors. For each group, your meter calculates the RMSmagnitude of oscillations
within that range. This allows for targeted analysis of frequencies that are most relevant to your
system.

Formatting Rules

Enter frequency groups as a single string in the Subsynchronous Oscillation Module’s Frequency
Groups setup register. Each group specifies a lower and upper frequency bound in Hertz.
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Rule Description Example

Basic format

Each group must be enclosed
in square brackets with lower
and upper bounds separated
by a comma.

[10.0,11.5] is interpreted
as 10.0–11.5 Hz

Decimal precision
Enter up to one decimal place.
Extra digits are ignored.

[10.0,11.567] is
interpreted as 10.0–11.5 Hz

Optional bounds
If one bound is omitted, the
module uses the default
minimum or maximum.

[5.0,] is interpreted as 5.0–
50 Hz

[,10.5] is interpreted as 0–
10.5 Hz

Enter at least one bound
At least one bound must be
specified.

[,] is not valid.

Character limit
All groups combined must not
exceed 600 characters.

N/A

Example input and interpretation

Input:

[0.1,49.4][10.0,11.567][5.0,][,10.5]

Interpretation:

Input range Interpreted range Frequency group

[0.1,49.4] 0.1–49.4 Hz 1

[10.0,11.567] 10.0–11.5 Hz 2

[5.0,] 5.0–50 Hz 3

[,10.5] 0–10.5 Hz 4

Configuring subsynchronous oscillation monitoring using ION Setup
The Subsynchronous Oscillation (SSO) Module monitors subsynchronous frequencies in the 0–
50 Hz range. You must link a source input and optionally configure frequency groups.

NOTE: This procedure covers configuring the SSOModule only. It does not configure alarming,
logging, or other actions. If you need to initiate an action when oscillations exceed a threshold,
implement that logic in your ION template or in your supervisory system.

Use advanced mode in ION Setup to:

• Select the source data to monitor.

NOTE: Data comes from linking numeric ION output registers from other modules to the
Subsynchronous Oscillation Module's input register. You cannot link other types of ION



registers. For more information, see ION Reference, available on www.se.com.

• (Optional) Enter the frequency groups.

Prerequisites:

• An understanding of ION architecture.

• Full meter configuration access.

To configure subsynchronous oscillation monitoring:

1. Open ION Setup.

2. Open advanced mode for your meter.

If prompted, enter the device credentials.

TIP: To open advanced mode, Ctrl+Select your meter in the Network Viewer.

3. Open Subsynchronous Oscillation Modules.

4. If you do not already have a subsynchronous oscillation module:

a. Right-click Subsynchronous Oscillation Modules.

b. Select Insert Module.

Subsynchronous Oscillation 1 is created.

5. Open Subsynchronous Oscillation 1 or Subsynchronous Oscillation 2.

6. Select Inputs, and then select Edit.

The ION Input Selection screen appears.

7.  Link the source input:  

a. Go toOutput Registers, and then:

a. Select a module type that has a numeric register.

b. Select the module that you want to open.

c. Select the numeric register that you want to link to the selected Source.

b. SelectOK.

TIP: You must select a register forOK to become active.

8. (Optional)  Enter the frequency groups:

a. Select Setup Registers.

b. Select Frequency Groups, and then select Edit.

c. Enter the frequency groups that you want to monitor. For formatting details, see
Subsynchronous oscillation frequency groups.

d. SelectOK.

9. Select Send.

10. Confirm your SSO configuration.
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Confirming subsynchronous oscillation configuration
Use ION Setup to confirm that your meter is calculating SSO results.

To confirm your subsynchronous oscillation configuration:

1. Open ION Setup.

2. Open advanced mode for your meter.

If prompted, enter the device credentials.

TIP: To open advanced mode, Ctrl+Select your meter in the Network Viewer.

3. Select Subsynchronous Oscillation Modules.

4. Select SSO 1 or SSO 2.

5. Shift+Select Output Registers.

6. Confirm that:

a. New Update Available is non-zero, indicating that the module is operating and
calculating SSO results.

b. The number of Frequency Group N Magnitude registers matches the number of
groups you defined in the Frequency Groups setup register.

Waveform capture
Use the meter’s Waveform Recorder modules to capture waveform data.

The Waveform Recorder module captures one waveform record every time its Record input is
triggered.

A waveform record is defined by the module’s Format setup register, expressed as (number of
samples per cycle) x (number of cycles per waveform record). For example, if Format is set to
128x7, that means one waveform record is made up of 7 cycles of waveform data at 128 samples
per cycle.

The meter supports 3 waveform capture types: standard, delayed, and extended.

Standard waveform capture
The meter’s Waveform Recorder modules support standard waveform capture.

A standard waveform capture saves one buffered waveform record at the Record trigger time.
Only pre-trigger waveform data is captured in this mode. No post-trigger waveform cycles are
recorded.



A Waveform recording triggered

B Waveform record captured at trigger

Delayed waveform capture
The meter’s Waveform Recorder modules support delayed waveform capture.

The Waveform Recorder module’s Record Delay Cycles setup register specifies how many
cycles to delay the waveform capture after the Record input is triggered. This is for capturing post-
trigger waveform data.
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A Waveform recording triggered

B Waveform record if Record Delay Cycles was set to zero

C Delay period (number of cycles specified in Record Delay Cycles setup register)

D Delayed waveform capture recorded in waveform log

Extended waveform capture
The meter’s Waveform Recorder modules support extended waveform capture.

The Waveform Recorder module’s Pre-trigger Records setup register specifies how many pre-
event records are saved with each triggered recording. The Post-trigger Records setup register
specifies how many post-event records are saved with each triggered recording.

Both Pre-trigger Records and Post-trigger Records are set to zero by default. To configure the
waveform recorder for extended waveform capture, either or both of these setup registers must
be set to a non-zero positive integer value. If you do this, you must also set the Record Delay
Cycles setup register to zero in order to properly configure the extended waveform capture.



A Waveform recording triggered

B Waveform record captured at trigger

C Pre-trigger waveform records captured

D Post-trigger waveform records captured

The waveform log set for each triggered recording is equal to the sum of Pre-trigger Records +
Post-trigger Records + 1 (where 1 is the actual record when the Waveform Recorder module’s
Record input was triggered).

For example, if Pre-trigger Records is set to 2 and Post-trigger Records is set to 6, the number of
records for each waveform log set is 9:
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The waveform log set for the extended waveform capture = [pre-trigger records] + [actual trigger
record] + [post-trigger records]. The total waveform records captured in this example is 2 + 1 + 6 =
9.

When extended waveform capture is enabled, both Buffer Depth and Depth setup registers must
be set to a positive integer multiple of the waveform log set.

NOTE: The COMTRADEmodule does not support extended waveform capture. The
COMTRADE files saved are only for the trigger waveform record.



High-Speed Transient Capture (HSTC)
High-Speed Transient Capture overview

The ION9000T continuously monitors incoming voltage signals. In addition to standard transient
monitoring, the ION9000T detects sub-microsecond high-voltage transients up to a peak voltage
of 10 kV.

NOTE: The high-speed transient capture (HSTC) feature is available on the ION9000T
(METSEION95030 and METSEION95040).

The ION9000T meter is equipped with firmware and frameworks that enable the HSTC feature.

The default HSTC related settings suit most applications. Use the default settings or make
changes based on your system needs.

Use the HSTC feature to:

• Expand power quality event detection capabilities when combined with standard transient
capture.

• Record pre-event data to see the characteristics of the incoming voltage signal before the
disturbance.

• Receive alarm notifications when a transient has been detected.

• Chart waveforms to better understand the transient event. For example, peak magnitude,
duration and initial polarity of the transient.

• Record statistics, such as voltage stress, to provide an indication of cumulative impact to
loads within the electrical system.

• Sort voltage transients by peak magnitude and duration.

• Quantify transients on a per phase basis.

• Detect and characterize transients to create mitigation strategies.

For more information on the HSTC, HSTC waveform recorder, and Data set recorder modules,
see ION Reference, available on www.se.com.

Go to www.se.com and search for “An Overview of Transients in Power Systems” for information
on transients and their effects in electrical power systems.

HSTC prerequisites
To use the HSTC feature, you need the following:

• ION9000T meter.

• ION9000T frameworks files (v2.2.x or later).

• ION Setup (v3.2.x or later).

The HSTC feature is not supported on other ION9000 series meters.
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Verify the correct meter framework
The HSTC option is displayed as the HSTC feature set.

View the meter’s feature set using ION Setup, meter webpages, or the display.

Viewing feature set using ION Setup

1. Open ION Setup and select the Setup Assistant for your meter.

2. Click Template > Save to PC > FAC1 Feature Set.

Viewing feature set using the meter webpages

1. Open a web browser and enter the IP address for your meter. Enter your login credentials
when prompted.

2. Click Diagnostics > Statistics >Meter - Basic > Feature Set.

Viewing feature set using the display

Select Alt Display Mode > Nameplate > Feature Set.

See Display modes for information about display modes.

Verify the correct ION Setup version
To verify the ION Setup version:

1. Open ION Setup.

2. Click Help > About ION Setup. An ION Setup dialog box opens and displays the ION Setup
version.

If your version is earlier than v3.2.x., download the latest version of ION Setup

Downloading the latest ION Setup version

1. Browse to https://www.se.com/en/download/document/ION_Setup_Latest_Release for the
latest version of ION Setup.

2. Download the installation file, then run it to upgrade ION Setup.

Commission HSTC
This section supplements the meter installation guides and provides guidance on commissioning
your meter to enable HSTC.

See your device installation guide for information related to installation.

System voltage
Potential transformer (PT) scaling is not applied in high-speed transient capture.

High-speed transient measurements are performed on voltage levels present at the meter’s
voltage terminals.

Voltage reference
Set the voltage reference, Ve or Vn, according to your system configuration.

https://www.se.com/en/download/document/ION_Setup_Latest_Release


High-speed transient voltage measurements are calculated between V1–V4 and neutral (Vn), or
between V1–V4 and earth (Ve) depending on this setting.

Communications
Ethernet communication is recommended. HSTC waveform viewing is not supported over serial
connections.

Set up HSTC
HSTC alarms are disabled by default. The HSTC feature is enabled when HSTC alarms are
enabled.

HSTC related settings, such as magnitude and duration thresholds, are pre-configured at the
factory. Use the default settings or make changes based on your system needs.

Review and configure the settings for the following functions before enabling the HSTC feature:

• HSTC alarms

• HSTC logging.

HSTC alarms
Use HSTC alarms to notify you when a specific condition is met, such as a voltage transient that
exceeds a defined magnitude threshold.

HSTC alarms are included in the ION9000 series alarm system and are shown in the meter’s
Historical Alarm screen(s).

Default HSTC alarm settings
Setup Register Value/Range Default

HSTC Alarm status Disabled, Enabled Disabled

Voltage Reference Ve, Vn Ve

Magnitude Threshold (VRMS) 120–7100 1000

Duration Threshold (μs) 0–250.0 0

Alarm Priority None, Info Only, Low, Medium, High High

Custom Priority 0–255 192

To use HSTC alarms, perform the following:

• Enable HSTC alarms.

• Configure HSTC alarms.

Set the voltage reference.

Set the peak magnitude threshold and duration threshold.

Assign alarm priority.

Set a custom alarm priority.

• View and acknowledge alarms.

See Alarms and alerts for additional information about the ION9000 series alarms.
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Enable and configure HSTC alarms
Enable HSTC alarms using ION Setup or the display.

Configure HSTC alarms using ION Setup.

Changing your meter’s HSTC alarm configuration deletes all existing Data set and HSTC
waveform logs.

NOTICE
DATA LOSS

Ensure that all important data has been recorded before configuring HSTC alarms.

Failure to follow these instructions can result in data loss.

Enabling and configuring HSTC alarms using ION Setup

To enable and configure HSTC alarms using ION Setup:

1. Open ION Setup and select the Setup Assistant for your meter.

2. Click Alarming > Transient.

3. Select High Speed Transient, and then click Edit.

4. In High Speed Transient Setup, enable or configure the setup registers:

Setup Register Value/Range Description

Enabled/Disabled
Enabled,
Disabled

Specifies if HS Transient capture is enabled.

Voltage Reference Ve, Vn
Determines the voltage reference. Set the voltage
reference to match your system configuration.

Magnitude
Threshold (VRMS)

120–7100

Specifies the absolute voltage threshold that must be
exceeded to trigger a HS transient capture.

Note: This value is entered in RMS volts.

Duration Threshold
(μs)

0–250.0

Specifies the length of time that the magnitude
threshold must be exceeded to trigger a HS transient
capture. If this register is set to zero, any voltage that
exceeds the magnitude threshold will trigger a HS
transient capture.

Alarm Priority

None, Info
Only, Low,
Medium,
High

Select the alarm priority you want to associate with
the HS transient alarms. To stop an alarm from being
displayed without affecting other meter features, set
the alarm priority to Info Only.



Setup Register Value/Range Description

Custom Priority 0–255

Select custom priority to view and configure the
priority associated with the alarm. The event log
cutoff value is displayed for reference. Event
priorities above the cutoff are stored in the meter’s
event log.

5. Click Save. ION Setup performs a configuration check and displays a message if the
Magnitude Threshold setting is below the configured nominal voltage.

Enabling HSTC alarms using the display

To enable and disable HSTC alarms using the display:

1. Review your meter’s nominal voltage settings.

2. Set the HSTCmagnitude threshold to a value higher than the nominal voltage.

See Disabling and enabling alarms using the display for instructions.

Log HSTC
Topics in this section:

HSTC logging
The HSTC logging function is enabled with HSTC alarms. When defined transient thresholds are
exceeded the meter performs the following:

• HSTC data set logging.

• HSTC waveform logging.

The meter performs a set of calculations and stores separate records for each voltage phase.
Records are captured for V1–V4 regardless of which phase the transient occurred on.

HSTC logging default settings

Data Set Logging HSTC Waveform Storage

100 records 40 records, 20.0 ms

See Configuring HSTC logging using ION Setup for information about these settings.

HSTC Data set logging
Use data set logging to record transient event information such as peak voltage magnitude and
duration.

This feature also provides summary information such as volts-seconds stress accumulations for
each phase and total unique transient events.

Each time the HSTC trigger criteria are met, the meter performs a set of calculations for each
voltage phase:
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HSTC Data set Event based analytics

• Peak voltage amplitude

• Rise time

• Duration

• Voltage stress (volt-seconds)

• Average voltage

• Timestamps

HSTC Summary Event accumulations and statistics

• Total number of transient events on voltage phases V1–V4

• Total number of unique events

• Date and time of the last transient event counter reset

• Accumulated voltage stress (volt-seconds) for voltage phases
V1–V4

• Date and time of the last voltage stress accumulations reset

• Total number of transient events grouped by peak magnitude
and duration. There are a total of nine bins:

Magnitude 1/Duration 1

Magnitude 1/Duration 2

Magnitude 1/Duration 3

Magnitude 2/Duration 1

Magnitude 2/Duration 2

Magnitude 2/Duration 3

Magnitude 3/Duration 1

Magnitude 3/Duration 2

Magnitude 3/Duration 3

HSTC waveform logging
Use HSTC waveform logging to capture voltage transient waveform data.

A transient detected on any voltage phase triggers a waveform capture for all connected voltage
phases. The HSTC waveform recording feature detects long duration and repetitive disturbances
and automatically extends high-speed transient capture if conditions persist.

Each transient waveform recording includes pre-event data to analyze the characteristics of the
incoming voltage signal prior to the event that triggered the high-speed transient capture.

Use ION Setup or EcoStruxure™ Power Monitoring Expert to chart and view waveforms.



Enable and configure HSTC logging
HSTC logging is enabled when HSTC alarms are enabled. Use the default settings or make
changes based on your system needs.

Changing your meter’s HSTC logging configuration deletes all existing data log and waveform
records.

NOTICE
DATA LOSS

Ensure that all important data and waveforms have been recorded before configuring the data
and waveform recorders.

Failure to follow these instructions can result in data loss.

Enabling HSTC logging

The HSTC logging function is enabled with HSTC alarms.

See “Enable and configure HSTC alarms” for instructions on how to enable or disable the HSTC
alarms.

Configuring HSTC logging using ION Setup

Configure data set and waveform logging using ION Setup.

To set different conditions:

1. Open ION Setup and select the Setup Assistant for your meter.

2. Click Power Quality > HSTC logging.

3. Select the data log and click Edit.

The HSTC Logging Wizard displays

4. Set the Data Set Depth to the number of records to keep

5. Click Next.

ION Setup prompts you if the number of records exceeds file size limits. Enter a lower
number, then click Next to proceed.

6. Set the waveform storage Log Depth to the number of waveforms to keep. The total
duration of log storage in milliseconds (ms) is displayed consistent with the Log Depth
setting.

ION Setup prompts you if the Log Depth setting exceeds the recommended memory
allocation.

7. Click Finish to return to the HSTC Logging tab.

View HSTC
The ION9000T continuously monitors incoming voltage signals. When HSTC is enabled and
defined transient thresholds are met the meter performs the following functions:
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• HSTC alarms

• HSTC logging

Data set logging

HSTC waveform logging

View and acknowledge alarms
HSTC alarms are classified as historical alarms. Use the display to view and acknowledge HSTC
alarms.

See Viewing and acknowledging alarms using the display for instructions.

View HSTC logs
The following logs are generated when a high-speed transient has been detected:

• HSTC data set logs

• HSTC summary logs

• HSTC waveform recorder logs

View HSTC logs using ION Setup, the meter webpages or the display.

Viewing HSTC data sets using ION Setup

1. Open ION Setup and select your meter.

2. Click View > Data Screens.

3. Go to the High Speed Transient Capture folder, then select the HSTC Data Set log.

The HSTC Data Set Recorder log displays.

Viewing HSTC summary using ION Setup

1. Open ION Setup and select your meter.

2. Click View > Data Screens.

3. Go to the High Speed Transient Capture folder, then select the HSTC Summary log.

The HSTC Summary log displays.

Viewing HSTC summary using meter webpages

1. Open a web browser and enter your meter’s IP address in the address box.

The webpage login displays.

2. Enter your login credentials.

3. SelectMonitoring > Power Quality Summary > HSTC.

The High-Speed Transient Summary screen displays.

View HSTC waveforms
Use ION Setup or EcoStruxure™ Power Monitoring Expert to view HSTC waveforms.

Viewing HSTC waveforms using ION Setup

Use the ION Setup waveform viewer to plot captured waveform logs.



1. Open ION Setup and select your meter.

2. Click View > Data Screens.

3. Go to the High Speed Transient Capture folder, then select the HSTC Waveform log. The
HSTC Waveform log displays. A progress bar at the bottom of the screen indicates when all
waveform logs have been retrieved from the meter.

NOTE: Records are sorted by Start Date/Time, with the newest entries appearing at the
top.

4. Select the data to plot:

a. Select the record you want to view.

b. Hold the SHIFT key while selecting the first and last entries to plot multiple records in the
same view.

5. Click the chart icon to plot the selected records.

A Chart Properties box opens.

6. ClickOK.

The HSTC Waveform Plot displays.

HSTC waveform viewer navigation

The HSTC waveform viewer provides user interface elements to help understand transient event
information such as the peak magnitude, duration and initial polarity of the transient.
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Element Name Description

A Active window
This window displays a portion of the overall captured
disturbance.

B
HSTC V1–V4 phase
selector

Click to select a single voltage phase V1 through V4.

C
Slider control (top
and bottom)

Click and drag to focus on an event in the Active window. The
values shown in the information panel at the bottom of the
screen will update to reflect the new slider positions.

D Scale

Auto generated value based on the magnitude of the detected
transient.

Note: The color of the text matches the voltage phase
selected. For example, blue text indicates HSTC V3 phase
has been selected.

E Trigger point

The time when the transient thresholds are exceeded.

Note: The color of the trigger point indicator arrow matches
the voltage phase selected. For example, a red arrow
indicates HSTC V1 phase has been selected.

F Histogram
The histogram shows the complete captured disturbance.
Waveform samples are grouped into bins based on the peak
magnitude of the sample.



Element Name Description

G
Active histogram
window

This window functions as a coarse zoom. Select and drag the
window to any point in the histogram to focus on a specific set
of waveform samples. The waveform samples contained
within this histogram window are displayed in the active
window above.

Note: The waveform samples in the active window reflect
the selected HSTC phase.

H
Magnitude
thresholds

The peak magnitude of captured high-speed transients is
sorted into three bin thresholds to aid in the classification and
analysis of the captured event.

Mag ≤ 1500 V

1500 V < Mag < 4000 V

4000 V ≤ Mag < 10 000 V
Right click in the histogram to set the number of active bins
and their corresponding thresholds.

Note: The updated threshold settings are used for
informational purposes only. They do not change the
conditions set to detect transients, nor are they retained
when the HSTC waveform viewer is closed.

I Trigger timestamp
Timestamp representing the point in time that the transient
condition was detected.

J Active window zoom

This window functions as a fine zoom. Click, hold and drag
your cursor across any waveform portion in the active
window.

Note: The waveform samples in the active window zoom
reflect the selected HSTC phase.

K Spectral analysis

Right click within the histogram window to view the spectral
analysis of the selected samples.

Note: The spectral analysis window reflects the selected
HSTC phase.

HSTC events
HSTC events are logged the same as other meter events:

• External events such as the detection of a high-speed transient

• Configuration changes such as editing the HSTCmagnitude threshold

• Other meter events

See the Event log for more information about logging meter events.
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Viewing HSTC events

View the event log using ION Setup or the display.

HSTC resets
There are two HSTC reset methods, depending on what information you want to clear:

Use the meter’s Master reset to clear HSTC Data set and Waveform logs.

Use the meter’s HSTC reset to clear HSTC event accumulations and statistics.

NOTICE
DATA LOSS

Ensure all important data from the device has been recorded before performing a reset.

Failure to follow these instructions can result in data loss.

Master reset

Perform a Master reset using ION Setup.

Alternatively, you can use the meter webpages or meter display.

See Resets for more information about meter resets.

Resetting HSTC using ION Setup

1. Open ION Setup and select your meter.

2. Click View > Data Screens.

3. Go to the High Speed Transient Capture folder, then select the HSTC Summary log.

The HSTC Summary log displays

4. Click the HSTC Reset icon.

5. Click Yes to confirm HSTC reset.



Logging
Logging overview

The meter’s logging frameworks include factory-configured data recorders, waveform recorders,
and event logs.

The logging frameworks store data related to:

• Power quality and compliance

• Energy and demand

• Revenue metering

• Trending and forecasting

• Meter events

When your system’s nominal parameters are programmed into the meter, power quality events
such as sags, swells and transients are automatically detected, and associated voltage and
current data and waveforms are logged. Meter data is stored in non-volatile memory, so data is
retained even if the meter loses power. If your system nominal values fluctuate, you can configure
the meter’s setpoint learning feature to learn your power system’s normal operating values, then
use that information to help identify voltage sags and swells.

The meter’s logging framework also supports burst data logging for sag/swell events. When burst
data logging is enabled, additional data records immediately before and immediately after the
sag/swell event are captured. Energy management systems can then retrieve this information for
use in applications, such as power event analysis.

TIP: Connect devices directly to an Ethernet network to help maximize the performance of your
power management system.

You can also configure the meter to email data from the logging frameworks. For more
information, see the PowerLogic MeterM@il Internal Email Client Feature technical note,
available on www.se.com.

Meter events are recorded in the meter’s onboard event log. You can also configure the meter to
record events to an external syslog server.

For details on how to set up syslog, see Configuring Syslog network settings using ION Setup.

Default data logging configuration
The meter’s default template includes factory-configured data logs (Data Recorder modules).

These data logs and their configuration are used by other components of your power monitoring
system.

NOTE: Do not change the default configuration of any of the logs unless you understand the
impact of the change on these power monitoring system components, the data they use, and
your meter’s memory.

The meter can support up to 100 data recorders, which can each record up to 50 different
parameters.
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Revenue Log
The Revenue Log (Data Rec 1) is configured for use with UTS MV-90 billing software.

Factory settings for this data recorder:

• Log depth = 3360 records (35 days)

• Interval = 900 seconds (15 minutes)

By default, it logs the following values:

Parameter Description

kWh del int Interval kWh delivered

kWh rec int Interval kWh received

kVARh del int Interval kVARh delivered

kVARh rec int Interval kVARh received

Historic data logs
Three historic data logs are used to record standard power system quantities, such as phase
current, phase voltage, and power factor. These logs are labeled Hist Mean Log, Hist High Log,
and Hist Low Log.

Factory settings for these data recorders:

• Log depth = 3360 records (35 days)

• Interval = 900 seconds (15 minutes)

By default, they log the following values:

Hist Mean Log (Data Rec 2)

Vll ab mean V unbal mean I avg mean kVA tot mean

Vll bc mean Ia mean I 4 mean PF lag mean

Vll ca mean Ib mean kW tot mean PF lead mean

Vll avg mean Ic mean kVAR tot mean Freq mean

Hist High Log (Data Rec 3)

Vll ab high V unbal high I avg high kVA tot high

Vll bc high Ia high I 4 high PF lag high

Vll ca high Ib high kW tot high PF lead high

Vll avg high Ic high kVAR tot high Freq high

Hist Low Log (Data Rec 4)

Vll ab low V unbal low I avg low kVA tot low



Hist Low Log (Data Rec 4)

Vll bc low Ia low I 4 low PF lag low

Vll ca low Ib low kW tot low PF lead low

Vll avg low Ic low kVAR tot low Freq low

Loss Log
The Loss Log (Data Rec 9) is configured to record loss values.

Factory settings for this data recorder:

• Log depth = 3360 records (35 days)

• Interval = 900 seconds (15 minutes)

By default, it logs the following values:

Parameter Description

MU Ia^2h int Phase A interval current squared hours

MU Ib^2h int Phase B interval current squared hours

MU Ic^2h int Phase C interval current squared hours

MU Vllab^2h int Phase A interval voltage Line-to-Line squared hours

MU Vllbc^2h int Phase B interval voltage Line-to-Line squared hours

MU Vllca^2h int Phase C interval voltage Line-to-Line squared hours

MU Vln a^2h int Phase A interval voltage Line-to-Neutral squared hours

MU Vln b^2h int Phase B interval voltage Line-to-Neutral squared hours

MU Vln c^2h int Phase C interval voltage Line-to-Neutral squared hours

Harmonics logs
Two harmonics logs record various harmonics data, including K-factor and Total Harmonic
Distortion (THD). These recorders are labeled Harm Mean Log and Harm High Log.

Factory settings for these data recorders:

• Log depth = 840 records (35 days)

• Interval = 3600 seconds (1 hour)

By default, they log the following values:

Harm Mean Log (Data Rec 7)

V1 THDmean I1 THDmean I1 K Fac mean

V2 THDmean I2 THDmean I2 K Fac mean

V3 THDmean I3 THDmean I3 K Fac mean
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Harm High Log (Data Rec 8)

V1 THD high I1 THD high I1 K Fac high

V2 THD high I2 THD high I2 K Fac high

V3 THD high I3 THD high I3 K Fac high

Energy and Demand Log
The EgyDmd Log (Data Rec 10) records energy and demand data used by energy management
software to generate reports.

Factory settings for this data recorder:

• Log depth = 3360 records (35 days)

• Interval = 900 seconds (15 minutes)

By default, it logs the following values:

Parameter Description

kWh del Active energy delivered

kWh rec Active energy received

kWh del-rec Active energy delivered minus received

kVARh del Reactive energy delivered

kVARh rec Reactive energy received

kVARh del-rec Reactive energy delivered minus received

kVAh del+rec Apparent energy delivered plus received

kW sd del-rec Active power demand delivered minus received

kVAR sd del-rec Reactive power demand delivered minus received

kVA sd del+rec Apparent power demand delivered plus received

Daily Nominal Log
The DailyNom Log (Data Rec 39) provides information about the meter’s nominal settings.

Factory settings for this data recorder:

• Log depth = 450 records

• Interval = Triggered on demand

By default, it logs the following values from the Factory module’s setup registers:

Parameter Description

FAC1 Vnominal Nominal voltage setting

FAC1 NomFreqNum Expected frequency of operation



Rapid Voltage Change Log
The RVC Log (Data Rec 23) provides details of rapid voltage changes related to sag/swells
(power quality events). This data recorder is disabled by default.

Factory settings for this data recorder:

• Log depth = 100 records

• Interval = Triggered on demand

If enabled, it logs the following by default:

SS1 Delta Umax SS1 Delta Uss SS1 RVC Duration

For more information on how to enable the Rapid Voltage Change Log, see Configuring
Advanced Power Quality.

Sag/swell Log
The Sag/swell Log (Data Rec 5) provides details of power quality events.

Factory settings for this data recorder:

• Log depth = 100 records

• Interval = Triggered on demand

By default, it logs the following values:

SS1 DistDur SS1 DistV1Min SS1 DistV1Max SS1 DistV1Avg

SS1 DistV1Engy SS1 DistV2Min SS1 DistV2Max SS1 DistV2Avg

SS1 DistV2Engy SS1 DistV3Min SS1 DistV3Max SS1 DistV3Avg

SS1 DistV3Engy SS1 DistNominal SS1 Swell Lim SS1 Sag Lim

For more information on how to configure sag/swell logging, see Configuring sag and swell
logging.

Sg/Sw HS Log
The Sg/Sw HS Log (Data Rec 6) captures high-speed (half-cycle) voltage and current data that
includes pre-event and post-event records related to the sag/swell event. This data recorder is
disabled by default.

If enabled, it logs the following by default:

HS Vln a HS Vll ab HS I a HS Freq

HS Vln b HS Vll bc HS I b
PQA1 Vavg Sliding
Ref Voltage

HS Vln c HS Vll ca HS I c

For more information on how to enable the Sg/Sw HS Log, see Configuring sag and swell logging.
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Transient Log
The Transient Log (Data Rec 15) provides details of power quality events. Factory settings for this
data recorder:

Factory settings for this data recorder:

• Log depth = 100 records

• Interval = Triggered on demand

By default, it logs the following values:

TR1 TranV1Dur TR1 TranV3Dur PM1 PT Prim

TR1 TranV1Max TR1 TranV3Max PM1 PT Sec

TR1 TranV2Dur TR1 TranNominal PM1 CT Prim

TR1 TranV2Max TR1 Threshold PM1 CT Sec

EN 50160 compliance logs
The EN 50160 compliance logs are used to record EN 50160 compliance counters:

Data recorder Description

EN50160 Flicker (Data Rec 18) Flicker

EN50160 Frq/Mg (Data Rec 17) Power frequency and supply magnitude

EN50160 Hrm Vlt (Data Rec 29) Voltage harmonics

EN50160 Ihm Vlt (Data Rec 30) Voltage interharmonics

EN50160 Intrp (Data Rec 24) Short/long interruptions

EN50160 MSignal (Data Rec 31) Evaluation of mains voltage signals

EN50160 Prm-f/V (Data Rec 32) Frequency and supply voltage statistics

EN50160 Prm-Flk (Data Rec 33) Flicker statistics (Pst and Plt)

EN50160 PrmHrm1 (Data Rec 12) Harmonics statistics

EN50160 PrmHrm2 (Data Rec 11) Harmonics statistics overflow

EN50160 Swell (Data Rec 25) Voltage swells

EN50160 Vlt Dp1 (Data Rec 19) Supply voltage dips

EN50160 Vlt Dp2 (Data Rec 20) Supply voltage dips

EN50160 Vunbal (Data Rec 28) Voltage unbalance

The meter logs EN 50160 counter data for present and previous observation periods as well as
EN 50160 events.

For more information about EN 50160, see the Power Quality: ION Meters and EN50160:2010
technical note, available on www.se.com.

https://www.se.com/ca/en/download/document/7EN72-0197/


IEC 61000-4-30 logs
The IEC 61000-4-30 logs are used to log parameters related to the International Electrotechnical
Commission’s IEC 61000-4-30 standard and to create reports:

4-30 3s RMS Log (Data Rec 38)

PqFlag 2s ivd I1 3s V1 OverDev 3s V3 OverDev 3s

V1 3s I2 3s V2 UnderDev 3s

V2 3s I3 3s V2 OverDev 3s

V3 3s V1 UnderDev 3s V3 UnderDev 3s

4-30 10mRMS Log (Data Rec 16)

PqFlag 10m PQA1 I1 10m V1 OverDev 10m V3 OverDev 10m

V1 10m PQA1 I2 10m V2 UnderDev 10m Power Freq 10m

V2 10m PQA1 I3 10m V2 OverDev 10m

V3 10m V1 UnderDev 10m V3 UnderDev 10m

4-30 2hrRMS Log (Data Rec 37)

PqFlag 2hr I1 2hr V1 OverDev 2hr V3 OverDev 2hr

V1 2hr I2 2hr V2 UnderDev 2hr Power Freq 2hr

V2 2hr I3 2hr V2 OverDev 2hr

V3 2hr V1 UnderDev 2hr V3 UnderDev 2hr

4-30 3s THD Log (Data Rec 26)

PqFlag 3s THD V3 THD 3s I3 THD 3s IUnbal u2 3s

V1 THD 3s I1 THD 3s Vunbal u2 3s IUnbal u0 3s

V2 THD 3s I2 THD 3s Vunbal u0 3s

4-30 10mTHD Log (Data Rec 27)

PqFlag 10m V3 THD 10m PQ I3 THD 10m IUnbal u2 10m

V1 THD 10m PQ I1 THD 10m Vunbal u2 10m IUnbal u0 10m

V2 THD 10m PQ I2 THD 10m Vunbal u0 10m

4-30 2hrTHD Log (Data Rec 34)

PqFlag 2hr V3 THD 2hr I3 THD 2hr IUnbal u2 2hr

V1 THD 2hr I1 THD 2hr Vunbal u2 2hr IUnbal u0 2hr

V2 THD 2hr I2 THD 2hr Vunbal u0 2hr
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4-30 10s Freq (Data Rec 21)

Power Frequency PqFlag 10s

4-30 Intrp Log (Data Rec 22)

V Intrp DrtnAll (voltage interruption duration - all voltages)

For more information, see the IEC 61000-4-30 compliance and IONmeters technical note,
available on www.se.com.

IEEE 519 compliance logs
The IEEE 519 compliance logs are used to record IEEE 519 compliance parameters:

Data recorder Description

519 Hrm I-X (Data Rec 35)
Current harmonics statistics and counters:
Weekly 95th percentile 10 min intervals

519 Hrm I-Y (Data Rec 36)
Current harmonics statistics and counters:
Weekly 99th percentile 10 min intervals

519 Hrm I-Z (Data Rec 14)
Current harmonics statistics and counters:
Daily 99th percentile 3 s intervals

519 Hrm V-X (Data Rec 42)
Voltage harmonics statistics and counters:
Weekly 95th percentile 10 min intervals

519 Hrm V-Z (Data Rec 13)
Voltage harmonics statistics and counters:
Daily 99th percentile 3 s intervals

V1 Hrm 1-50 (Data Rec 40) V1 voltage harmonics - 10 min

V2 Hrm 1-50 (Data Rec 41) V2 voltage harmonics - 10 min

V3 Hrm 1-50 (Data Rec 43) V3 voltage harmonics - 10 min

I1 Hrm 1-50 (Data Rec 44) I1 current harmonics - 10 min

I2 Hrm 1-50 (Data Rec 45) I2 current harmonics - 10 min

I3 Hrm 1-50 (Data Rec 46) I3 current harmonics - 10 min

Configuring data logging using ION Setup
Use ION Setup to configure the meter’s data recorders.

Changing the meter’s data recorder configuration clears existing data in that data recorder.

NOTICE
DATA LOSS

Ensure that all important data is recorded before configuring data recording.

Failure to follow these instructions can result in data loss.

https://www.se.com/ca/en/download/document/7EN72-0185/


To configure data logging using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Logging >Memory.

4. In the Status tab, select the data log and click Edit.

The Log Depth Setup window appears.

5. Configure the settings as applicable:

Parameter Description

Log Interval How frequently records are logged

Log Depth Maximum number of records stored in the log

Log Memory
Information only. This is automatically calculated, and displays
how much memory the log uses based on the Log Interval
and Log Depth

Log Storage
Information only. This is automatically calculated, and displays
how much total memory is left after subtracting the Log
Memory usage

Waveform recording
The meter’s factory-configured waveform recorders store waveform data related to power quality
events.

Waveform information is used to help identify power system disturbances, which are an
increasing concern for industrial plants, hospitals, data centers and other facilities where the
equipment is sensitive to voltage or current sags, swells, transients, and momentary interruptions.
Waveform information is also used to help ensure compliance with power quality standards.

In addition to measuring and recording numerical values for voltage and current, your meter can
also capture the sinusoidal waveform data. The current and voltage waveform data provides
additional information for analysis of the system’s power quality or a power quality event.

When your system’s nominal parameters are programmed into the meter, power quality events
such as sags, swells and transients are automatically detected and voltage and current waveform
data is logged. The default factory settings for sag/swell and transient detection are sufficient for
most applications, but you can also modify the amount of deviation from the nominal required to
trigger waveform recording.

Waveform data storage format
Your meter’s waveform data storage format is defined by:

• Cycles: the number of cycles included in the waveform (its duration).

• Samples: samples per cycle, which is the number of waveform data points collected in each
cycle.
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This gives you the option to record a lot of information for a very short duration or less information
over a longer duration. You can also configure the waveform recording to record pre-event and
post-event data.

Types of waveform data
You can use your meter to detect ITI (CBEMA) - type disturbances, and determine information
regarding the magnitude and duration of each disturbance. This information can be used by your
energy management system to plot the disturbance on an ITI (CBEMA) curve.

COMTRADE waveform data is available from your meter.

NOTE: If you are generating COMTRADE waveform information, the associated waveform
recorders cannot be modified unless COMTRADE is disabled. If the waveform recorders are
not configured identically, COMTRADE waveform information will not be generated.

Key terms

Term Definition

COMTRADE
COMmon format for TRAnsient Data Exchange (COMTRADE) is
a common format for waveform data.

ITI (CBEMA)

A curve that graphically describes an AC input voltage envelope
which can be typically tolerated by information technology
equipment. Meter waveform information is plotted on this curve to
help evaluate power quality.

Nominal
The normal or usual parameter value. For example, the nominal
voltage for many power systems is 120 V.

Sag
A power event where the voltage or current drops below the
nominal value.

Swell
A power event where the voltage or current rises above the
nominal value.

Transient
A power event where a short duration surge of electrical energy is
detected.

For more information on the Waveform Recorder module, see ION Reference, available on
www.se.com.

Default waveform recording configuration
The meter’s default framework includes factory-configured waveform logs (waveform recorders).

These waveform logs and their configuration are used by other components of your power
monitoring system. Do not change the default configuration of any of the logs unless you
understand the impact of the change on these power monitoring system components, the data
they use and your meter’s memory.



Waveform Recorder modules
The factory-default Waveform Recorder modules are preconfigured to capture sag/swell and
transient power quality events.

Waveform recorder Description

Wfm Rc V1-Sg/Sw (Wform Rec 1)
V1 voltage waveforms recorded during a defined sag or
swell event.

Wfm Rc V2-Sg/Sw (Wform Rec 2)
V2 voltage waveforms recorded during a defined sag or
swell event.

Wfm Rc V3-Sg/Sw (Wform Rec 3)
V3 voltage waveforms recorded during a defined sag or
swell event.

Wfm Rc I1-Sg/Sw (Wform Rec 5)
I1 current waveforms recorded during a defined sag or
swell event.

Wfm Rc I2-Sg/Sw (Wform Rec 6)
I2 current waveforms recorded during a defined sag or
swell event.

Wfm Rc I3-Sg/Sw (Wform Rec 7)
I3 current waveforms recorded during a defined sag or
swell event.

Vfm Rc V1-Trnst (Wform Rec 9)
V1 voltage waveforms recorded during a defined
transient event.

Vfm Rc V2-Trnst (Wform Rec 10)
V2 voltage waveforms recorded during a defined
transient event.

Vfm Rc V3-Trnst (Wform Rec 11)
V3 voltage waveforms recorded during a defined
transient event.

Vfm Rc I1-Trnst (Wform Rec 13)
I1 current waveforms recorded during a defined
transient event.

Vfm Rc I2-Trnst (Wform Rec 14)
I2 current waveforms recorded during a defined
transient event.

Vfm Rc I3-Trnst (Wform Rec 15)
I3 current waveforms recorded during a defined
transient event.

COMTRADE modules
The factory-default COMTRADEmodules are preconfigured with their inputs linked to the Trigger
outputs of the waveform recorders for sag/swell and transient monitoring.

COMTRADE 1 inputs (sag/swell) Linked Waveform Recorder (Trigger output)

Waveform Trigger 1 Wfm Rc V1-Sg/Sw (Wform Rec 1)

Waveform Trigger 2 Wfm Rc V2-Sg/Sw (Wform Rec 2)

Waveform Trigger 3 Wfm Rc V3-Sg/Sw (Wform Rec 3)
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COMTRADE 1 inputs (sag/swell) Linked Waveform Recorder (Trigger output)

Waveform Trigger 4 Wfm Rc I1-Sg/Sw (Wform Rec 5)

Waveform Trigger 5 Wfm Rc I2-Sg/Sw (Wform Rec 6)

Waveform Trigger 6 Wfm Rc I3-Sg/Sw (Wform Rec 7)

COMTRADE 2 inputs (transient) Linked Waveform Recorder (Trigger output)

Waveform Trigger 1 Vfm Rc V1-Trnst (Wform Rec 9)

Waveform Trigger 2 Vfm Rc V2-Trnst (Wform Rec 10)

Waveform Trigger 3 Vfm Rc V3-Trnst (Wform Rec 11)

Waveform Trigger 4 Vfm Rc I1-Trnst (Wform Rec 13)

Waveform Trigger 5 Vfm Rc I2-Trnst (Wform Rec 14)

Waveform Trigger 6 Vfm Rc I3-Trnst (Wform Rec 15)

Event log
Your meter records events produced by the meter’s ION modules or external meter events.

Meter events, such as meter configuration or changes to I/O state, have priority values associated
with them, so you can control what events are logged. Each event has a priority based on its type
and severity, and for most events you can configure the priority. The event log records the date
and time of the event, along with relevant details about the event.

Your meter’s event log can be viewed through ION Setup and the display.

For more information on how to view the event log, see Viewing and downloading an event log.

Default event log configuration
Your meter logs all configuration changes, meter access events, and power system events.

You can configure certain features, such as the digital inputs, so an event is logged when the
feature changes state (for example, the digital input changes from off to on).

Your meter’s event log might be used by other components of your power monitoring system. Do
not change the default event log configuration unless you understand the impact of the change on
the power monitoring system components and the data they use and on your meter’s memory.

Changing the default event log configuration should only be undertaken by those with an
advanced understanding of ION architecture and their meter’s template.

The event log is controlled by the Event Log Controller module, which allows you to set a priority
cutoff for event logging. Events with a priority number greater than the cutoff value are logged,
and events with lower priorities are discarded. By default, this value is set so that all relevant
events are recorded in the meter’s event log. Event priority values range from 0 to 255 with a
typical cutoff value of 5.



NOTE: Alarms are generated by events from certain ION modules. The alarm level is
determined by the priority of the associated event. To disable the alarm but still record the
associated event, set the alarm priority to Info Only. To disable the alarm and the event, set the
alarm priority to None.

For more information on the Event Log Controller module and event priorities for specific ION
modules, see ION Reference, available on www.se.com.

User triggered event log entries

The Event Log includes an association between security-related events and the username that
was logged in to the meter during the event.

When a user produces an event, such as a reset, successful or unsuccessful login attempts, user
lockout or setup change, it is written to the event log. Events created in advanced security through
ION Setup or the display are associated with the username that was logged into the meter
(USER1 - USER50).

Unread events in event log

View unread events in the event log. Log into ION Setup as the designated reader and switch ION
Setup into Advanced mode to view unread events. A customized framework is required to setup
notifications for unread events.

Assigning a designated reader for event log notification

A user can be assigned the role of designated reader for the event log.

When the Designated Reader is configured, an entry in the event log is considered unread until it
is reviewed or backed up to external storage by the designated reader. When the designated
reader is informed that the event log is nearly full, an event log review or backup strategy can be
implemented before older entries are overwritten. This feature can assist in ensuring that event
log entries are not overwritten before they can be reviewed. Use ION Setup to select a user to be
the designated reader.

1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

3. Open the EventLogCtl Modules folder and double click EventLogCtl.

4. Enter login credentials as necessary.

5. Click the Setup Registers tab.

6. Select Designated Reader and click Edit.

7. Set Designated Reader to the user that reviews the event log (USER0 - USER50) and click
OK.

Syslog
Syslog uses the User Datagram Protocol (UDP) to transport event log information from the meter
directly to a centralized syslog server.
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The syslog server can receive logs from multiple devices, including meters, then store and filter
the log information as needed. You can use ION Setup to modify the syslog network settings for
your device. Syslog is a useful feature to help maintain meter log information for extended periods
of time.

NOTE: Ethernet is required to use the syslog feature.

Syslog is an open standard allowing you to use any one of a number of syslog server applications
currently available. The decision regarding which syslog server solution to use can be based on
budget and your technical requirements. See the individual syslog server’s documentation for
more information.

Configuring Syslog network settings using ION Setup
To configure Syslog network settings using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Communications > Advanced Ethernet > SysLog.

4. Select Enable Syslog and click Edit.

5. Select Yes to enable the syslog server feature or select No to disable it.

6. ClickOK.

7. Select Syslog Server and click Edit.

8. Enter the IPv4 address or an IPv6 address for the syslog server.

NOTE: You must enter the IP address for the syslog server, not the server’s fully-qualified
domain name.

9. ClickOK.

10. Verify that the Syslog server is receiving log information from the meter.

NOTE: If the Enable Syslog register is enabled but the Syslog Server register does not
contain an IP address, an event is generated in the event log to indicate that syslog is
enabled with no server IP.

Syslog severity to event log priority mapping
Syslog severities map to ION event priorities (0–255).

Only four of the syslog severities are used in the mapping.

Syslog severity ION event priority name ION event priority range

2 - Critical condition High 192–255



Syslog severity ION event priority name ION event priority range

4 - Warning condition Medium 128–191

5 - Normal but significant
condition

Low 64–127

6 - Informational None 0–63

Advanced log setup and memory optimization
You can configure your meter’s logs to help ensure the integrity of critical data and to optimize the
meter’s memory usage.

Before you configure your meter’s logs, it is important to understand how logging functions and
how the settings work together.

NOTE: Configuring your meter’s logs requires an in-depth understanding of the meter’s
memory, how the logs function and the data you are capturing.

Viewing log configuration and memory usage information
You can use ION Setup to view log settings and memory usage information for your meter’s
default logs.

This information can help you understand your log usage and how to optimize your logging
configuration for your situation.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Logging >Memory screen.

The Status tab:

Lists the default logs, their interval (Duration) and depth (Records), if applicable, and
the percentage of available memory used by the log.

Provides information on how much of the meter’s memory is used for system tasks in
the System Resources list item.

Displays the total meter memory and the percentage of memory in use versus memory
available.

Log depth configuration
You can change the number of records (depth) stored in the log.

Use ION Setup to change the maximum number of records (depth) stored in the log in the meter’s
long-term memory.

Data logs and circular-format waveform recorders have a minimum depth of 1 record. The
maximum depth is dependent on your meter’s memory and the configuration of your other logs.

Log interval configuration
You can configure the logging interval, which is how frequently records are logged.
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You can change the logging intervals for most logs using the ION Setup Assistant Logging >
Memory screen.

Changing the interval for other logs (for example, logs that are related to standards or triggered by
disturbances) is an advanced procedure that involves using the Advanced mode of ION Setup to
modify settings in the module that is linked to the log’s Record input. See ION Setup help and ION
Reference for more information.

Programming your meter to write to any data recorder at continuous intervals shorter than 60
seconds (heavy logging configuration) can cause loss of data in the event of a power failure.

NOTICE
DATA LOSS

Use an uninterruptible power supply (UPS) if you program your meter for heavy logging.

Failure to follow these instructions can result in data loss.

Log mode configuration
You can configure the log record mode, or how the log behaves when full.

Changing how the log records information (circular or stop-when-full) is an advanced procedure
that requires changing the RecordMode setup register in the Data Recorder andWaveform
Recorder modules.

A
Circular (FIFO) logging mode: when the log is full, a new record
overwrites the oldest record

B
Stop-when-full logging mode: when the log is full, any new records are
not logged



Log buffer configuration
The log buffer depth is the maximum number of records that can be stored in the meter’s short-
term memory (RAM) for a particular log.

After records are captured in the log buffer in the meter’s short-term memory, they are replicated
to the long-term memory. Because of inherent differences between short-term (volatile) and long-
term (non-volatile) memory, records can be added more quickly to the short-term memory than
they can be copied to long-term memory.

The logs in the default logging framework have their log buffer depths pre-configured to a value
suitable for most applications. But you can configure the log buffer depth for your applications, if
required (for example, to help ensure the continuity of critical data in high-speed logging
scenarios or to optimize usage of your meter’s memory for your particular logging configuration).

If you are logging data at high speeds, it is important to review your logging needs, and find the
right balance between data retention and memory optimization for your particular situation.

NOTE: If you get a message that you do not have sufficient memory when you try to create a
new log or change the configuration of an existing log, you may need to reduce the log buffer
depths of other logs in order to make memory available for the new log.

Fully buffered logs

A fully buffered log (e.g., a Data Recorder or Waveform Recorder module) is one where the value
of the Buffer Depth setup register is the same as the Depth setup register. This means the buffer
(short-term memory) is set up to use all the available long-term memory allocated for that log. This
ensures the buffer does not run out of space before all the records are replicated to the long-term
memory, regardless of the recording speed (i.e., the rate of record captures).

You may want to use this configuration if you are logging critical data (for example, revenue logs)
or logging data at frequent intervals (for example, intervals less than 60 seconds). However, it is
important to note that this configuration uses the most short-term memory, or RAM (the meter has
a maximum 10 MB of RAM available for the log buffer depth).

Partially buffered logs

A partially buffered log (e.g., for a Data Recorder or Waveform Recorder module) is one where
the value of the Buffer Depth setup register is less than the Depth setup register. This means the
buffer (short-term memory) is set up to use only a portion of the available long-term memory
allocated for that log. This configuration allows for a larger log size (i.e., number of records).
However this does not ensure that the buffer does not run out before all the records are replicated
to the long-term memory (e.g., in the case of high-speed recording).

You may want to use this configuration for logs with intervals greater than 60 seconds or with less
critical data. Because the records are partially replicated, this configuration uses less of the
meter’s short-term memory, or RAM, in a log that is otherwise configured the same. This allows
you to make more RAM available for other logs with a higher logging frequency or more critical
data.

However, depending on your configuration, there may be instances where the log buffer fills up
faster than it can replicate records to long-term memory. In this case, you may lose records and
see gaps in your data.
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NOTE: The Insert Outage Records functionality does not work if the data recorder is configured
as partially buffered. In order to use this functionality, you must configure the data recorder to be
fully buffered. See ION Reference, available from www.se.com, for more information about
configuring the Data Recorder module.

Example: Fully buffered log records replicated from short-term to
long-term memory

In the following example, the log buffer equals the log depth and all the records are replicated in
both the short-term memory and the long-term memory.

A Log buffer

B Long-term memory

C Total available space in the log buffer (for example, 20 records)

Example: Partially buffered log records replicated from short-term
memory to long-term memory

In the following example, the buffer depth equals 20. The first record has already replicated to the
long-term memory, making room in the log buffer for the new records (including the newest
record, in gray).



A Log buffer

B Long-term memory

C Total available space in the log buffer (for example, 20 records)

Example: Resulting gaps in data when a partially buffered log is
full

In the graphic on the left, the log buffer (A) is full, and the oldest record has not replicated to the
long-term memory yet. This means that the new record (C) is not logged, and is permanently lost.
In the graphic on the right, the oldest record (D) was replicated to long-term memory, making
space in the buffer. The new record at the next interval (E) is logged but there is a gap in the data
for the lost record (C).

A Log buffer

B Long-term memory
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C Record that cannot be logged because log buffer is full (this record is lost)

D Record moving from short-term memory to long-term memory

E New record at next interval

Changing log interval and depth settings using ION Setup
You can configure log intervals, log depths and buffer depths to optimize your memory usage.
Before you begin, make sure you understand:

• the structure of the meter’s logging framework

• the meter’s existing logging configuration

• your data logging requirements

Changing your meter’s log configuration deletes all existing records from that log.

NOTICE
DATA LOSS

Ensure that all important data is recorded before configuring a log.

Failure to follow these instructions can result in data loss.

The default log settings are designed to meet the needs of most users.

This procedure provides the steps for configuring settings for a subset of data logs using the ION
Setup Assistant. Configuring these settings for custom logs, and logs not listed in the Logging >
Memory screen, is an advanced procedure; see the ION Setup help for more information.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Logging >Memory.

4. Select the log you want to edit and click Edit.

5. Set the log depth and log interval as required for your logging needs.

Log Interval: you can change the interval units to seconds, minutes, hours or days.

Log Depth: You can set the depth in time (seconds, hours, days, etc.) or the number of
records.

NOTE: For some log types, you only set the log depth (for example, waveform recorders).

Log Memory shows the estimated impact of the changes on the total size of the log and
Log Storage displays the estimated available log memory on the meter.



NOTE: If you receive a message stating that there is not enough memory when you
change a log’s configuration, check the configuration of your meter’s other logs. You may
not have enough RAM, or short-term memory, to allow for the new configuration. You may
need to use Advanced mode to check the detailed configuration of your logs.

6. Click Finish.

NOTE: You may see a Next button instead of Finish. In this case, the next screen allows
you to configure the buffer depth for the log. The screen displays the overall log depth and
a field for setting the log buffer depth. It also shows the impact of the Buffer Depth setting
to your meter’s short-term memory (RAM).
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Time and timekeeping
Time and timekeeping overview

Your meter’s internal clock is used for keeping time, timestamping data, and determining intervals
for time-based measurements.

Local meter time is displayed based on the meter’s time sync source and the settings used for
time zone and daylight savings time. You can configure and view your meter’s date and time
information using ION Setup, or the display.

Your meter monitors time using the frequency of an internal oscillator or the frequency of the line
power being measured. Your meter’s battery powers the internal clock so that time is maintained
when the meter is unpowered.

Your meter supports different time types and time synchronization methods to adjust its internal
clock. To improve your meter clock’s accuracy, you can use an external time reference such as a
Global Positioning System (GPS) signal, Network Time Protocol (SNTP/NTP) server or Precision
Time Protocol (PTP) leader.

For more information, see the Time Synchronization and Timekeeping technical note, available
on www.se.com.

For more information on the Clock module, see ION Reference, available on www.se.com.

Internal clock temperature compensation
The time accuracy of the meter has been improved by compensating for clock drift if the meter’s
operating temperature falls outside the optimum temperature range.

Your meter’s internal clock is adjusted based on the internal clock temperature compensation
parameters.

Time synchronization
Your meter’s clock controls the timing of metering parameters, such as demand intervals or power
quality measurement aggregation over time intervals.

Adjustments to the clock are made by synchronizing the meter’s time with another time source,
determined by the Time Sync Source. Time synchronization messages can be automatically
generated and sent to your meter from your energy management system software or other time
sources such as an SNTP/NTP server, PTP leader, or GPS receiver. You can also manually
trigger a time synchronization message from your energy management system or configuration
software.

NOTE: To help maintain data integrity, some energy management systems impose a blackout
rule where time synchronization messages near energy interval boundaries are ignored.

https://www.se.com/ca/en/download/document/70072-0111-14/


Supported time synchronization sources
Several time synchronization sources are available to your meter.

Time sync
source

Description

Meter
configuration
software (ION
Setup)

Configuration software can manually synchronize the time of your meter
based on the clock of the computer running the configuration software.
Configuration software synchronization is usually performed when the meter
is initially commissioned.

Energy
management
system

Energy management systems can synchronize the time of your meter to be
consistent with other meters on the network.

GPS receiver
(IRIG-B)1

A GPS receiver using IRIG-B can synchronize the time of a meter up to ± 1
ms of Coordinated Universal Time (UTC). A dedicated serial network is
required to implement a GPS scheme. For IRIG-B, one of your meter’s
digital inputs must be connected to the IRIG-B network, and the digital input
must be configured for IRIG-B time synchronization in addition to
configuring your meter’s clock.

GPS over serial

A GPS receiver can synchronize the time of a meter up to ± 1 ms of
Coordinated Universal Time (UTC). For GPS over serial, your meter’s serial
port must be connected to a GPS receiver, and the serial port
communications must be configured with the correct protocol setting.

Simple Network
Time Protocol
(SNTP)

SNTP can synchronize the time of your meter up to ± 1 second of other
meters on an Ethernet network. For SNTP time synchronization, your meter
must be connected to an Ethernet network that has an active SNTP server
and be configured with the server’s information.

Network Time
Protocol (NTP)

NTP can typically synchronize the time of a meter to ± 10 to 100 ms,
depending on network configuration. To implement NTP time
synchronization, your meter must be connected to an Ethernet network that
has an active NTP server and be configured with the server’s information.

Precision Time
Protocol (PTP)2

PTP can synchronize the meter time to ± 1 ms of other devices connected to
a local area network. To implement PTP time synchronization, your meter
must have PTP selected as the time sync source and be connected to an
Ethernet network that has a valid PTP grandmaster.

1 Use the digital inputs located on the meter base for IRIG-B time synchronization and other high-
accuracy applications.
2 This clock precision assumes your meter is installed in a Star network topology only.

Clock source
The Clock Source setup register defines the meter’s representation of a one second period, and
can be set to:
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Setting option Description

Line Frequency

The meter monitors the ISO Grid Operation line frequency, and
adjusts the one second period based on the measured line
frequency. All devices connected to the grid network are
synchronized to maintain a consistent time base. If a power
outage occurs, the clock automatically synchronizes with the
meter’s internal crystal until power is restored. Once power is
restored, the clock resynchronizes with the line frequency.

NOTE: Do not use line frequency when your meter is
synchronized to an external time sync source.

Internal The meter clock is synchronized to the meter’s internal crystal.

Comm

The meter clock is synchronized to an external time sync source.
Use this for the Clock Source if:

• The Time Sync Source setup register is set to a serial
communications port to receive GPS time synchronization
signals.

• The Time Sync Source setup register is set to ETHERNET-PTP
and your meter is installed in a trusted PTP network.

• The Time Sync Source setup register is set to IRIG-B.

Clock source time quality flag
The meter’s clock source time quality flag is primarily used to report time quality information for
digital input events, such as status alarms, in Sequence-of-Events Recording (SER) applications.

The meter keeps track of the time difference between the meter’s internal clock and the time sync
source.

When the meter’s Clock module’s Use Clock Source Qual Flag is set to use flag, the Diagnostics
module’s Receiver Status output register is set to:

• LOCKED if the time difference between the GPS time sync source or PTP leader and meter
clock is within ±1 ms of each other

• UNLOCKED if the time difference between the GPS time sync source or PTP leader and meter
clock is greater than ±1 ms of each other

PTP system setting recommendations
By default, your meter is configured to be compatible in typical PTP supported systems.

In a PTP system, the grandmaster clock determines the reference time for the entire system. To
ensure correct implementation and operation of the protocol, it is recommended to set the
following parameters in your system grandmaster clock:



Parameter Setting Description

PTP device type
End to End
transparent clock

A transparent clock that supports the use of the end-to-
end delay measurement mechanism between slave
clocks and the leader clock.

Peer delay
mechanism

2 step
A clock that provides time information using the
combination of an event message and a subsequent
general message.

Clock domain 0–3
A logical grouping of clocks that synchronize to each
other using the protocol, but that are not necessarily
synchronized to clocks in another domain

Ethernet
switches

PTP V2
compatible

All switches and other devices in the network must
support IEEE 1588 PTP V2 to achieve the stated time
precision and accuracy

Star network topology
In addition to PTP system related settings, the accuracy of your meter clock also depends on your
physical network configuration. A star network topology is required to achieve the level of clock
precision specified.

A Ethernet switch or hub

B Ethernet connected meters

C PTP leader clock
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Configuring time information using ION Setup
You can set the time, date, and time synchronization settings using ION Setup.

NOTE: You must manually adjust the date and time information if the device is installed in a
different time zone location from the computer running ION Setup.

To configure time information using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your device.

3. Click Clock > Timezone.

4. Select any parameter, and then click TimeSync to synchronize your device’s date and time
with the computer that is running ION Setup.

NOTE: Time Sync Sourcemust match the device connection type to ION Setup for
TimeSync to work.

5. Click DST Settings to modify your meter’s daylight savings time (DST) start and end dates,
if required.

6. Select the parameter that you want to configure, and then click Edit. Enter the password if
prompted.

Parameter Value Description

TimeZone –

Sets the time zone based on the time zones
available from the computer’s operating system.

TIP: You can synchronize the computer's DST
settings with the meter while editing this
parameter.

Time Sync
Type

UTC or LOCAL

Specifies the time format of the time sync
message.

UTC (Coordinated Universal time) is equivalent to
Greenwich Mean Time (GMT).

LOCAL is the local time with DST and time zone
information applied.

For SNTP/NTP and PTP time
synchronization, set the Time Sync Type to
UTC.



Parameter Value Description

Time Sync
Source

COM1, COM4,
ETHERNET,
ETHERNET - ION,
ETHERNET - DNP,
ETHERNET - PTP,
IRIG-B

Sets which device port accepts time
synchronization messages.

Time synchronization messages on other ports
are ignored.

For GPS time synchronization, set the Time
Sync Source to COM1 (or COM4).

For SNTP/NTP time synchronization, set the
Time Sync Source to ETHERNET.

For ION time synchronization, set the Time
Sync Source to ETHERNET - ION.

For DNP time synchronization, set the Time
Sync Source to ETHERNET - DNP.

For PTP time synchronization, set the Time
Sync Source to ETHERNET - PTP.

For IRIG-B time synchronization, set the Time
Sync Source to IRIG-B.

Clock
Source

Internal, COMM, Line
Freq

Sets the source for the clock:

Internal: the meter’s internal clock.

COMM: the meter’s communication port
(used by the IRIG-B, GPS or ETHERNET -
PTP time sync source).

Line Freq: uses the measured line frequency
of the power system as the clock source.

DST Offset
Numeric Bounded
Format/Elapsed Interval
Format

Specifies the amount of time the displayed local
time is moved forward when entering Daylight
Savings. A value of zero disables this feature and
local time is not adjusted for DST.

Start of the
Week

Monday–Sunday

Specifies the start day of the week used for
Trending and Forecasting.

NOTE: Changing the start day of the week
clears all trending and forecasting data.

7. (Optional) If using SNTP/NTP time synchronization, enter the following information under
Communications > Advanced Ethernet > NTP:
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Parameter Value Description

Enable NTP
Time Sync

NTP, SNTP, No

NTP: specifies NTP time synchronization.

SNTP: specifies SNTP time synchronization.

No: neither NTP nor SNTP time synchronization are
used.

NTP Time Sync
Interval

Numeric value
or elapsed
interval value

Specifies how often the meter synchronizes over
SNTP

NOTE: This parameter is not used for NTP.

Event Logging
Threshold (NTP
and PTP only)

0.000001 to
1.000000

Specifies the minimum time difference (in seconds)
for a time synchronization to be logged as an event.

This parameter can be configured to help prevent the
meter’s event log from being flooded with time
synchronization events.

NTP Server
Server IP
address or
domain name

Specifies the IP address (or fully qualified domain
name if DNS is active) of the SNTP or NTP server.

8. (Optional) If using serial GPS time synchronization, enter the following information under
Communications > Serial settings:

Parameter Description

Protocol Select the GPS setting that matches your GPS receiver.

Baud rate
The recommended baud rate for GPS time synchronization is 19200
bps.

Serial port The recommended stop bits/parity for GPS time synchronization is 8N1.

Configuring time information using the display
Use the meter’s display to configure time parameters.

NOTE: If your device is installed in a region where DST is observed, it is recommended to use
ION Setup to configure the time zone for your locale.

1. Press Setup Menu > Date/Time/Clock Setup > Date & Time Setup.

2. Configure your time and date formats, time zone offset, and daylight savings time offset.
Press the down button to access the Clock Setup screen.

3. Configure the clock and time synchronization source, and the time synchronization time
format.



Parameter Values Description

Time Format 12 H, 24 H Specifies how the time is displayed.

Date Format
MM/DD/YYYY,
DD/MM/YYYY,
YYYY/MM/DD

Specifies how the date is displayed.

TZ Offset -12:00:00 to 13:00:00
Sets the time zone of the meter’s location,
relative to UTC.

DST Offset -3:00:00 to 3:00:00
Sets the daylight savings time offset of the
meter’s location.

Date and time setup

Parameter Values Description

Clock Source
Internal, Line Freq,
COMM

Specifies the time synchronization source.

Time Sync
Source

COM1, COM4,
ETHERNET, ETHERNET
- ION, ETHERNET -
DNP, ETHERNET - PTP,
IRIG-B

Specifies the port to receive time
synchronization signals.

Time Sync Type UTC, Local
Specifies whether time synchronization
signals are received in local time or UTC.

Clock setup
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Measurements
Energy

Your meter provides bi-directional, 4-quadrant, revenue accurate energy metering:

• kWh, kVARh, kVAh delivered and received

• kWh, kVARh, kVAh net (delivered minus received)

• kWh, kVARh, kVAh total (delivered plus received)

• Volt-squared-hours and amp-squared-hours

• Integration of any instantaneous measurement

Energy parameters can be logged automatically on a programmed schedule.

All energy values represent the total for all three phases.

Demand
Your meter supports several demand calculation methods, including block, rolling block,
synchronized and predicted demand.

It can measure demand on any instantaneous value and record peak (maximum) demand with
time and date information.

• kW, kVAR, kVA demand

• kW, kVAR, kVA peak demand

• Amps, Volts demand

Instantaneous measurements
Your meter provides one second and half-cycle true RMS readings.

Instantaneous readings include:

• 3-phase voltages (line-to-line, line-to-neutral): per phase and average

• Line-to-earth voltages per phase and V4, neutral-to-earth voltage

• 3-phase currents: per phase and average

• I4 and I5 currents, measured

• Residual current, calculated (I calc res)

• Active (kW), reactive (kVAR) and apparent (kVA) power: per phase and total

• Power factor per phase and total

• System frequency

• Voltage and current unbalance

• Phase reversal

Harmonics
Your meter provides harmonic distortion metering, recording, and real-time values for all voltage
and current inputs.



Your meter can measure and record:

• Individual harmonics, including magnitude and phase angle

• Interharmonics

• Total even harmonic distortion (TEHD)

• Total odd harmonic distortion (TOHD)

• Total harmonic distortion (THD)

• Total demand distortion (TDD)

• K-factor

• Crest factor

Min/max recording
Your meter records new minimum and maximum data every recording interval for a variety of
values.

• Voltage and current

• kW, kVAR and kVA

• Power factor

• Frequency

• Voltage unbalance

Power quality measurements
Your meter monitors the voltage channels to detect and record power quality events.

Disturbance event recording
The meter measures and records:

• Sag/swells: ITIC/CBEMA and SEMI curves

• Transients: 20 µs or longer on any voltage channel

Power quality standards logging
The meter logs power quality standards data according to:

• EN 50160, including Flicker

• IEC 61000-4-30 Class A

• IEEE 519

Advanced power quality features
The meter supports advanced power quality features:

• Disturbance Direction Detection: The meter can capture sag/swell and transient
disturbances, analyze the information, and determine the direction of the disturbance relative
to the meter. Determining the source of a disturbance more quickly and accurately helps
prevent repeat occurrences and also helps to minimize facility downtime.
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• COMTRADE: The meter can save waveform data in COMmon format for TRAnsient Data
Exchange (COMTRADE) format. COMTRADE data is available for download using an SFTP
client application.

• Setpoint learning: You can configure your meter to learn certain disturbance-related values.
For example, what constitutes a sag, swell, transient, or high or low setpoint.

Power and power factor
The sampled measurements taken at the meter’s voltage and current inputs provide data for
calculating power and power factor.

In a balanced 3-phase alternating current (AC) power system source, the AC voltage waveforms
on the current-carrying conductors are equal but offset by one-third of a period (a phase angle
shift of 120 degrees between the three voltage waveforms).

Power factor (PF)
Power factor (PF) is the ratio of real power (P) to apparent power (S).

PF is provided as a number between -1 and 1 or as a percentage from -100% to 100%, where the
sign is determined by the convention.

A purely resistive load has no reactive components, so its power factor is 1 (PF = 1, or unity power
factor). Inductive or capacitive loads introduce a reactive power (Q) component to the circuit
which causes the PF to become closer to zero.

True PF and displacement PF

The meter supports true power factor and displacement power factor values:

• True power factor includes harmonic content.

• Displacement power factor only considers the fundamental frequency.

NOTE: Unless specified, the power factor displayed by the meter is true power factor.

Apparent, active, and reactive power (PQS)
Apparent power (S) is the capacity of your measured power system to provide active (real power,
P) and reactive power (Q).

A typical AC electrical system load has both resistive and reactive (inductive or capacitive)
components. Resistive loads consume real power (P). Reactive power (Q) is either consumed
(inductive loads) or generated (capacitive loads).



Standard PF sign Description

IEEE + Leading power factor

- Lagging power factor

IEC + Positive active energy

- Negative active energy

The units for power are watts (W or kW) for real power P, vars (VAR or kVAR) for reactive power
Q, and volt-amps (VA or kVA) for apparent power S.

Positive real power P(+) flows from source to load, and negative real power P(-) flows from the
load to the power source.

Current phase shift from voltage
Electrical current can lag, lead, or be in phase with the AC voltage waveform, and is typically
associated with the type of load— inductive, capacitive or resistive.

For purely resistive loads, the current waveform is in phase with the voltage waveform. For
capacitive loads, current leads voltage. For inductive loads, current lags voltage.

The following diagrams show how voltage and current waveforms shift based on load type under
ideal (laboratory) conditions.
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Current and voltage in phase (resistive)

Current leads voltage (capacitive)

Current lags voltage (inductive)

Power demand
Power demand is a measure of average power consumption over a fixed time interval.

NOTE: If not specified, references to demand are assumed to mean power demand.



The meter measures instantaneous consumption and can calculate demand using various
methods.

Peak demand
Peak (or maximum) demand is the highest demand level recorded over the billing period.

Power utilities generally bill commercial customers based on their peak usage levels, called peak
demand (in kW) and energy consumption (in kWh). Peak (or maximum) demand is the highest
demand level recorded over the billing period. You can view peak demand values on your meter’s
display.

Your meter calculates the average current demand and kW, kVAR and kVA demand using sliding
window demand methods. It supports coincident demand values when a peak demand is
detected.

Your meter’s default configuration is suitable for most applications, or you can customize it for
your specific application. You can configure the minimum time between consecutive demand
resets.

NOTE: If not specified, references to demand are assumed to mean power demand.

Peak demand reset lockout
The demand reset lockout time sets the minimum time allowed between consecutive demand
resets; the meter ignores any attempts to reset demand that occur within the lockout period.

The peak demand reset lockout period is user-configurable (typical default value is 25 days).

See the ION Setup online help for instructions on how to configure demand peak and the demand
reset lockout period on your meter.

For more information on how Sliding Window Demand modules measure and calculate demand
values, see ION Reference, available on www.se.com.

Sliding window demand
To calculate demand values, your meter uses the sliding window averaging (or rolling interval)
method which divides the demand interval into a set number of subintervals of specified duration.

The demand is measured based on the average load level over the most recent set of
subintervals. Sliding window demand also provides predicted demand values.

Examples of sliding window demand
This example shows two different ways of configuring a 15-minute demand interval:

• Single interval (also called block or timed block): the 15-minute demand interval is defined as
a single subinterval with a duration of 15 minutes.

• Sliding window (also called rolling block): the 15-minute demand interval is defined as three
subintervals with a duration of 5 minutes each. This method offers better response time than a
single interval.

Single interval (block)
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A Calculation updates at the end of the interval

B Demand value is the average for the last completed interval

Sliding window (rolling block)

A Calculation updates at the end of the subinterval (5 minutes)

B Demand value is the average for the last completed interval

Incremental energy
Incremental energy allows you to define a start time, end time, and the time interval (increments)
for incremental energy accumulation.

At the end of each interval, the energy accumulated during that period is stored. By default, the
meter only records the previous interval’s incremental energy and the instantaneous energy
accumulations in the active interval.

The first interval of incremental energy accumulation begins at the specified start time.
Incremental energy ends at the specified end time, which may result in a truncated interval if the
interval duration does not divide evenly into the overall incremental energy duration. For example,
an interval duration of three hours with an overall duration of five hours truncates the last interval
duration to two hours. The latest value for the specified end time is midnight (24:00).



Your start time must be before the end time and after midnight, and the period over which
incremental energy is accumulated cannot include midnight. This is because your meter’s start
and end times are defined relative to midnight.

Start: 6AM, End:
12AM, interval: 3 hrs

Incremental energy accumulates from 6AM to midnight in intervals of
3 hours.

Start: 6AM, End:
2AM, interval: 3 hrs

Incremental energy will not function. End time must be after start
time and before or equal to midnight.

Incremental energy helps provide information for analyzing energy and power usage against
present or future utility rates, and is useful for measuring energy consumption by shift or for a
specific process.

When configuring incremental energy, shorter incremental energy periods provide more granular
data which can make the data easier to use for comparison purposes.

Example: Incremental energy
• Start time: 8AM or 08:00

• End time: 12AM or 24:00

• Interval: 420 minutes (7 hours)

A First interval (08:00 to 15:00)

B Second interval (15:00 to 22:00)

C Third interval (22:00 to 24:00)

The first incremental energy interval is from 8AM (start time) to 3PM, and is 7 hours long. The
second incremental energy interval is from 3PM to 10PM, and is also 7 hours long. The third
interval is from 10PM to 12AM, and is only 2 hours long because 12AM is the specified end time.
These intervals repeat every 24 hours until the configuration is changed or incremental energy
feature is disabled.
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Configuring incremental energy using ION Setup
You can configure incremental energy using ION Setup.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Incremental Energy.

4. Select Status and click Edit. The Incremental Energy Setup screen is displayed.

5. Select Enable to display parameters for configuration.

6. Select the parameter to configure.

NOTE: Configuring any parameter resets the incremental energy values recorded by your
meter.

Parameter Range Description

Start time
12:00 am to
11:59 pm

The incremental energy first interval’s start time. The
start time must be prior to the end time for energy
accumulation.

End time
12:01 am to
12:00 am

The end time for incremental energy.

The end time must be after the start time and be less
than or equal to 12AM (midnight).

Interval
duration

Configurable
The increment period for the incremental energy
duration.

7. ClickOK to save your changes.

Conditional energy
Conditional energy allows you to define an accumulation period for real and reactive energy using
one of your meter’s digital inputs.

You can use conditional energy to track four-quadrant accumulated energy during a specific
period. For example, you can track accumulated energy values during a particular process that is
controlled by a programmable logic controller (PLC).

Conditional energy is accumulated until it is reset. The conditional energy reset date and time
information is stored in the meter’s event log.

Configuring conditional energy using ION Setup
You can enable and configure conditional energy settings using ION Setup.

When configuring your meter, the configuration interface may show all of the possible ports,
regardless of what is physically available on your meter.

One of your device’s digital inputs must be connected and configured to define when conditional
energy is accumulated.



1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Energy Applications > Digital Input Based. Review the digital inputs assigned to
applications to help ensure there are no conflicting usages.

4. Select Conditional Energy and click Edit. The Conditional Energy Setup screen is
displayed.

5. Click Enabled to enable the conditional energy feature.

6. Click Select to define the digital input. The input’s state determines whether conditional
energy is accumulated. When this digital input is on, conditional energy is accumulated.

NOTE: It is recommended to set Assigned Input to No Connection to disable the
conditional energy feature by removing any port associations.

7. ClickOK to save your configuration.

Trending and forecasting overview
Trending and forecasting is a feature on your device that predicts the next set of measured or
calculated data by plotting and analyzing trends in historical data.

Trending and forecasting data is a useful tool to help analyze changes in load and power quality
and forecasting values such as demand. For your meter’s trending and forecasting feature to
work, you only need to give the meter time to accumulate data.

For more information on the Trending and Forecasting module, see ION Reference, available on
www.se.com.

Trending and forecasting implementation
Data used for trending and forecasting is logged for specific intervals:

• Every hour for the last 24 hours

• Every day for the last month

• Every week for the last 8 weeks

• Every month for the last 12 months

The following parameters are configured for trending and forecasting using ION Setup:

kW sd del-rec (demand) Freq (frequency)

Vll ab I a mean

Vll bc I b mean

Vll ca I c mean

Vll avg I avg mean

You can configure the start day of the week for trending and forecasting using the Clock setup
assistant in ION Setup.
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Viewing trending and forecasting data on your meter’s webpages
You can select data for forecasting and trending and view the resulting information using your
meter’s webpages.

For trending and forecasting to operate, your meter must have accumulated data for at least two
of the specified intervals. For example, if you want to view a daily graph, your meter must have
accumulated data for at least two previous days before the present day.

To view trending and forecasting data on your meter's webpages:

1. Log in to your meter’s webpages.

2. ClickMonitoring > Trending & Forecasting.

3. Select the Target and Interval. The graph for the selected data is displayed.



Resets
Resets overview

Resets allow you to clear accumulated parameters stored on your meter, reinitialize the meter or
reinitialize meter accessories.

Meter resets clear your meter’s onboard data logs and other related information. Resets are
typically performed after you make changes to the meter’s basic setup parameters to clear invalid
or obsolete data to prepare the meter for active service.

NOTE: Revenue-locked meters must be unlocked to perform resets that impact revenue data.
For more information, see Revenue locking your meter.

Option modules reset
Perform an option module reset if your option modules are not communicating with your meter.

During an option module reset, the option module may not operate normally, and digital and
analog outputs may change state.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

You can reset your meter’s option module bus using ION Setup or the display. This power cycles
all the modules attached to your meter. If you have queued firmware updates for option modules
on your meter’s internal SFTP site, the firmware updates are performed.

By default, your meter is configured to automatically perform an option module bus reset to help
keep the option modules operating normally. Contact Technical Support for instructions on
changing this default configuration.

Available resets
You can perform meter resets using:

• ION Setup

• The meter webpages

• The display
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Reset Description

Master Reset

• Clears all cumulative and derived quantities from the meter,
including: demand, peak demand, energy, revenue, and test
mode parameters.

• Clears meter event and waveform logs.

• Clears COMTRADE waveform records stored in the meter’s
internal SFTP site.

• Clears meter data logs.

Peak Demand Reset

Clears meter peak demand values.

NOTE: The peak demand reset has a lockout period that sets
the minimum time allowed between consecutive resets.

Min/Max Reset Clears maximum and minimum values stored in the meter.

Digital Input Count Reset Clears the digital input status change counters.

Harmonics Min/Max Reset
Clears maximum and minimum harmonics values stored in the
meter.

Disturbance Count Reset
Clears the sag/swell event counter. The sag/swell event counter
counts the number of sag/swells that have occurred since the last
reset or meter power-up.

EN50160 Reset
Clears all EN 50160 parameters and statistics accumulated in the
meter.

Option Modules Reset
Resets communications to expansion modules connected to the
meter.

Conditional (Cnd) Energy
Reset

Clears the conditional energy values stored in the meter.

Input Metering Reset Clears the input metering values stored in the meter.

Performing resets using ION Setup
You can reset the meter using ION Setup.

Revenue-locked meters must be unlocked to perform resets that impact revenue data. For more
information, see Revenue locking your meter.

Meter resets clear the meter’s onboard data logs and other related information.



NOTICE
DATA LOSS

Save all important data from the device before performing a reset.

Failure to follow these instructions can result in data loss.

To reset the meter using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Verification.

4. Select Normal Mode and click Display.

5. Select the desired tab in the Normal Mode dialog box. Depending on the tab selected,
different resets are available.

Tab Reset available

Energy Master Reset

Rolling Demand
Peak Reset

Master Reset

Volts, Amps and Power Master Reset

Conditional Energy
Cnd Reset

Master Reset

Input Metering
IM(n) Reset

NOTE: n is the input metering number, for example IM1.

6. Click the appropriate button to perform the reset. For some resets, the meter indicates that
the reset is in progress.

NOTE: Do not configure or power down your meter until it indicates that the reset is
complete or some parameters may not be completely reset.

Performing resets using the meter webpages
You can reset the meter using the meter webpages.

Revenue-locked meters must be unlocked to perform resets that impact revenue data. For more
information, see Revenue locking your meter.

Meter resets clear the meter’s onboard data logs and related information.
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NOTICE
DATA LOSS

Ensure all important data from the device has been retrieved before performing a reset.

Failure to follow these instructions can result in data loss.

To reset the meter using the meter webpages:

1. Connect to your meter’s webpages.

2. Browse to Control > Resets.

3. Click Reset for the values you want to clear.

Parameter Description

Master Reset

Clears all cumulative and derived quantities from the
meter, including: demand, peak demand, energy,
revenue, and test mode parameters.

Clears meter event and waveform logs.

Clears COMTRADE waveform records stored in the
meter’s internal SFTP site.

Clears meter data logs.

Peak Demand Reset

Clears meter peak demand values.

NOTE: The peak demand reset has a lockout period that
sets the minimum time allowed between consecutive resets.

Min/Max Reset
Clears all accumulated maximum and minimum values stored
in the meter.

Digital Input Count Reset Clears the digital input status change counters.

Harmonics Min/Max
Reset

Clears all accumulated maximum and minimum harmonics
values stored in the meter.

Disturbance Count Reset

Clears the sag/swell event counter. The sag/swell event
counter counts the number of sag/swells that have occurred
since power-up or the last reset to provide power quality
information to energy management systems.

EN50160 Reset
Clears all EN50160 parameters and statistics accumulated in
the meter.

Performing resets using the display
You can reset the meter using the display.

Revenue-locked meters must be unlocked to perform resets that impact revenue data. For more
information, see Revenue locking your meter.



Your meter’s digital and analog outputs may change state or may not function during resets.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Meter resets clear the meter’s onboard data logs and related information.

NOTICE
DATA LOSS

Ensure all important data from the device has been retrieved before performing a reset.

Failure to follow these instructions can result in data loss.

To reset the meter using the display:

1. Select .

2. Select Setup Menu > Resets.

3. Select .

Enter your meter’s username and password.

4. Press the up or down icons to navigate available resets. A gray bar appears behind the
active selection.

Reset Description

Master Reset

Clears all cumulative and derived quantities from the meter,
including: demand, peak demand, energy, revenue, and test
mode parameters.

Clears meter event and waveform logs.

Clears COMTRADE waveform records stored in the meter’s
internal SFTP site.

Clears meter data logs.

Peak Demand
Reset

Clears meter peak demand values.

NOTE: The peak demand reset has a lockout period that sets the
minimum time allowed between consecutive resets.
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Reset Description

Min/Max Reset
Clears all accumulated maximum and minimum values stored in the
meter.

Digital Input Count
Reset

Clears the digital input status change counters.

Harmonics
Min/Max Reset

Clears all accumulated maximum and minimum harmonics values
stored in the meter.

Disturbance Count
Reset

Clears the sag/swell event counter. The sag/swell event counter
counts the number of sag/swells that have occurred since power-up
or the last reset to provide power quality information to energy
management systems.

EN50160 Reset
Clears all EN 50160 parameters and statistics accumulated in the
meter.

Option Modules
Reset

Resets communications to expansion modules connected to the
meter.

5. Press the Check Box icon.

TIP: You can select more than one reset.

6. Select to reset the selected options.

When you selectMaster Reset, the message all recorded data will be lost.

Reset selected parameters? is displayed.

7. Select to confirm.



Firmware upgrades
Firmware upgrades overview

It is recommended to upgrade PowerLogic™ ION9000 advanced power quality meters to the
latest firmware version.

Firmware version pre-v2.1.0

Before upgrading to the latest firmware version, firmware version 2.1.0 must have been
previously installed. Go to www.se.com, and then search for Upgrading Meter Firmware to v2.1.0
for information on that upgrade.

TIP: Firmware version can be identified using ION Setup, meter webpages, or the display.

Meter firmware includes a digital signature which helps ensure authenticity.

Obtaining meter upgrades
To find a recent firmware package, search for your meter type and Firmware and Associated
Files.

Download the firmware upgrade package (ZIP) from www.se.com.

Upgrade information
Meter firmware

Ameter upgraded to firmware version 4.5.0 or later cannot be downgraded to an earlier firmware
version.

NOTICE
LOSS OF DOWNGRADE CAPABILITY

Do not upgrade to firmware version 4.5.0 or later if you need to downgrade the meter in the
future.

Failure to follow these instructions can result in loss of firmware downgrade
functionality.

Upgrade agent

When upgrading to firmware to version 2.1.0 or later, use upgrade agent version 2.1.0 or later.

Restart requirement
Meter restart is required.

Legacy security support
Legacy security support is an interim solution for users that use Standard security mode and is the
default setting for new meters. It provides backwards compatibility with older software
communicating with the meter using ION protocol.
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If Standard security was used before upgrading meter firmware to v3.0.0, Legacy security support
is enabled.

If Advanced security was used before upgrading meter firmware to v3.0.0, Advanced security is
enabled.

RECOMMENDATION: Use Advanced security mode.

Legacy security
support username

Legacy security
support password

Legacy security
support password
range

Legacy security
support password
limit

User1

• Same password
used before
upgrade to
firmware version
3.0.0., or

• 0 (zero) for new
meters.

0–99999999 8 characters

Switch ION Setup into Advanced mode to setup multiple user accounts for meters using Legacy
security support: Open ION Setup > Ctrl + click on the meter to select it.

Meter firmware upgrade prerequisites
Perform back ups of all meter data, download latest ION Setup, and check the connection
requirements before upgrading.

Ensure that the firmware version you are upgrading to is compatible with your meter and the
version number is greater than your existing firmware.

Back up custom meter webpages
Back up webpage files if they were customized.

The upgrade process overwrites all existing meter webpages.

NOTICE
LOSS OF CUSTOM WEBPAGES

Back up custom webpages before upgrading the meter firmware.

Failure to follow these instructions can result in loss of custom webpage functionality.

To back up meter webpages, copy theweb folder to a local folder on the computer using an SFTP
client application.

Back up custom meter frameworks
Back up the meter template if the meter uses a customized meter template or frameworks.



The upgrade process overwrites all existing meter frameworks.

NOTICE
LOSS OF CUSTOM FRAMEWORKS

Back up custom frameworks before upgrading the meter firmware. The upgrade process
overwrites existing meter frameworks.

Failure to follow these instructions can result in loss of custom framework
functionality.

Back up accumulated energy values
Record the accumulated energy values on the meter before upgrading. Re-enter these values
after the upgrade. See Editing accumulated energy values using ION Setup.

Download latest ION Setup
To upgrade meter firmware, the most recent version of ION Setup is required.

1. Start ION Setup.

2. Click Help > Check for Updates.

3. Open a web browser and go to https://www.se.com/en/download/document/ION_Setup_
Latest_Release/ to download the latest version of ION Setup.

4. If you do not have the most recently released version, download the installation file, then run
it to upgrade ION Setup.

Connection requirements
• Use a direct Ethernet TCP connection to prevent delays and upgrade failure risks associated
with slower communications connection methods. You cannot perform certain firmware
updates over serial or Ethernet gateway.

• The display, webpages and option module firmware updates require an SFTP over Ethernet
connection.

• Use a computer connected to the same Ethernet network as the meter (physically or through
a remote desktop connection).

• To upgrade option module firmware, the option modules must be connected to the meter.

Meter firmware upgrades
Use individual files such as UPX, BIN and S19 file formats to upgrade or use the firmware
upgrade ZIP file with ION Setup (recommended).

Do not interrupt the upgrade process until all updates are complete.
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NOTICE
UPGRADE FAILURE

Do not interrupt the upgrade process or disconnect the meter or any connected components
while ION Setup is performing the firmware upgrades.

Failure to follow these instructions can result in loss of meter functionality.

Option 1 (recommended) – Upgrading using ZIP file
This is the recommended method of upgrading your meter. This method can also be used for
sequential device upgrades.

Any digital and analog outputs associated with your device may change state during a firmware
upgrade.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

Loading firmware or template onto your meter clears the meter’s recorded data.

NOTICE
DATA LOSS

Ensure that all important data has been recorded before uploading firmware or a template to
your device.

Failure to follow these instructions can result in data loss.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Template > Upgrade.

4. Click Upgrade and navigate to the saved upgrade ZIP file.

5. Select the upgrade ZIP file and clickOpen. The Compressed Device Upgrade Package
window displays the updates to be installed in the order listed.



NOTE: Click the View What’s New PDF link to read about new and updated features
related to the firm upgrade.

6. Select the components you want to upgrade. For example:

ION9000 firmware V3.0.0 package to be applied in the order listed:

UpgradeAgent_V002.001.000.upx (not required if already applied)

V003.000.000.upx

Factory V2.2.0.0.0 template is the meter template that is programmed to the meter
after the firmware upgrade is complete.

Factory V3.0.0 web pages are the files to be uploaded to the meter’sweb SFTP folder,
to update the meter webpages with firmware-related changes.

7. Select the desired settings and readings to be retained, if you selected a template
component:

8. ClickOK.
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9. Click Proceed to start the upgrade process.

10. Confirm upgrade status is complete and upload webpages to the meter. See Status for
details.

Option 2 – Upgrading using individual upgrade files
Refer to the “Firmware and templates” section in the meter’s user manual for detailed instructions
on how to upgrade the meter, display and option module firmware.

1. Follow tasks in the order listed:

a. UpgradeAgent_V002.001.000.upx

b. V003.000.000.upx

To retain your meter settings, select a meter template file (DCF) to paste into the meter
when performing a and b firmware upgrades. Use the Template Paste Options box to
specify the settings to retain after the upgrade.

NOTICE
LOST SETTINGS

Always select a template file when upgrading the meter firmware.

Failure to follow these instructions can result in loss of meter settings.

2. Confirm upgrade status is complete and upload webpages to the meter. See Status for
details.

Status
After all required meter firmware updates are complete, ION Setup continues to perform the
remaining updates.

• If you selected to upgrade the template, ION Setup will paste the template into the meter.

• If you selected to upgrade PM89RD96 remote display firmware, ION Setup will perform the
display upgrade through the connected DIN rail-mounted meter.

Upgrading display firmware
For more information, see the Upgrade PM89RD96 display firmware to v4.0.15 technical note,
available on www.se.com.

Upgrading option module firmware
You can upgrade option module using ION Setup or directly through the meter's internal SFTP
site.

1. Go to www.se.com and search for the METSEPM89M0024 or METSEPM89M2600
firmware file.

2. Download the firmware file.

https://www.se.com/ca/en/download/document/7EN72-0202/


Loading option module firmware using ION Setup
Upload firmware to option modules using ION Setup over an Ethernet connection. Each option
module must be upgraded individually.

Prerequisites:

• Option module firmware upgrade (.S19) file(s). Go to www.se.com to download upgrade files.

• Option module is connected to the meter.

• Access to meter’s internal SFTP site.

Digital and analog outputs may change state during a firmware upgrade. Option modules are
offline during an option module firmware upgrade; they will not communicate to the meter and the
outputs may change state during the upgrade process.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

If your meter’s option module loses power during firmware upload, the option module will revert to
its original firmware and you will have to reload the firmware file.

To load firmware option module firmware using ION Setup:

1. Obtain the Option Module firmware files (.S19) that you want to load onto your option
module(s). Save the files where they can be accessed by the computer running ION Setup.

2. Start ION Setup.

3. Open the Setup Assistant for your meter.

4. Select the Template screen.

5. Click the Upgrade tab, then click Upgrade. Enter your meter’s password if prompted and
clickOK.

6. Navigate to where you have stored the option module firmware. Select the Option Module
firmware file (*.S19) as the file type.

7. Select the option module firmware file and clickOpen.

An ION Setup window will open. Click Yes to confirm the firmware upgrade.

8. The Option Card Upgrade window opens. Select the Slot that corresponds to the Option
Module type. You can select multiple slots for the same option module type.

9. Click Start.

A dialog box describes the firmware upgrade progress, verifies the firmware, and finishes
with an overview stating whether the firmware was successfully uploaded.
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Loading option module firmware using SFTP
Upload firmware to your meter’s option modules by loading the firmware upgrade file onto your
meter’s internal SFTP site. Each option module must be upgraded individually.

Prerequisites:

• Option module firmware upgrade (.S19) file(s). Go to www.se.com to download upgrade files.

• Option module is connected to the meter.

• Access to meter’s internal SFTP site.

The meter’s digital and analog outputs may change state during a firmware upgrade. Option
modules are offline during an option module firmware upgrade. They will not communicate to the
meter and the outputs may change state during the upgrade process.

WARNING
UNINTENDED OPERATION

Do not use this device for critical control or protection of persons, animals, property, or
equipment.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

NOTE: If your meter’s option module loses power during firmware upload, the option module
will revert to its original firmware and you will have to reload the firmware file.

To load firmware option module firmware using SFTP:

1. Connect to your meter’s internal SFTP site.

2. Open the (optionModuleUpg) folder.

3. Open the option module folder that applies to the module to be upgraded.

4. Drag the option module firmware file into the option module upgrade folder.

The file is immediately transferred to the option module, and is not stored on the meter.

5. Review the option module firmware upgrade details stored in the meter’s event log to
confirm that the upload was successful. The upgrade folder must match the position of the
option module (A through D).



Maintenance
Maintenance overview

The meter does not contain any user-serviceable parts. If the meter requires service, contact your
local Schneider Electric Technical Support representative.

NOTICE
METER DAMAGE

• Do not open the meter case.

• Do not attempt to repair any components of the meter.

Failure to follow these instructions can result in equipment damage.

Do not open the meter. Opening the meter voids the warranty.

Editing accumulated energy values using ION Setup
You can edit energy values such kWh and kVARh using ION Setup.

NOTE: Ensure you have recorded accumulated energy values before upgrading your meter’s
firmware. You can then re-enter these values after the upgrade.

NOTE: Revenue-locked meters must be unlocked before accumulated energy values can be
edited. See Revenue locking your meter for more information

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Click Template.

4. Click the Register Edit tab, click Energy then click Display. Enter your meter’s password (if
prompted) and clickOK.

The Register Editor screen displays.

5. Click Edit to enable editing.

6. Enter values for kWh, kVAh and kVARh as required. Click Send to finish.

NOTE: Only values that have the check box selected will be sent to the meter.

7. Click Close to close the Register Editor screen.

Restarting the meter using the display
You can restart your device using the display to help troubleshoot issues.

PowerLogic™ ION9000 series - User manual Maintenance

7EN02-0390-10 Public 307



Maintenance PowerLogic™ ION9000 series - User manual

308 Public 7EN02-0390-10

NOTE: The device will be unavailable during the restart.

Prerequisites:

• User with security configuration access.

Performing a restart using the display

WARNING
HAZARD OF UNINTENDED OPERATION
• Do not use the meter for critical control or protection applications where human or
equipment safety relies on the operation of the control circuit.

• Be aware that an unexpected change of state of the digital outputs may result when the
supply power to the meter is interrupted or after a meter firmware or template upgrade.

Failure to follow these instructions can result in death, serious injury, or equipment
damage.

To perform a restart using the display:

1. Open Setup Menu.

TIP: To open the Setup Menu, select , and then scroll to Setup Menu.

2. Scroll toMeter Restart, and then select .

3. If prompted, enter the device credentials, and then selectOK.

4. Select to confirm theMeter Restart.

Verifying the meter restarted
After performing aMeter Restart, verify that the meter restarted by finding the logged meter
restart event.

To find a logged meter restart event using the display:

1. Select .

2. Use the navigation buttons to scroll to Events, and then select .

3. Select the latest event, and then select .

TIP: The first event in the list is the latest event.

4. Confirm that the event details includes:

Date

Time

Source: Front Panel

Event: Meter restart



NOTE: The date and time event details should match when you performed a the
meter restart.

Test mode
Test mode is typically used for verifying meter functions.

The meter is usually reading data from a test power supply while function verification is
performed.

The values shown in the test mode display screens represent different accumulators than those
shown in norm or alt mode (although they perform some of the same basic measurements). The
test mode display values are for accuracy checking purposes; they only accumulate while the
meter is in test mode.

You can create custom test mode screens and modify the existing test mode screens.

NOTE:

• You cannot place revenue-locked meters into test mode.

• All of the billing quantities that are recorded when the meter is in Normal mode stop
accumulating when the meter is switched to test mode – the data is sent to special test
mode registers instead.

• The values accumulated in these test registers are displayed on the test mode displays and
in ION Setup.

• The regular normal mode billing registers are unaffected while the meter is in test mode;
accumulation of this data continues as soon as you exit test mode.

• All test registers are reset to zero when you exit test mode.

Test mode default screens
Your meter has default test mode display screens.

NOTE: You can modify the test mode display screens or add custom screens using ION Setup.

Screen Description

Demand test
This screen shows test mode kW delivered and received values.
Both quantities are produced from a sliding window (rolling block)
demand calculation.

Reactive energy test
This screen shows test mode kVARh delivered and received
values.

Active energy test This screen shows test mode kWh delivered and received values.
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Putting your meter in test mode using ION Setup
Prerequisites:

• To put your meter into test mode, your meter must be:

a. Revenue-unlocked

OR

b. In a pending state (pending lock or pending unlock)

If you are unsure of the meter revenue-lock state, see Revenue lock LED behavior.

To put your meter into test mode using ION Setup:

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Navigate to Verification and then select Verification.

4. Select Test Mode and then select Display.

Your meter is now in test mode, and the Test Mode screen is displayed.

5. Select the different tabs to view your meter’s test mode values and modify test mode
parameters.

6. Select Close to exit test mode.

Putting your meter in test mode using the display
You can put your meter into test mode using the display.

Prerequisites:

• To put your meter into test mode, your meter must be:

a. Revenue-unlocked

OR

b. In a pending state (pending lock or pending unlock)

If you are unsure of the meter revenue-lock state, see Revenue lock LED behavior.

To put your meter into test mode using the display:

1. Select .

2. Navigate to Normal Display Mode.

3. Select .

4. Navigate to Test Mode.

5. Select to open the Test Mode Screens. If prompted, enter the meter username and
password.

The Test Modemenu displays briefly before switching to the first Test Mode screen.

6. View the test mode screens by pressing or .

7. Select to return to Test Mode Screens.



8. Select to highlight Exit Test Mode, and then select .

If prompted, enter the meter username and password.

Cleaning instructions
Your meter is rated for Pollution Degree 2: Normally, only non-conductive pollution occurs.
Occasionally, however, a temporary conductivity caused by condensation may be expected.

You should periodically inspect and clean your meter. Non-conductive pollution could negatively
impact the meter by impeding air flow and cooling. Abrasive contaminants can reduce the meter
lifespan.

NOTE: The meter is rated as IP30 (not protected from liquids.) The front of the meter display is
rated as IP54 (dust and water resistant) or IP65 (dust and water proof.) To review your meter's
display specifications, see Display.

Prerequisites:

• Turn off all power supplying the device before cleaning it.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

• Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

• Always use a properly rated voltage sensing device to confirm that all power is off.

• Do not use the data from the meter to confirm power is off.

• Do not short secondary terminals of Voltage Transformer (VT).

• Do not open secondary terminals of Current Transformer (CT).

• Secure CT or Low Power Current Transformers (LPCT) secondary conductors to ensure they
do not contact live circuits.

• Assume communications and I/O wiring are hazardous live until determined otherwise.

• Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

To clean the meter and accessories: 

• Use compressed air (up to 30 PSI or ~200 kPa) to remove non-conductive pollution from
inside and around the meter or any of its accessories.

• Clean meter surfaces using a cloth dampened with water. *

NOTE: Do not allow liquids to enter the device through ventilation slots, connectors, or
other openings.
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• If you are not certain about how to remove abrasive contaminants from the meter or its
accessories, contact Support or your Schneider Electric representative. Improperly removing
contaminants and pollution may void the warranty.

To clean the display:

• Wipe the display using a cloth dampened with water. *

* You can use 70% isopropyl alcohol instead of water if absolutely necessary. Cleaning the device
too frequently with isopropyl alcohol could damage the printing on labels and buttons. If you are
concerned about the risk of infection from touching surfaces, wear gloves or use hand sanitizer
afterward.

Device-specific information
Manufacturing-related information about the meter is available from the Factory module or using
Modbus commands.

The meter’s Factory module stores meter details such as:

• Device Type

• Serial Number

• Vendor Name

• Options

NOTE: The Options register holds the device Commercial Reference for devices shipped
with firmware version 4.6.0 or later.

You can use ION Setup in advanced mode to view the contents of the Factory module’s setup
registers. Similarly, you can use Modbus commands to read the Modbus registers mapped to the
corresponding Factory module’s registers.

NOTE: Not all ION device setup registers are mapped to Modbus registers by default.

For more information on the Factory module, see ION Reference, available on www.se.com.



Revenue
A revenue meter provides, over a defined range of operating conditions, measurements that are
within international and national defined standards and industry-accepted accuracy limits.

It also provides protection against unauthorized alteration of these measured quantities. National
and utility-based standards regulate protection against unauthorized alteration of measured
quantities.

Revenue metering components
To meet government regulations and utility security requirements, the meter incorporates three
types of security systems:

• Traditional anti-tamper mechanical seals on the meter. See your device installation guide.

• Passcode entry to reset meter values, for example, Master reset.

• Hardware locking mechanism that prevents modification of revenue quantities after they are
locked.

Revenue firmware security features
Your revenue meter has additional firmware security features:

• Your firmware upgrades are recorded in your meter’s upgrade log. Contact Technical Support
for information on upgrade log retrieval.

• When revenue-locked, you cannot perform resets, configure some revenue-specific
parameters, or upgrade your meter.

Protected features and settings
Your revenue meter has features and settings that cannot be changed while revenue-locked.

In order to prevent changes to revenue-related features, settings and meter data, you can apply
revenue-locking after all revenue-metering setup is complete. See the ION Device Template
Reference, available from www.se.com, for a complete listing of revenue-locked features and
settings.

Revenue locking
Revenue locking might be required to help meet government regulations and utility security
requirements.

Revenue locking your meter helps:

• Prevent changes to revenue-related features, settings, and meter data.

• Prevent tampering with your meter’s voltage and current connections.

• Ensure the validity of revenue data.

See the meter’s catalog pages, available from www.se.com, or consult your local Schneider
Electric representative for information about your device, its options and accessories.

Revenue-locking summary
You must configure and revenue lock your meter before installing it.
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• Unlock your revenue meter if it is locked.

• Configure the required revenue settings specific for installation.

NOTE: If you are using ION Setup to configure your meter, allow for any communication
delays before removing power to your meter.

• Verify the revenue settings have been implemented.

• Clear all accumulated meter data.

• Revenue lock your meter.

• Verify the meter is revenue-locked.

• Install the meter and install the terminal covers according to your meter’s installation guide.

Revenue lock switch
The revenue lock switch located on the meter base is used to revenue lock your meter.

This switch is accessed through a sealable cover.

A Revenue lock switch cover

B Sealing point

C Toggle switch

D Revenue lock LED

Revenue lock LED behavior
The revenue lock LED indicates the lock status of the meter.

LED behavior Revenue lock status

Off The meter is not revenue locked.



LED behavior Revenue lock status

On The meter is revenue locked.

Flashing
New revenue lock state is pending; power cycle your meter to set the
revenue lock to on or off.

To help find your revenue lock LED, see Display overview.

Revenue locking your meter
You can lock and unlock your meter using the revenue lock switch located on the meter base.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

• Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

• Always use a properly rated voltage sensing device to confirm that all power is off.

Failure to follow these instructions will result in death or serious injury.

1. Open the revenue lock switch cover.

2. Locate the revenue lock switch.

3. Toggle revenue lock switch on or off.

4. Close the revenue lock switch cover and make sure it is firmly in place.

5. Seal the revenue lock switch cover if required.

Anti-tamper sealing
The meter has several anti-tamper sealing points which can be sealed by a wire seal or lock.

In certain countries, the meter is no longer revenue certified if the anti-tamper seals are broken.

See your meter’s installation guide for sealing point locations.

NOTICE
LOSS OF COMPLIANCE

Re-certify your meter with the appropriate revenue metering authorities if you remove the anti-
tamper seals.

Failure to follow these instructions may render your device non-compliant for billing
purposes.

Revenue lock switch seal
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PT/CT correction
Potential transformer/current transformer correction (PT/CT correction), also called instrument
transformer correction, can help reduce the need to replace transformers in installations where
high accuracy is required.

The primary application for PT/CT correction is to apply correction factors for ratio errors and
phase angle errors to instrument transformers. PT/CT correction is done for each current and
voltage input to the meter and only affects 1-second power meter data and values derived from it,
such as energy or demand. No high-speed, harmonics or waveform values are affected by the
correction.

NOTE: For those familiar with ION architecture, the relevant 1-second Power Meter module
outputs are compensated using the Instr Xformer (ITC) Correction module. All other modules
that use the 1-second Power Meter module’s data are also compensated.

See the ION Setup online help, available from www.se.com, for instructions on how to configure
PT/CT correction on your device.

For more information about the Instr Xformer Correction (ITC) module and how it applies PT/CT
correction to your device, see ION Reference, available on www.se.com.

Transformer loss compensation
Transformer Loss Compensation (TLC) is the method for compensating for the measurable
losses that occur when there is a physical separation between the meter and the actual billing
point.

TLC is used when a meter’s actual location is different from the electrical location where change
of ownership occurs, for example, if meters are connected on the low-voltage side of power
transformers but the ownership change occurs on the high-side of the transformer. Meters are
usually installed on the low-voltage side of a transformer because it is more cost-effective



NOTE: Due to the variation in installations, advanced knowledge of power systems and
connection methods is required before transformer loss compensation can be properly
implemented. Data parameters should only be programmed by qualified personnel that have
appropriate training and experience with Transformer Loss Compensation calculations.

There are cases where the change of ownership occurs halfway along a transmission line, where
it is impractical to install a meter. In this case, power metering must be compensated using line
loss calculations.

For more information, see the PowerLogic Transformer Line Loss Calculations technical note,
available on www.se.com.

Time of use
Time of Use (TOU) is often used when a utility has set up schedules with different rates based on
time of day, type of day and date when energy is consumed.

You can view the TOU active rates and seasons using the display.

For more information on how to configure TOU on your meter, see the ION Setup online help,
available from www.se.com.

For more information on the Time of use module and its settings, see ION Reference, available on
www.se.com.

Energy pulsing LED behavior
The visible and infrared LEDs are configured by default to pulse based on energy measured by
the meter.

You can configure the pulse weight (pulses per kWh) and the energy source.

Energy pulsing is used to help verify the energy measurement accuracy of your meter for revenue
purposes.
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Verifying accuracy
Verifying accuracy overview

All meters are tested and verified at the factory in accordance with International Electrotechnical
Commission (IEC) and American National Standards Institute (ANSI) standards.

Your digital power meter typically does not require re-calibration. However, in some installations a
final accuracy verification of the meters is required, especially if the meters will be used for
revenue or billing applications.

For a list of accuracy standards that your meter complies to, contact your local Schneider Electric
representative or download the meter brochure from www.se.com.

Accuracy test requirements
The most common method for testing meter accuracy is to apply test voltages and currents from a
stable power source and compare the meter’s readings with readings from a reference device or
energy standard.

Signal and power source
The meter maintains its accuracy during voltage and current signal source variations but its
energy pulsing output needs a stable test signal to help produce accurate test pulses. The meter’s
energy pulsing mechanism needs approximately 10 seconds to stabilize after every source
adjustment.

The meter must be connected to control power in order to conduct accuracy verification testing.
Refer to your meter’s installation documentation for power supply specifications.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Verify the device’s power source meets the specifications for your device’s power supply.

Failure to follow these instructions will result in death or serious injury.

Control equipment
Control equipment is required for counting and timing the energy pulse outputs from a visible
LED, infrared LED or onboard digital output.

• Most standard test benches have an arm equipped with optical sensors to detect LED pulses
(the photodiode circuitry converts detected light into a voltage signal).

• The reference device or energy standard typically has digital inputs that can detect and count
pulses coming from an external source (i.e., the meter’s onboard digital output).



NOTE: The optical sensors on the test bench can be disrupted by strong sources of ambient
light (such as camera flashes, florescent tubes, sunlight reflections, floodlights, etc.). This can
cause test errors. Use a hood, if necessary, to block out ambient light.

Environment
The meter should be tested at the same temperature as the testing equipment. The ideal
temperature is about 23 ºC (73 ºF). Make sure the meter is warmed up sufficiently before testing.

A warm-up time of 30 minutes is recommended before beginning energy accuracy verification
testing. At the factory, the meters are warmed up to their typical operating temperature before
calibration to help ensure that the meters will reach their optimal accuracy at operating
temperature.

Most high precision electronic equipment requires a warm up time before it reaches its specified
performance levels. Energy meter standards allow the manufacturers to specify meter accuracy
derating due to ambient temperature changes and self-heating.

Your meter complies with and meets the requirements of these energy metering standards.

For a list of accuracy standards that your meter complies with, contact your local Schneider
Electric representative or download the meter brochure from www.se.com.

Reference device or energy standard
To help ensure the accuracy of the test, it is recommended that you use a reference device or
reference energy standard with a specified accuracy that is 6 to 10 times more accurate than the
meter under test. Before you start testing, the reference device or energy standard should be
warmed up as recommended by its manufacturer.

NOTE: Reference equipment with a traceable calibration certificate is recommended when
performing accuracy testing.

Energy pulsing
Energy pulsing LEDs and digital outputs can be used for energy pulsing.

Your meter is equipped with two types of energy pulsing LEDs: visible light and infrared. These
LEDs emit pulses that are then used to determine the accuracy of the meter’s energy
measurements. The pulses of light indicate accumulated energy; the meter’s accumulations are
compared with the reference/standard’s accumulated energy in order to help determine the
meter’s accuracy.

The meter’s digital output can also be used for energy pulsing. A closing (low impedance) and
then opening (high impedance) of the digital output represents a pulse. If the accuracy testing
equipment has a voltage requirement, a current-limited wetting supply voltage must be provided.

NOTE: Digital outputs on option modules should not be used for meter accuracy testing.
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Verifying accuracy test meter settings
Your meter‘s power system and other parameters must be configured for accuracy testing.

Meter parameter Value

Volts mode 4W-Wye (4 wire Wye)

PT/CT correction Disabled

Test mode

Active

NOTE: In test mode, your meter’s billing quantities stop accumulating,
and the data is sent to special test mode registers. These registers are
cleared when you exit test mode.

Verifying accuracy test
The following tests are guidelines for accuracy testing your meter; your meter shop may have
specific testing methods.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

• Apply appropriate Personal Protective Equipment (PPE) and follow safe electrical work
practices. See NFPA 70E, CSA Z462 or other local standards.

• Turn off all power supplying this device and the equipment in which it is installed before
working on or in the equipment.

• Always use a properly rated voltage sensing device to confirm that all power is off.

• Do not exceed the maximum ratings of this device.

• Verify the device’s power source meets the specifications for your device’s power supply.

Failure to follow these instructions will result in death or serious injury.

1. Connect the test voltage and current source to the reference device or energy standard.
Ensure all voltage inputs to the meter under test are connected in parallel and all current
inputs are connected in series.



A Reference device or energy standard

B Test voltage and current source

C Meter under test

2. Connect the control equipment used for counting the standard output pulses using one of
these methods:

Option Description

Energy pulsing
LED

Align the red light sensor on the standard test bench armature over the
energy pulsing LED.

Onboard Digital
output

Connect the meter’s onboard digital output to the standard test bench
pulse counting connections.

NOTE:When selecting which method to use, be aware that energy pulsing LEDs and
digital outputs have different pulse rate limits.

3. Before performing the verification test, let the test equipment power up the meter and apply
voltage for at least 30 seconds. This helps stabilize the internal circuitry of the meter.

4. Configure your meter power settings (such as voltage, current and frequency) to align with
the reference device.

5. Depending on the method selected for counting the energy pulses, configure the meter’s
energy pulsing LED or one of the digital outputs to perform energy pulsing. Set the meter’s
energy pulse constant so it is in sync with the reference test equipment.

6. Perform accuracy verification on the test points. Run each test point for at least 30 seconds
to allow the test bench equipment to read an adequate number of pulses. Allow 10 seconds
of dwell time between test points.

PowerLogic™ ION9000 series - User manual Verifying accuracy

7EN02-0390-10 Public 321



Verifying accuracy PowerLogic™ ION9000 series - User manual

322 Public 7EN02-0390-10

Calculate the number of required pulses
The reference test equipment typically requires you to specify the number of pulses required for a
test duration of “t” seconds.

Normally, the number of pulses required is at least 25 pulses, and the test duration is greater than
30 seconds.

Use the following formula to calculate the required number of pulses:

Ne Number of metering elements used

V
Test point voltage in line-to-neutral volts
(V) per phase

I Test point current in amps (A) per phase

t
Test duration in seconds (s) which must
be longer than 30 seconds

PF Power factor

Kt
Pulse constant programmed in the meter
under test in Wh/pulse

Round up the result of the calculation to the nearest integer number of pulses.

Calculation for number of required pulses
This example calculates the number of pulses required for an inductive load 3-phase test point
with a test duration of 60s; the source is configured to use V = 120V, I = 5A, PF = -0.5; the pulse
constant of the meter under test is Kt = 1.8 Wh/pulse.

Round the number up to the nearest integer: Number of pulses = 9

Percentage error calculation for accuracy verification testing
Accuracy verification testing requires you to calculate the percentage error between the meter
being tested and the reference/standard.

Calculate the percentage error for every test point using the following formula:

Energy error = (EM - ES) / ES x 100%

Where:

• EM = energy measured by the meter under test

• ES = energy measured by the reference device or energy standard.



NOTE: If accuracy verification reveals inaccuracies in your meter, they may be caused by
typical sources of test errors. If there are no sources of test errors present, please contact your
local Schneider Electric representative.

Typical sources of test errors
If you see excessive errors during accuracy testing, examine your test setup and test procedures
to eliminate typical sources of measurement errors.

Typical sources of accuracy verification testing errors include:

• Loose connections of voltage or current circuits, often caused by worn-out contacts or
terminals. Inspect terminals of test equipment, cables, test harness and the meter under test.

• Meter ambient temperature is significantly different than 23 °C (73 °F).

• Floating (ungrounded) neutral voltage terminal in any configuration with unbalanced phase
voltages.

• Inadequate meter control power, resulting in the meter resetting during the test procedure.

• Ambient light interference or sensitivity issues with the optical sensor.

• Unstable power source causing energy pulsing fluctuations.

• Incorrect test setup: not all phases connected to the reference device or the energy standard.
All phases connected to the meter under test should also be connected to the reference
meter/standard.

• Moisture (condensing humidity), debris or pollution present in the meter under test.

Accuracy verification test points
The meter should be tested at full and light loads and at lagging (inductive) power factors to help
ensure testing over the entire range of the meter.

The test amperage and voltage input rating are labeled on the meter. Refer to the installation
guide or data sheet for your meter’s nominal current, voltage and frequency specifications.

Watt-hour test point Sample accuracy verification test point

Full load
100% to 200% of the nominal current, 100% of the nominal voltage and
nominal frequency at unity power factor or one (1).

Light load
10% of the nominal current, 100% of the nominal voltage and nominal
frequency at unity power factor or one (1).

Inductive load
(lagging power
factor)

100% of the nominal current, 100% of the nominal voltage and nominal
frequency at 0.50 lagging power factor (current lagging voltage by 60°
phase angle).

VAR-hour test point Sample accuracy verification test point

Full load
100% to 200% of the nominal current, 100% of the nominal voltage and
nominal frequency at zero power factor (current lagging voltage by 90°
phase angle).
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VAR-hour test point Sample accuracy verification test point

Light load
10% of the nominal current, 100% of the nominal voltage and nominal
frequency at zero power factor (current lagging voltage by 90° phase
angle).

Inductive load
(lagging power
factor)

100% of the nominal current, 100% of the nominal voltage and nominal
frequency at 0.87 lagging power factor (current lagging voltage by 30°
phase angle).



Troubleshooting
Review the topics in this section to get more information on how to troubleshoot your meter and
where to obtain technical assistance.

Setting up Advanced security troubleshooting
Some users could experience software access issues after enabling Advanced Security mode.
Resolve software access issues using these troubleshooting steps:

Meter state Example behavior
Solution – follow tasks in the
order listed

Newmeter Login credentials are unknown.

• Verify that you are using the
newest version of ION Setup.

• Enter Username: User1 and
Password: 0 [zero].
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Meter state Example behavior
Solution – follow tasks in the
order listed

Meter recently
upgraded to
firmware v3.0.0

Using EcoStruxure™ Power
Monitoring Expert software and after
password is entered, access is not
granted.

• Verify that you are using the
newest version of ION Setup.

• Verify you are using meter
firmware v3.0.0.

• Configure software meter
security settings.

• Enter meter username: User1
and Password: [password used
before upgrade to firmware
v3.0.0].

Using Vista software and after
password is entered, access is not
granted.

Go to www.se.com and search for
support to get assistance with
troubleshooting.

Using EcoStruxure™ Power
Operation software.

Go to www.se.com and search for
support to get assistance with
troubleshooting.

Incorrect credentials are entered
multiple times and a lockout occurs.

Wait until lockout duration is over
and account is not locked out. If a
user account is locked out, that user
can still access the device by
entering the correct credentials over
a different protocol and
communications method.

Login credentials are unknown.

• Verify that you are using the
newest version of ION Setup.

• Enter meter username: User1
and Password: [password used
before upgrade to firmware
v3.0.0].

Option module troubleshooting
Events related to option module initialization and operation are stored in your meter’s onboard
event log. Perform an option bus reset to restart the option bus and re-initialize the option
modules attached to your meter. Reviewing the events in the event log within the first minute of
option bus reset will provide the most specific details of the detected problem with your option
module.

When troubleshooting option modules, attach each option module directly to the meter and verify
its operation. If each option module operates when directly connected, use combinations of
modules or known good modules to help identify the issue.



Information about your option module’s type, serial number, firmware version and present status
is available in the Factory and Diagnostics modules.

See ION Reference, available from www.se.com, for more information about the Factory and
Diagnostics modules.

Technical assistance
Go to www.se.com and search for support to get assistance with troubleshooting.

Have the meter model, serial number and firmware version information ready. See Device-
specific information for details about obtaining this information.

You may be asked by a customer care agent to enable factory access to the device for
troubleshooting. Factory access is gained after a unique diagnostic access code is used to login
to the device over a secure protocol.

Factory access:

• Is disabled by default.

• Is temporarily enabled for a duration defined in the Factory Access minutes register.

• Requires adequate user privileges to enable.

• Provides read and write permissions.
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Specifications
This section lists the specifications for your meter and accessories.

NOTE: The information contained in this section is subject to change without notice. You can
download updated documentation from www.se.com or contact your local Schneider Electric
representative for the latest updates.

Mechanical characteristics

Mounting options
DIN rail: IEC 60715 (DIN EN 60715), TH 35–7.5 or TH 35–15

Panel mount: with 9B2BMA

Orientation Vertical, retaining clips located on bottom of meter

IP degree of protection IP30 (except connectors)

Maximum number of
option modules

4 (based on maximum operating temperature)

ION9000 series meter

Mechanical compliance

Vibration
IEC 60068-2-6

IEC 60068-2-57

Shock
IEC 60068-2-27

IEC 60068-2-31, Test Ec Free fall procedure 1

Electrical characteristics

Rated inputs

• AC: 65–277 V L–N rms (±10%), 42–69 Hz.

• DC: 80–300 VDC (±10%) VDC ±20% tolerant (temporary
sag/swell)

Power supply (auxiliary power)

Active energy (Wh) IEC 62053-22 Class 0.1 S

Reactive energy (VARh) IEC 62053-24 Class 0.5 S

Power monitoring device (PMD) IEC 61557-12 PMD/SD/K70/0.2 and PMD/SS/K70/0.2

Active power (P)
IEC 61557-12 Class 0.1

Reactive power (QV) IEC 61557-12 Class 1

Apparent power (SV) IEC 61557-12 Class 0.2

Measurement accuracy



Apparent energy (EapV) IEC 61557-12 Class 0.2

Current (I) IEC 61557-12 Class 0.1

Voltage (U) IEC 61557-12 Class 0.1

Frequency (f) IEC 61557-12 Class 0.02

NOTE: Reactive energy and demand values, by default, are based only on the fundamental
frequency, and do not include higher harmonics. Active and apparent energy and demand
values are measured using the entire signal, including harmonics.

Power quality instrument (PQI)

IEC 62586-1/2 PQI-A

IEC 61000-4-30 Class A (Udin = 230 V)

IEC 61000-4-15 Class F1 (Un = 230 V, 120 V)

Voltage unbalance (Unb) IEC 61557-12 Class 0.2

Voltage harmonics (Uh) IEC 61557-12 Class 1

Voltage THD (THDu) IEC 61557-12 Class 1

Current harmonics (Ih) IEC 61557-12 Class 1

Current THD (THDi) IEC 61557-12 Class 1

Waveform capture 16–1024 samples per cycle

Power quality

Specified accuracy
range

57–400 V L-N/100–690 V L-L (Wye) or 100–600 V L-L (Delta or Wye
with unearthed neutral)

Impedance > 5 MΩ

Measurement category III

Overload  600 V L–N or 1035 V L–L

Voltage inputs

Nominal
IEC: 1A/5A (Class 0.1 S)

ANSI: Current Class 2, 10, 20 (Accuracy Class 0.1)

Burden  0.01 VA maximum at 5 A

Specified
accuracy
current range

10 mA–20 A

Starting
current

1 mA

Withstand 30 A continuous, 50 A@ 10 sec/hr, 500 A@ 1 sec/hr

Impedance 0.3 mΩ (typical)

Current inputs
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Input voltage range ± 5.5 V pk

Minimum signal 1 mV

Withstand 30 V pk continuous

Input impedance 200 kΩ

LVCS current inputs

AC control power

Operating range
50/60 Hz ± 10%: 90–480 V ± 10%

400 Hz: 90–120 V ± 10%

Burden (meter only)
Maximum: 16.5 W/38 VA@ 480 V (45–65 Hz)

Maximum: 13W/24 VA@ 120 V (400 Hz)

Burden (fully optioned meter)
Maximum: 40W/80 VA@ 480 V (45–65 Hz)

Maximum: 36W/58 VA@ 120 V (400 Hz)

Ride-through time (no optional
accessories)

100 ms (6 cycles at 60 Hz) typical, 120 V AC

400 ms (24 cycles at 60 Hz) typical, 240 V AC

1200 ms (72 cycles at 60 Hz) typical, 480 V AC

DC control power

Operating range 110–480 V DC ± 10%

Burden (meter only) Maximum: 13.5 W at 480 V DC

Burden (fully optioned meter) 37 W at 480 V DC

Overvoltage category III

Control power

DC control power

Operating range 20–60 V DC ± 10%

Burden (meter only) Maximum: 15W at 20–60 V DC

Burden (fully optioned meter) Maximum: 38W at 20–60 V DC

Overvoltage category III

Low-voltage DC control power

Number 4

Type Form A solid-state

Reference voltage 40 V

Maximum load voltage 30 V AC/60 V DC

Maximum load current 75 mA

ON resistance 13–40 Ω at 25 °C (77 °F)

Digital output (Form A)



Signal type Continuous or pulse

Pulse frequency ≤ 25 Hz

Number 8

Type
Externally excited, 24 V DC whetting voltage available from
the meter

Reference voltage 40 V

Event timestamp accuracy ± 1 ms

Maximum voltage
30 V AC

60 V DC

Pulse frequency ≤ 25 Hz

Response time 1 cycle

Current draw
ON: ≤ 2.5 mA

OFF: ≤ 0.5 mA

Voltage ON state
4–30 V AC

4–60 V DC

Voltage OFF state
0–1.4 V AC

0–2.0 V DC

IRIG-B

IRIG-B00x format (unmodulated IRIG-B time code)

Coded expressions 0–7 are supported but the year data is
not used.

Digital inputs

Number 2

Type Form Cmechanical relay

Maximum load voltage 250 V AC/30 V DC

Maximum load current

8 A@ 250 V AC

5 A@ 24 V DC

20k cycles (resistive)

Operate time Maximum: 10 ms

Release time Maximum: 5 ms

Lifetime
No Load: 10,000,000 operations

Rated Voltage and Load: 50,000 operations

Relay output (Form C)

Output voltage 24 V DC

Whetting source (Digital inputs)
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Output current 20 mA

Maximum load 8 digital inputs (meter base)

Environmental characteristics

Operating temperature

-25 ºC to Max temp (-13 ºF to Max temp)

NOTE: Maximum operating temperature could change
based on the quantity and type of attached option modules.
SeeMaximum operating temperature with option modules
below.

LEDs

Type Visible orange, infrared

Wavelength 600–609 nm (orange), 825–925 nm (infrared)

Maximum pulse rate 10 Hz (100 ms)

Energy pulsing LEDs (visible and infrared)

Type Bi-color, red/green

Status LEDs (visible)

EMC (electromagnetic compatibility)
EMC standards IEC 62052-11, IEC 61326-1, IEC 61000-6-5

Immunity to electrostatic
discharge

IEC 61000-4-2

Immunity to radiated fields IEC 61000-4-3

Immunity to fast transients IEC 61000-4-4

Immunity to surges IEC 61000-4-5

Immunity to conducted
disturbances

IEC 61000-4-6, IEC 61000-4-16

Immunity to power frequency
magnetic fields

IEC 61000-4-8

Immunity to conducted
disturbances, 2 - 150 kHz

CLC/TR 50579



Immunity to voltage dips and
interruptions

IEC 61000-4-11

Immunity to ring waves IEC 61000-4-12

Conducted and radiated
emissions

EN 55011 and EN 55032 Class B, FCC part 15 Class B,
ICES-003 Class B

Surge withstand capability
(SWC)

IEEE/ANSI C37.90.1

Safety

Safety construction

IEC/EN 61010-1, CAT III, 400 VLN / 690 VLL

UL 61010-1 and CSA-C22.2 No. 61010-1, CATIII, 347 V LN /
600 VLL

IEC/EN 62052-31, Protective Class II

Ethernet communications
Number of ports 2 (switched mode)

Maximum cable length 100 m (328 ft), per TIA/EIA 568-5-A

Cable type CAT5 (or higher)

Connector type Unshielded RJ45 modular connector (2)

Mode 10Base-T, 100Base-TX, Auto-MDIX

Data rate up to 100 Mbps

RS-485 communications
Number of ports 2

Cable type Shielded twisted pair

Maximum cable length 1200 m (4000 ft)

Maximum number of devices
(unit loads)

Up to 32 devices on the same bus

Parity None, even, odd

Baud rate 2400–115200, 19200 recommended
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Real-time clock

Clock drift (time error)
Meter Powered ON: 5 ppmmaximum

Meter Powered OFF: 20 ppmmaximum at 25 °C (77 °F)

Battery backup time Minimum 7 years under specified storage conditions

Display

Display

Display type
Capacitive touchscreen, WVGA color graphic TFT LCD 800 x
480 resolution

Display backlight White LED

Viewable area 152.5 x 91.5 mm (6.00 x 3.60 in)

Weight 0.9 kg (2.0 lb)

Communications ports

Optical communications ports
ANSI C12.18 optical port

IEC 1107 optical port adapter

USB communications ports
USB host port: Type A USB

USB device port: Mini-B USB

Control power

Power over Ethernet (PoE)
power

PD Type 1 Class 3 per IEEE 802.3af, 10Wmaximum

Auxiliary control power

(Not required for PoE
applications)

24 V DC ± 20%

DC burden 10Wmaximum

Use UL listed or UL recognized NEC class 2 (or equivalent
SELV or PELV) power source

Communication connection

Cable type
CAT5 (or higher). Use with unshielded RJ45 modular
connector

Cable length 100 m (330 ft) maximum

Connection type Direct, point-to-point

Environment

Operating temperature –20 ºC to 60 ºC (–4 ºF to 140 ºF)

Storage temperature –40 °C to 85 °C (–40 °F to 185 °F)

METSERD192 display



Humidity rating
5%–95% RH non-condensing

Maximum dewpoint: 37 °C (99 °F)

Pollution degree 2

Altitude < 3000 m (9843 ft) above sea level

IP degree of protection
Front: IP65

Rear: IP30

Location/mounting

For UL Type 12 applications, install display on a flat surface
of a Type 12 enclosure

Not suitable for wet locations

For indoor use only

Option modules
See your option module’s installation guide for additional option module specifications.

Maximum number of modules 4

Input resistance
< 300 Ω (current mode)

> 500 kΩ (voltage mode)

Input voltage mode 0–30 V DC

Input current mode 4–20 mA , 0–20 mA

Operating temperature

–25 to 70 ºC (–13 to 158 ºF)

Maximum operation temperature is based on the quantity and
type of attached option modules.

METSEPM89M0024 Analog (2 out, 4 in)

Maximum number of modules 4

Operating temperature

–25 to 70 ºC (–13 to 158 ºF)

Maximum operation temperature is based on the quantity and
type of attached option modules.

METSEPM89M2600 Digital (2 out, 6 in)

Maximum number of modules 1

Operating temperature

–25 to 70 ºC (–13 to 158 ºF)

Maximum operation temperature is based on the quantity and
type of attached option modules.

METSEPMRS4854W 4-Wire RS-485

Maximum number of modules 1

METSEPMFIBER Fiber Ethernet
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Operating temperature

–25 to 70 ºC (–13 to 158 ºF)

Maximum operation temperature is based on the quantity and
type of attached option modules.

Other
Parameter Description

Weight (meter base only)

Weight (Measurement Canada)

1.5 kg (3.3 lb)

3.23 kg (7.12 lb)

Meter start time1
25 seconds: Measurements

35 seconds: Communications

45 seconds: Display initialization

Meter storage 2000 MB

Data update rate
Regular data: 1 second

High-speed: 50/60 Hz half-cycle

Advanced security user
accounts

Up to 50 users

Valid password characters ASCII 32–126

1 – Meter start up time is expressed as the typical elapsed time from the application of control
power to the result indicated in the description field.
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